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About this Guide
The TouchNet® Payment Gateway™ 6 Business User’s Guide describes how
to look up and manage online payments using the TouchNet Payment
Gateway Operations Center.

TouchNet Payment Gateway allows you to easily process electronically
submitted credit card, debit, or ACH payments. With Payment Gateway,
you can track authorizations and settlements through detailed, searchable
reports.

Note: You may be licensed to use additional modules that extend Payment
Gateway’s functionality. These modules include controls for enterprise-wide
interface between your applications and Payment Gateway. Each module is
documented separately.

In this guide, we assume that the reader has prior knowledge of credit card
and debit processing systems, software operations, and host systems. This is
not intended as a guide to host system operation or banking processes, nor
does it explain how to use software operating systems or database
management systems with which TouchNet Payment Gateway may work.

If you are processing ACH payments, we assume that you have previous
knowledge of the operating rules of bodies governing ACH transactions.
This guide does not describe procedures you might use to pass ACH files to
your bank.

PA-DSS Compliant Payment Applications

For information regarding TouchNet’s PA-DSS compliant payment
applications and how they support your institution’s PCI compliance efforts,
refer to the TouchNet PA-DSS Implementation Guide. Individuals
responsible for PCI compliance should review this guide. Please visit the
TouchNet Client Community to obtain a copy of the PA-DSS
Implementation Guide.

To Contact TouchNet Customer Care

For technical assistance or customer support contact TouchNet Customer
Care, by calling 1-888-621-4551 between the hours of 7:00 a.m and 7:00
p.m. Central Time, or logging into the TouchNet Client Community at
https://clientcommunity.touchnet.com and selecting the Contact Customer
Care quick link.

TouchNet Customer Care is available Monday through Friday between 7:00
a.m. and 7:00 p.m. Central Time. Extended support hours are available by
agreement with TouchNet.

TouchNet Payment Gateway 6.0 Business User Guide
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Your Payment Gateway 6 Documentation
TouchNet product documentation is available on the TouchNet Client
Community. To browse documents, log in to your TouchNet Client
Community account. Click the Product and Services Spaces link in the
Spaces navigation menu, then click the Payment Gateway link. Select the
desired documentation from the Guides listing.

Documentation Title Description

Online Help

Click the Help link from the left navigation menu in the Payment
Gateway Operations Center to open online help.

Help contains all of the information found in the Business User's Guide
and the Technical User's Guide. It also contains reference information
and detailed step-by-step instructions for tasks not performed on a daily
basis.

Installation Guide

or

Upgrade Guide

These guides walk through the process of installing or upgrading
Payment Gateway. Each guide is available in a Windows version and a
Solaris version.

If your solutions are hosted in the TouchNet Certified DataCenter,
TouchNet will install and upgrade your software for you.

Business User's Guide
This guide is for the Payment Gateway business office users hosted on
campus. It documents the daily procedures you’ll perform in the
Payment Gateway Operations Center.

Technical User's Guide

This guide is for information technology staff on campus.

It contains detailed information about the concepts and components of
the Payment Gateway, as well as advanced configuration,
maintenance, and troubleshooting information.

Requesting a
TouchNet

Login

You must log into your TouchNet Client Community account to obtain the
download. If you do not have a login, you can send a login request by
going to the TouchNet Client Community
(https://clientcommunity.touchnet.com), and clicking the Login link. On
the Login page click the Need a Login? link, fill out the login request and
click the Submit button.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



What’s New in Payment Gateway 6
Payment Gateway 6 includes several new features:

• Three new fields have been added to the ACH merchant configuration
when manually generating the ACH file. These new fields: Use File
Cutoff Time, File Cutoff Time, and File Cutoff Offset allow you to
select the file cutoff time parameters to customize the ACH file. See
"Generating the Current ACH File" on page 140.

• Reports have been modified to display in a separate window or tab.
When a user selects a report and clicks the View Report button, the
report displays in a separate window if you are using Internet
Explorer, or in a separate tab if you are using Firefox. You can
continue to export the report data to a CSV-format file for use in
spreadsheet programs. See "Payment Gateway Reports" on page 183.

• A new process allowing schools to resubmit failed credit and debit
card batches has been added to the Payment Gateway Operations
Center. When a credit card or debit card payment batch fails, for any
reason, designated users are notified via a failed batch email message
generated from Payment Gateway. Once the user with the new
resubmit failed batch merchant role receives the email notification,
they can locate the failed batch using the Credit Card Batch
Settlement report, review the failed batch details, verify the batch
results with the payment processor, and resubmit it to processors that
allow a batch to be resubmitted. See "Resubmitting a Failed Credit
Card Batch" on page 114and "Resubmitting a Failed Debit Card Batch"
on page 169.

• A new automated process for uploading the ACH Return File received
from the bank. When the ACH return file is uploaded, the returned
payment transactions are automatically marked as returned. Two
additional transactions can be configured to be automatically sent
back into the ACH network for collection. See "Uploading the ACH
Return File" on page 149.

• The ability to automatically apply a default reinitiation fee to returned
ACH payment transactions. See "Automatically Reinitiating ACH
Files" on page 152.

• Simplified the process for creating an ACH reversal file to make it
easier to create the ACH reversal file. See "Generating an ACH
Reversing File" on page 163.

• A new user role for processing ACH return files. Assign the new
Process Return File role to users who are allowed to process ACH
return files. See "Payment Gateway User Roles" on page 237.

• A new Process Credits role for processing credit card credits. Assign
this role to users who are allow to process credits but are restricted
from performing single authorizations. This new role is needed to

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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division of labor purposes and audit regulations. See "Payment
Gateway User Roles" on page 237.

• Several new pages are available for making merchant configuration
changes, making it easier to locate the desired fields that need to be
changed. See "Maintaining Merchant Information" on page 71

• Users making modifications to merchant processor identifiers must be
assigned the new Modify Processors Identifiers permission as well as
the TPG Administrator role. Users with this new modify permission
can make changes to processor identifiers. See "Editing the Processor
Identifiers " on page 73. Once the changes are entered and saved in a
pending status they must be approved by a user with the new
Approve Processor Identifiers permission as well as the
TPG Administrator role. An email notification is sent to the approver.
Approvers also have the ability to cancel any pending changes. See
"Approving Merchant Configuration Changes " on page 80

• A new payment details page has been added to Payment Gateway
reports.

• Payment Gateway report information can be filtered by time of day.
You can select the hour and minutes in addition to the date to narrow
the information that displays for each report. See "Running Reports"
on page 184.

• Additional detail added to the payment transaction reports to make
reconciliation and research easier. The Student ID (Payer ID) and
Institutional Unit fields are now included on the reports.

• Additional sorting and filtering capabilities are available for the User
Audit Log to filter by user session and specific user actions. See
"Filtering the User Audit Log Results" on page 254.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



1.0 Getting Started
Payment Gateway users access Payment Gateway by logging in through
U.Commerce Central. U.Commerce Central provides a centralized location
for managing U.Commerce Central system operations and viewing
commerce activity across campus. It's the "command center" for campus-
wide financial management, bringing new accountability, control, and
confidence to campus finance. It encompasses all of your TouchNet campus
solutions, providing an Operations Center that gives you instant, high-level
information about your business. U.Commerce Central also provides a user
management system.

Payment Gateway can be installed in stand-alone mode (i.e., not as part of
U.Commerce Central). At a future date, you can complete the configuration
that will hook up Payment Gateway to U.Commerce Central; however,
while Payment Gateway is in stand-alone mode, no transaction data will be
stored for use by U.Commerce Central.

The first step in accessing the Payment Gateway Operations Center is to
use your web browser to launch U.Commerce Central. To launch
U.Commerce Central, you need the U.Commerce URL and a username and
password.

Where do you get the U.Commerce Central URL and login
credentials?

• If you are the Payment Gateway administrator and you are logging in
for the first time, you will get the U.Commerce Central URL,
username, and password from your TouchNet implementation
specialist.

• Existing U.Commerce Central users are given access to Payment
Gateway by the Payment Gateway administrator.

• New U.Commerce Central users must be created through User
Management in U.Commerce Central. Then Payment Gateway access
is granted by the administrator.

Logging in to
U.Commerce

Central

Once you have received the U.Commerce Central URL and your username
and password, follow these steps to login to U.Commerce.

1 Enter the U.Commerce Central URL in your browser's address field
and press Enter. The U.Commerce Central Login page displays.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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The U.Commerce Central login page

2 Enter your username and password.

Note: If you forgot your password you can click the Forgot password? link to
change your password. Refer to the "The Forgot Password link allows
individual users to reset their password. If the user you forgets their
password, you can click the Forgot Password? link and quickly change your
Password. Users no longer need to contact the U.Commerce Central
administrator and wait for the password to be reset." on page 242 of this
guide for instructions on changing your password.

3 Click the Login button. The U.Commerce Central home page
displays.

The top navigation bar shows all the U.Commerce Central products
that are available for you to use. Payment Gateway displays as one of
the tabs in the top navigation bar.

4 Click the Payment Gateway tab. The Payment Gateway Operations
Center home page displays.

Navigating the
Payment
Gateway

Operations
Center

The Payment Gateway Operations Center interface allows users to perform
tasks depending on their assigned roles and assigned merchant(s). At login,
every Operations Center user sees only the merchants, tasks, and reports for
his or her access rights.

In the Operations Center, a user’s roles may include rights to view reports,
configure Payment Gateway, set up Operations Center users, set up
merchant and host accounts, create and manage ACH files, manage ACH
payments, process credits, or complete single credit card authorizations.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
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To navigate Payment Gateway Operations Center use the left navigation
menu and the top navigation bar menu (which includes links for Home,
Help, Change Password, and Logout. The left navigation menu displays
only those options that are available to you based on your user roles.

The Payment Gateway left and top navigation menus

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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2.0 Payment Gateway Concepts and
Components

TouchNet Payment Gateway processes payments from your customers,
sending payment data to your credit card processor, your debit processor, or
for ACH payments creates a NACHA-standard file to be sent to the bank.

Payment Gateway also stores payment transaction information in a database
and in encrypted data files. In the Payment Gateway Operations Center,
you can review payment data in searchable reports.

Payment Gateway can process payments for multiple merchants that use a
single credit card or debit processor. In the Payment Gateway Operations
Center, you can set up the merchants allowed by your license, change
system configuration, and perform further processing on payment
transactions.

If you accept online payments through U.Commerce Central solutions like
TouchNet Bill+Payment, TouchNet Cashiering, or TouchNet Marketplace,
you will also use the TouchNet Payment Gateway Operations Center to
configure the commerce options to route data and funds from those
payments.

TouchNet Payment Gateway is part of TouchNet® U.Commerce™ Central,
which is a comprehensive commerce management system tailored
specifically for colleges and universities. U.Commerce Central helps
institutions achieve more secure and efficient operations by providing a
unified framework with which to administer electronic payments and
related business transactions. With solutions from e.Commerce (online, self-
service payments) to p.Commerce (in-person and merchant-assisted
payments) and from authorized-user access to public access, U.Commerce
Central allows schools to enable, track, and reconcile the flow of dollars
throughout the campus enterprise—from an initial application or device all
the way to the bank.

2.1 Payment Gateway and Card Processors
Credit card or debit processors provide services to the bank where your
merchant is located. Processors authorize and settle credit card or debit
payments. They also coordinate the resulting transfers of funds between the
card-issuing bank and your bank.

TouchNet Payment Gateway is certified for use with the following credit
card and debit processors, on the Microsoft Windows XP®, Microsoft
Windows NT®, Microsoft Windows® 2000, Microsoft Windows 2003, and
Sun Solaris™ for SPARC platforms. All listed processors support IP
connectivity with Payment Gateway.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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Processors
Credit
Card

PIN Debit
PINLESS
Debit

Host-Based or
Terminal-Based?

Atlanta
BuyPass(Concord
EFSNet and
MIGS) payment
processing
module) via
Secure Transport

YES YES YES host

FDC Nashville YES terminal

FDC North YES YES YES terminal

FDC South YES YES terminal

Global Payment
Systems East

YES YES YES terminal

MasterCard Inter-
national Gateway
Service (MIGS)

YES terminal

RBSLynk (vital
processing
module)

YES YES terminal

Moneris e-Select
Plus

YES YES
YES
(Interac
online)

host

Elavon (formerly
Nova)

YES YES YES terminal

Paymentech YES YES terminal

TSYS Acquiring
Solutions
(formerly Vital)

YES YES terminal

Note: RBSLynk processor uses the TSYS Acquiring Solutions specification.

Note: TouchNet Payment Gateway support for IP connectivity does not
include direct connectivity using leased lines or ISDN.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
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2.2 Credit Card and Debit Transaction Processing
When a customer submits a credit card or debit payment through your
online payment application, it is authorized and settled by your bank’s
processor. Payment Gateway sends all required data to the processor for
both the authorization and settlement.

Authorizations During an authorization, the credit card or debit processor approves the
payment transaction on behalf of the bank that issued the card account.

When a payment is submitted, your online payment application sends the
authorization request to Payment Gateway. Payment Gateway verifies that
the request includes all needed data and then sends the authorization
request to the processor over an IP connection.

When the credit card or debit processor responds with an authorization,
rejection, or exception/error, Payment Gateway logs the response to the
Payment Gateway databases and sends the response back to the server
where your online payment application is running. For credit card
transactions, the successful authorizations are added to a batch using your
online payment application. For debit transactions, successful debit
authorizations added to a batch for later settlement.

Batch
Settlements

In a batch settlement, previously authorized transactions are submitted to
the processor for final payment processing. Each successful transaction
settlement results in a funds transfer between the card-issuing bank and
your acquiring bank.

For each successfully settled transaction, the processor sends a charge or
credit to the appropriate card-issuing bank. The issuing bank then sends the
amount of the charge to your acquiring bank, minus any applicable fee.
Your bank deposits the funds, minus any applicable discount rate, in the
correct merchant account.

Settlement attempts can be made in one of two ways:

• Payment Gateway can run an automatic, daily batch settlement that
you schedule.

• You can send a command to settle the current, pending batch at any
time.

Note: During settlement for host-based processors, such as Concord EFSnet,
MIGS, and Moneris e-Select Plus batch files are not sent.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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2.3 ACH Transaction Processing
TouchNet Payment Gateway includes features and functions to process ACH
transactions. If you are licensed to process ACH transactions, you can accept
online payments from personal checking or savings accounts and use
Payment Gateway to process them.

If you are not licensed for ACH processing but you wish to use it, contact
TouchNet. You will need a new license and an additional license key.

Note: All users see some ACH processing features in the Operations
Center, regardless of license.

2.4 Updating Your Host System Account Balance
When configured to work with a TouchNet host integration module (such as
Banner® Connect, Colleague® Connect, or PeopleSoft Connect), Payment
Gateway can send payment amount information to your host system.

Payments submitted through a TouchNet solution, such as TouchNet
Bill+Payment or webCheck, are accompanied by information that will
allow Payment Gateway to update the payer’s account balance on the host
system.

When Payment Gateway updates a host system account, the payment
amount, account identification, and payer identification data are sent to the
host using the TouchNet host integration module appropriate for your host
system type.

2.5 Payment Gateway and Data Security
Payment Gateway encrypts all payment data stored in data or debug files.
Sensitive data associated with ACH payments is encrypted in the Payment
Gateway databases. Sensitive data is not stored unencrypted in the
databases.

Secure Socket Layer (SSL) security is supported between your application
server and the Payment Gateway computer; we assume that you have
implemented SSL with tools of your choice. The encryption between
Payment Gateway and your credit card or debit processor is specified by the
processor.

For those processing ACH transactions, all bank routing numbers, checking
or savings account numbers, and payment agreements are encrypted in the
Payment Gateway databases.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



3.0 Payment Processing Setup
The Payment Processing Setup portion of the Operations Center is where
you add and maintain credit card, ACH, and debit merchant information.
You must have either the administrator, modify processor identifiers or
approve processor identifiers modifications role permission to access and
view the Payment Processing Setup pages. Only users with the modify
processor identifiers permission can make changes to the Payment
Processing Setup pages.

The left navigation is organized by payment type.

Payment Processing Setup left navigation

Each payment type has three configuration options: Merchant Configuration,
System, and Payment Module.

3.1 Merchant Configuration

You can set up and manage merchants as allowed by your license. You must
have a separate license key for each type of processing you want to do –
credit card, ACH, debit, or signature debit only. For example, a credit card
license key is required to set up credit card merchants, a separate license
key is required to set up ACH merchants, and so on.

Step-by-step information about how to add merchants, remove merchants,
edit merchants, and grant users access to merchants is available in Payment
Gateway online help.

Important! You can use only the number of merchants allowed by your
license. If you believe you may exceed the number of licensed
merchants, contact TouchNet Customer Care for assistance.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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Access the merchant configuration options by clicking on the Merchant
Configuration link in the left navigation.

Credit Card - Merchant Configuration options

3.2 System

TouchNet will advise you on what to enter in the System Configuration
fields. Do not make any changes to this page unless instructed to do so by
TouchNet.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
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Credit Card - System Configuration page

3.3 Payment Module

There is a Payment Module configuration page for each payment type.
These are to be configured by TouchNet personnel only. Do not make any
changes to these pages unless instructed to do so by TouchNet personnel.

Credit Card - Payment Module Configuration page

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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3.4 What Are Merchants?
Merchants contain information and instructions for the credit card, ACH, or
debit processor (if applicable), your school’s bank, and the Payment
Gateway. The information varies depending on the type of merchant and
what the recipients of the transactions need to know.

There are three types of merchants in Payment Gateway:

• Credit card

• ACH

• Debit

When you create a host system account, you assign payment methods to
that account. A merchant is assigned to each credit card, ACH, and debit
payment method in a host system account. This ties together the
information for your ERP, your bank, your card processor, and Payment
Gateway. Therefore, all of the merchant information must be in a form that
the processor and/or your school’s bank can understand.

Merchants figure prominently in the Payment Gateway. Most of the
information you will encounter in the Operations Center is organized by
merchant.

Each Payment Gateway user is given access to specific merchants. When
users log into Payment Gateway they only see information for the
merchants to which they have access.

Credit Card
and Debit
Merchants

TouchNet Payment Gateway supports multiple credit card and debit
processors. All of your merchants that use the same processor can accept
payments through Payment Gateway.

When you create a credit card or debit merchant, you enter information that
will be sent to the card processor and eventually to your school’s bank with
each batch. All of the information must be in a form that the processor and
your school’s bank can understand. Your bank will tell you what to enter in
most of the configuration fields.

Signature Debit Only Merchants

You can designate your credit card merchant(s) to accept signature debit
only transactions. Signature debit only merchants must be licensed by your
school. Contact TouchNet to obtain your signature debit only license key.
Signature debit only merchants are configured on the Merchant
Configuration page. Refer to "Merchant Configuration Fields by Processor"
on page 20 for more information.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



ACH Merchants When you send your school’s ACH file to your bank, it includes a file
header that identifies the merchant that the ACH file is for. The information
in that file header comes from the ACH merchant fields in Payment
Gateway.

All of the information in the file header must be in a form that the bank
will recognize when it receives the ACH file. Again, the bank will provide
you with most of the information you need to complete those fields at
setup.

Information about how to add merchants is available in Payment Gateway
online help.

Adding a New
Merchant

To add a new merchant, follow these steps.This process requires the
administrator role.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment method] > Merchant Configuration >
Add Merchant. The Add Merchant page for the selected payment
method displays.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.
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The Add Merchant page

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
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2 Complete all of the fields on the page in the Description, Processor
Identifiers, General, and Card Types (credit card merchants only)
sections. The fields you see are determined by the payment type you
are creating a merchant for, and (for credit card or debit) the processor
you use. Your bank will supply most of the information needed to

complete the fields. Required fields display a next to the field.

Descriptions of each credit card and debit merchant configuration field
(by processor) can be found in the Merchant Configuration Fields by
Processor section.

3 Click the Add Merchant button. A message displays at the top of the
screen, confirming that your new merchant has been added
successfully.

The new merchant is added to Payment Gateway. The merchant fields
are not active until the required fields are approved.

An email notification is sent to designated users indicating a new
merchant has been added and some fields require approval. A
message also displays on the Payment Gateway home page notifying
the administrator that new merchant information has been added and
needs approval. See "Approving Merchant Configuration Changes " on
page 80 for more information about the approval process.

4 Once the new merchant information has been approved. Payment
Gateway must be restarted.

Note: After you have added the merchant you must assign users who will
have access to the new merchant. See "Granting Users Access to
Merchants" on page 246 for more information.

TouchNet Payment Gateway 6.0 Business User Guide
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3.5 Merchant Configuration Fields by Processor
Payment Gateway Operations Center Merchant Configuration pages include
several fields required by your credit card or debit processor. Different
processors require the completion of different fields, some of which will be
provided by your school's bank.

The credit card and debit merchant configuration fields vary for each
processor listed below: 

• Concord EFSnet and MIGS- Merchant Config Fields

• Elavon (formerly Nova) - Merchant Config Fields

• FDC Nashville - Merchant Config Fields

• FDC North - Merchant Config Fields

• FDC South - Merchant Config Fields

• Global Payment Systems East - Merchant Config Fields

• RBSLynk - Merchant Config Fields

• Moneris e-Select Plus - Merchant Config Fields

• Paymentech - Merchant Config Fields

• TSYS Acquiring Solutions (formerly Vital) - Merchant Config Fields

Concord
EFSnet and

MIGS-
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Store ID

• Store Key

• Terminal ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
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Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.
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Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Maximum Auth Amount

Maximum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount.

You can enter up to 9999999 as the value (do not enter commas), for the
highest allowed authorization of $99,999.99.

Merchant Cards

Credit card types that the merchant accepts.

Merchant Account Number

The customer number field provided by TouchNet Bill+Payment.

Merchant Name

The merchant name. 40 character maximum.
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Note: The Merchant name and Merchant phone number fields must either
both be populated, or both be blank, or the payment transaction will not
process successfully. Initially, these fields are blank.

Merchant Phone Number

The debit card merchant phone number initiating the payment. 25 character
maximum.

Note: The Merchant phone number and Merchant name fields must either
both be populated, or both be blank, or the payment transaction will not
process successfully. Initially, these fields are blank.

Merchant Number

Provided by bank. Changes to this information require approval by a user
with the Approve Processor Identifier Modifications permission.

Minimum Auth Amount

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

Primary URL

Assigned Primary URL for IP connectivity. Provided by bank or processor.

Read Timeout and Write Timeout

Number of milliseconds Payment Gateway will wait for a response from the
processor. TouchNet suggests 60000 (60-second timeout.)

Secondary URL

Assigned Secondary URL for IP connectivity. Provided by bank or processor.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Signature Debit Only

Select the Yes radio button to designate your credit card merchant to accept
signature debit only transactions. This designation is only for credit card
merchants.

Note: Contact TouchNet to obtain a license key for signature debit
only merchants.
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Store ID

Provided by bank. Changes to this information require approval by a user
with the Approve Processor Identifier Modifications permission.

Store Key

Provided by bank. Changes to this information require approval by a user
with the Approve Processor Identifier Modifications permission.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code (ECOMM, RETAIL, MOTO, ECOMM_DEBIT, RETAIL_DEBIT, or
MOTO_DEBIT) depends on how the merchant accepts payments through
your TouchNet solutions or other applications.

Terminal ID

Provided by bank. Changes to this information require approval by a user
with the Approve Processor Identifier Modifications permission.

Elavon
(formerly
Nova) -

Merchant
Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Bank ID

• Terminal ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.
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Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.
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Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Bank ID

Provided by bank. Length is 6 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

IP Registration Key

Enter this value, which Elavon assigned to TouchNet:
58U5VD25ZU1Q140i35U3

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Max Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is $999,999.99.
Do not enter dollar sign or commas.
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Max Batch Amount

Maximum dollar amount for credits and sales to allow in a batch, up to
$999,999.99. Do not enter the dollar sign or the decimal with the amount.
Payment Gateway uses this setting to split large batches into smaller ones.

Max Batch Count

Maximum combined number of credits or sales to allow in a batch, up to
999. The maximum number of debit transactions is 920. Payment Gateway
uses this setting to split large batches into smaller batches.

Merchant Cards or Card Table

Credit card types that the merchant accepts.

Minimum Auth Amount 

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

Read Timeout and Write Timeout

Enter the number of milliseconds Payment Gateway will wait for a response
from the card processor. TouchNet suggests a setting of 300000. (300-
second timeout.)

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Signature Debit Only

Select the Yes radio button to designate your credit card merchant to accept
signature debit only transactions. This designation is only for credit card
merchants.

Note: Contact TouchNet to obtain a license key for signature debit
only merchants.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.
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Target Market Type

The code (ECOMM, MOTO, RETAIL, ECOMM_DEBIT, MOTO_DEBIT, or
RETAIL_DEBIT) depends on how the merchant accepts payments through
your TouchNet solutions or other applications.

Tax Rate

Required by Elavon in your configuration but is not typically used by
applications. It is used only for payments made with
commercial/corporate/purchasing cards. If your application takes this type of
payment, enter the tax rate. If the merchant is tax exempt, enter zero. The
format is #.###. For example, a tax rate of 7.625% would be specified as
7.625.

Terminal ID

Provided by bank. Length is 22 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

FDC Nashville -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Merchant ID

• Terminal ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

11 Digit Phone Format

Format to use when dialing the phone number including the area code.
Include any prefix used in dialing out. Use commas for pauses, and use the
question mark symbol for each phone number digit to dial.
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Example: If your system requires you to dial 8 before dialing a long
distance number, you would enter 8?,???,???,???? in this field.

Example: If you needed to dial a code after the long distance number (in
our example, the code is 23), you would enter 8?,???,???,????,23 in this
field.

7 Digit Phone Format

Format to use when dialing the phone number without an area code.
Include any prefix used in dialing out. Use commas for pauses, and use the
question mark symbol for each phone number digit to dial.

Example: If your system requires you to dial 9 before dialing a local
number, you would enter 9,???,???? in this field.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 
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Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

Datawire Device ID

Datawire Device ID for IP connectivity. Provided by bank.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.
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Maximum Auth Amount

Maximum dollar amount the merchant will authorize. You can enter up to
9999999 as the value, for the highest allowed authorization of $99,999.99.
Do not enter the dollar sign, decimal point, or commas.

Maximum Batch Amount

Maximum dollar amount for credits and sales to allow in a batch, up to
$999,999.99. Do not enter the dollar sign or the decimal with the amount.

For instance, if you set the maximum batch amount to 50000000, each
batch can contain up to $500,000 in sales and $500,000 in credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Maximum Batch Count

Maximum number of credits or sales to allow in a batch, up to 998.

For instance, if you set this number to 998, the batch can include up to 998
sales and 998 credits. Payment Gateway uses this setting to split large
batches into smaller batches.

Merchant Cards or Merchant Table

Credit card types that the merchant accepts.

Merchant ID

Provided by bank. Maximum length is 11 characters. Changes to this
information require approval by the user with the Approve Processor
Identifier Modifications permission.

To match the Merchant ID with a merchant name, go to Payment
Processing Setup > [payment type] > Merchant. Select a merchant. The
Merchant ID displays at the top of the page.

Merchant Zip Code

ZIP code for merchant location. Maximum length is 9 characters.

Minimum Auth Amount

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

Phone Number

Dial-up number. Provided by the processor.
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Primary URL

Assigned Primary URL for IP connectivity. Provided by bank or processor.

Read Timeout and Write Timeout

Number of milliseconds Payment Gateway will wait for a response from the
processor. TouchNet suggests 60000 (60-second timeout.)

Secondary URL

Assigned Secondary URL for IP connectivity. Provided by bank or processor.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Signature Debit Only

Select the Yes radio button to designate your credit card merchant to accept
signature debit only transactions. This designation is only for credit card
merchants.

Note: Contact TouchNet to obtain a license key for signature debit
only merchants.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code (ECOMM, RETAIL, or MOTO) depends on how the merchant
accepts payments through your TouchNet solutions or other applications.

Tax Rate

Required by FDC in your configuration but is not typically used by
applications. It is used only for payments made with commercial cards
(corporate cards). If your application takes this type of payment, enter the
tax rate. If the merchant is tax exempt, enter zero. The format is #.###. For
example, a tax rate of 7.625% would be specified as 7.625.

Terminal ID

Provided by bank. Maximum length is 11 characters. Changes to this
information require approval by the user with the Approve Processor
Identifier Modifications permission.
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FDC North -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Merchant ID

• Terminal ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.
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Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.
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CustSvcPhoneNum

Merchant’s customer service telephone number with area code. EComm
and MOTO merchants only.

CustSvcURL_or_EMail

Merchant’s customer service URL or email address. EComm merchants
only.

Datawire Device ID

Datawire Device ID for IP connectivity. Provided by bank.

Datawire Service Discovery URL

URL to be used to find out where IP-based transactions should be sent.

Datawire Transaction Count Before Ping

Number of transactions between each ping of the Datawire server.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Market Type

The code (ECOMM, MOTO, RETAIL, or RETAIL_DEBIT) depends on how
the merchant accepts payments through your TouchNet solutions or other
applications. Enter the correct code as instructed by your bank.

Maximum Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is $999,999.99.
Do not enter the dollar sign, decimal point, or commas.

Maximum Batch Amount

Maximum total dollar amount for credits and sales allowed in a batch, up to
$21,474,836.47. Do not enter the dollar sign or the decimal with the
amount.

For instance, if you set the maximum batch amount to 10000000, each
batch can contain up to $100,000 total in sales and credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Maximum Batch Count

Maximum combined number of credits or sales allowed in a batch. Payment
Gateway uses this setting to split large batches into smaller batches. First
Data recommends 350.
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Merchant Cards or Card Table

Credit card types that the merchant accepts.

Merchant ID

Merchant ID provided by bank. Maximum length is 12 characters. Changes
to this information require approval by the user with the Approve Processor
Identifier Modifications permission.

To match the Merchant ID with a merchant name, go to Payment
Processing Setup > [payment type] > Merchant. Select a merchant. The
Merchant ID displays at the top of the page.

Minimum Auth Amount

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

PrintCustSvcNum

Indicates whether to print the Cust Service Telephone Number on the
customer’s Visa bill. If not specified, this defaults to yes. EComm and
MOTO merchants only.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Signature Debit Only

Select the Yes radio button to designate your credit card merchant to accept
signature debit only transactions. This designation is only for credit card
merchants.

Note: Contact TouchNet to obtain a license key for signature debit
only merchants.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.
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Terminal ID

Terminal ID provided by bank. Maximum length is 6 characters. Changes to
this information require approval by the user with the Approve Processor
Identifier Modifications permission.

FDC South -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Merchant ID

• Terminal ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.
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Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.
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Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

Datawire Device ID

Datawire Device ID for IP connectivity. Provided by bank.

Datawire Service Discovery URL

Provided by Datawire. This is the Datawire Service Discovery URL, which
is the URL used to request the URL necessary for processing transactions.

Datawire Transaction Count Before Ping

Number of transactions between each ping of the Datawire server.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Max Detail Items

Maximum number of items to group when sending detail data during batch
settlement.

Maximum Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is $999,999.99.
Do not enter the dollar sign, decimal point, or commas.

Maximum Batch Amount

Maximum total dollar amount for credits and sales allowed in a batch, up to
$21,474,836.47. Do not enter the dollar sign, decimal point, or commas.

For instance, if you set the maximum batch amount to 10000000, each
batch can contain up to $100,000 total in sales and credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Maximum Batch Count

Maximum combined number of credits or sales to allow in a batch, up to
9999. Payment Gateway uses this setting to split large batches into smaller
batches.

Merchant Cards or Card Table

Credit card types that the merchant accepts.
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Merchant ID

Provided by bank. To match the Merchant ID with a merchant name, go to
Payment Processing Setup > [payment type] > Merchant. Select a
merchant. The Merchant ID displays at the top of the page. Changes to this
information require approval by the user with the Approve Processor
Identifier Modifications permission.

Minimum Auth Amount 

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Number of IP Connections to Create

TouchNet recommends you leave this value set to 4.

Primary URL

Assigned Primary URL for IP connectivity. Provided by bank or processor.

QUAL CODE

Qual code as assigned by FDC South. Entry is 8 characters long.

Read Timeout and Write Timeout

Number of milliseconds Payment Gateway will wait for a response from the
processor. TouchNet suggests 60000 (60-second timeout.)

Secondary URL

Assigned Secondary URL for IP connectivity. Provided by bank or processor.

SE Number for AMEX

Service establishment number for AMEX (assigned by FDC South).

SE Number for CARTE BLANCHE

Service establishment number for CARTE BLANCHE (assigned by FDC
South).

SE Number for DINER'S CLUB

Service establishment number for DINER’S CLUB (assigned by FDC South).

SE Number for DISCOVER

Service establishment number for DISCOVER (assigned by FDC South).
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Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

SICCode

Standard Industry Code. The SIC code for higher education is 8220. Contact
your card processor or bank to confirm your SIC code if you are not sure
what it is. This value is required for debit merchants.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code (ECOMM, MOTO, RETAIL, or RETAIL_DEBIT) depends on how
the merchant accepts payments through your TouchNet solutions or other
applications.

Tax Rate

Required by FDC in your configuration but is not typically used by
applications. It is used only for payments made with commercial cards
(corporate cards). If your application takes this type of payment, enter the
tax rate. If the merchant is tax exempt, enter zero. The format is #.###. For
example, a tax rate of 7.625% would be specified as 7.625.

Terminal ID

Provided by bank. Changes to this information require approval by the user
with the Approve Processor Identifier Modifications permission.

First Horizon -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.
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This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data
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Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Acquirer BIN (Bank ID Number)

Provided by bank. Length is 6 characters.

Agent Bank Number

Provided by bank. Length is 6 characters.

Agent Chain Number

Provided by bank. Length is 6 characters.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

City Code

Your ZIP code. You may enter either the 5 or 9-digit code. Do not use
hyphens.

Country Code

Do not change the default. Specifies US as the country.

Currency Code

Do not change the default. Specifies US currency.

Host for IP connectivity

If SSL is used, the assigned host for IP connectivity. Provided by bank.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Max Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is
$21,474,836.47. Do not enter the dollar sign, decimal point, or commas.
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Max Batch Amount

Maximum total dollar amount for credits and sales allowed in a batch, up to
$21,474,836.47. Do not enter the dollar sign, decimal point, or commas.

For instance, if you set the maximum batch amount to 10000000, each
batch can contain up to $100,000 total in sales and credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Max Batch Count

Maximum combined number of credits or sales to allow in a batch, up to
10,000. Payment Gateway uses this setting to split large batches into
smaller batches.

Max Detail Items

Maximum number of items to group when sending detail data during batch
settlement.

Merchant Cards or Card Table

Credit card types that the merchant accepts.

Merchant Category

Your industry classification, provided by bank. Length is 4 characters.

Merchant City

Your city or merchant phone number. Maximum length is 13 characters.

Merchant Link Customer ID

Provided by bank or processor.

Merchant Location Number

Location number assigned by your bank. Length is 5 characters. If no
merchant location number is assigned by your bank, enter 00001.

Merchant Name

Merchant name that will appear on cardholder statement. Provided by bank.
Maximum length is 25 characters.

Merchant Number

Your merchant ID number, provided by bank. Length is 12 characters.

To match the Merchant Number with a merchant name, go to Payment
Processing Setup > [payment type] > Merchant. Select a merchant. The
Merchant Number displays at the top of the page.

Merchant State

Your state code. Use the 2-character, uppercase state abbreviation.
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Minimum Auth Amount 

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Primary URL

Assigned Primary URL for IP connectivity. Provided by bank or processor.

Primary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.

Read Timeout and Write Timeout

Enter the number of milliseconds Payment Gateway will wait for a response
from the credit card processor. TouchNet suggests a setting of 60000. (60-
second timeout.)

Reimbursement Attribute

First Horizon will provide this 1-character value, which designates the
reimbursement fee applicable to a transaction.

Secondary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.

Secondary URL

Assigned Secondary URL for IP connectivity. Provided by bank or processor.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Store Number

Provided by bank. Length is 4 characters.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code, either ECOMM, MOTO, RETAIL, or RETAIL_DEBIT, depends on
how the merchant accepts payments through your TouchNet solutions or
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other applications.

Tax Rate

Required by First Horizon in your configuration but is not typically used by
applications. It is used only for payments made with commercial cards
(corporate cards). If your application takes this type of payment, enter the
tax rate. If the merchant is tax exempt, enter zero. The format is #.###. For
example, a tax rate of 7.625% would be specified as 7.625.

Terminal Number

Provided by bank. Length is 4 characters.

Terminal or V-Number

Terminal ID assigned by your bank. Also known as a V-Number. Length is 8
characters.

Time Zone

Merchant time zone, specified in a 3-digit code. If your bank does not
provide this code, use this list to find your time zone code:

705 - Eastern time zone

706 - Central time zone

707 - Mountain time zone

708 - Pacific time zone

105 - Eastern Standard Time (daylight savings not observed)

107 - Arizona (daylights savings not observed)

Use Merchant Batch Num

Enter "true" if you want the batch numbers to be sequential on a merchant
by merchant basis. Ask your processor what is preferred.

Global
Payment

Systems East -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Bank ID

• Merchant ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.
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Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.
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Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Bank ID

Provided by bank. Length is 6 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Maximum Auth Amount 

Maximum dollar amount the merchant will authorize. You can enter up to
99999999 as the value, for the highest allowed authorization of
$999,999.99. Do not enter the dollar sign, decimal point, or commas.
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Maximum Batch Amount

Maximum dollar amount for credits and sales to allow in a batch, up to
$21,474,836.47. Do not enter the dollar sign, decimal point, or commas.

Example: If you set the max batch amount to 50000000, each batch can
contain up to $500,000 in sales and $500,000 in credits. Payment Gateway
uses this setting to split large batches into smaller ones.

Maximum Batch Count

Maximum number of credits or sales to allow in a batch, up to 5120.

Example: If set to 999, the batch can include up to 999 sales and 999
credits. Payment Gateway uses this setting to split large batches into
smaller ones.

Merchant Cards or Card Table

Credit card types that the merchant accepts.

Merchant ID

Provided by bank. Length is 15 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

To match the Merchant ID with a merchant name, go to Payment
Processing Setup > [payment type] > Merchant. Select a merchant. The
Merchant ID displays at the top of the page.

Minimum Auth Amount 

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

Override

Specifies whether to allow duplicate transactions within a batch. To enable
duplicate transactions, select Yes. To disallow duplicate transactions, select
No.

If your display shows text fields instead of a selection, enter True to enable
duplicate transactions or False to disallow them.

Primary Host IP Address

IP address for IP connectivity, provided by bank.

Primary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.
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Route Data

Provided by bank. Sent to Global Payments and echoed back as part of
transaction validation. Min length 6 characters. Max length 20 characters.

Secondary Host IP Address

Secondary IP address for IP connectivity, provided by bank.

Secondary Port for IP Connectivity 

If SSL is used, the assigned port for IP connectivity. Provided by bank.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

SSL Cert File Directory

For IP connectivity. Path to the \certs directory within Payment Gateway. If
you have installed Payment Gateway to a different directory, correct the
path.

SSL Gateway Processing Mode

For IP connectivity, leave set to PRODUCTION.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code (ECOMM, MOTO, RETAIL, ECOMM_DEBIT, MOTO_DEBIT, or
RETAIL_DEBIT) depends on how the merchant accepts payments through
your TouchNet solutions or other applications.

Tax Rate

Required by Global Payments in your configuration but is not typically used
by applications. It is used only for payments made with commercial cards
(corporate cards). If your application takes this type of payment, enter the
tax rate. If the merchant is tax exempt, enter zero. The format is #.###. For
example, a tax rate of 7.625% would be specified as 7.625.

Use SSL Gateway

For IP connectivity, leave set to TRUE.
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Moneris e-
Select Plus -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• ECR Number

• Store ID

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.

CONFIDENTIAL

3.0  Payment Processing Setup 51



52 Chapter 3

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

APIToken

Provided by Moneris e-Select Plus. Numeric and up to 20 characters.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

ECR Number

Provided by Moneris e-Select Plus. It is alphanumeric and 8 characters.
Changes to this information require approval by the user with the Approve
Processor Identifier Modifications permission.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Merchant Cards or Merchant Table

Credit card types that the merchant accepts.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

Primary URL

Assigned Primary URL for IP connectivity. Provided by Moneris e-Select
Plus.

Read Timeout and Write Timeout

Enter the number of milliseconds Payment Gateway will wait for a response
from the credit card processor. TouchNet suggests a setting of 60000. (60-
second timeout.)

Secondary URL

Assigned Secondary URL for IP connectivity. Provided by Moneris e-Select
Plus.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

StoreID

Provided by Moneris e-Select Plus. Alphanumeric and up to 10 characters.
Changes to this information require approval by the user with the Approve
Processor Identifier Modifications permission.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.
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This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code (ECOMM, MOTO, RETAIL, ECOMM_DEBIT, or MOTO_DEBIT)
depends on how the merchant accepts payments through your TouchNet
solutions or other applications.

Important! The combination of the ECR Number, StoreID, and APIToken
must be unique for each merchant. If not, closing a batch for one
merchant may unintentionally close batches for other merchants and
reporting data may be incorrect. Your institution should work closely with
Moneris e-Select Plus to make sure that you are given a unique set of
values for each merchant.

Paymentech -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Client Number

• Merchant Number

• Terminal Number

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.
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This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.
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Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default is OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

Client Number

Provided by bank. Length is 4 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Maximum Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is $99,999.99. Do
not enter the dollar sign, decimal point, or commas.

Maximum Batch Amount

Maximum total dollar amount for credits and sales allowed in a batch, up to
$999,999.99. Do not enter the dollar sign, decimal point, or commas.

For instance, if you set the maximum batch amount to 10000000, each
batch can contain up to $100,000 total in sales and credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Maximum Batch Count

Maximum combined number of credits or sales to allow in a batch, up to
998. Payment Gateway uses this setting to split large batches into smaller
batches.

Merchant Cards or Card Table

Credit card types that the merchant accepts.
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Merchant Number

Provided by bank. Length is 12 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Minimum Auth Amount

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Net Connect Enable Keep Alive

Used during batch settlement to keep connection alive. Provided by
Paymentech.

Net Connect Password

Password for IP connectivity, provided by Paymentech.

Net Connect User Name

User name for IP connectivity, provided by Paymentech.

Number of IP Connections

TouchNet recommends you leave this value set to 4.

Primary URL 

Assigned Primary URL for IP connectivity. Provided by bank or processor.

Secondary URL 

Assigned Secondary URL for IP connectivity. Provided by bank or processor.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.
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Target Market Type

The code (ECOMM, MOTO, RETAIL, RETAIL_DEBIT) depends on how the
merchant accepts payments through your TouchNet solutions or other
applications.

Tax Rate

Required by Paymentech in your configuration but is not typically used by
applications. It is used only for payments made with commercial cards
(corporate cards). If your application takes this type of payment, enter the
tax rate. If the merchant is tax exempt, enter zero. The format is #.###. For
example, a tax rate of 7.625% would be specified as 7.625.

Terminal Number

Provided by bank. Length is 3 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

RBSLynk -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Client Number

• Merchant Number

• Terminal Number

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

ABANumber

RBSLynk will provide this 9-character numeric value or instruct you to enter
0 for this field. Required for debit.
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Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.

Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.
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Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.

Acquirer BIN (Bank ID Number)

Provided by bank. Length is 6 characters.

Agent Bank Number

Provided by bank. Length is 6 characters.

Agent Chain Number

Provided by bank. Length is 6 characters.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

City Code

Your ZIP code. You may enter either the 5 or 9-digit code. Do not use
hyphens.

Country Code

Do not change the default. Specifies US as the country.

Currency Code

Do not change the default. Specifies US currency.
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Debit Sharing Group

A 1 to 30-character field provided by RBSLynk. Required for debit.

Host for IP connectivity

If SSL is used, the assigned host for IP connectivity. Provided by bank.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.

Max Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is
$21,474,836.47. Do not enter dollar sign, decimal point, or commas.

Max Batch Amount

Maximum total dollar amount for credits and sales allowed in a batch, up to
$21,474,836.47. Do not enter the dollar sign, decimal point, or commas.

For instance, if you set the maximum batch amount to 10000000, each
batch can contain up to $100,000 total in sales and credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Max Batch Count

Maximum combined number of credits or sales to allow in a batch, up to
10,000. Payment Gateway uses this setting to split large batches into
smaller batches.

Max Detail Items

Maximum number of items to group when sending detail data during batch
settlement.

Merchant Cards or Card Table

Credit card types that the merchant accepts.

Merchant Category

Your industry classification, provided by bank. Length is 4 characters.

Merchant City

Your city or merchant phone number. Maximum length is 13 characters.

Merchant Location Number

Location number assigned by your bank. Length is 5 characters. If no
merchant location number is assigned by your bank, enter 00001.
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Merchant Name

Merchant name that will appear on cardholder statement. Provided by bank.
Maximum length is 25 characters.

Merchant Number

Your merchant ID number, provided by bank. Length is 12 characters.

To match the Merchant Number with a merchant name, go to Payment
Processing Setup > [payment type] > Merchant. Select a merchant. The
Merchant Number displays at the top of the page.

Merchant State

Your state code. Use the 2-character, uppercase state abbreviation.

Minimum Auth Amount 

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Primary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.

Read Timeout and Write Timeout

Enter the number of milliseconds Payment Gateway will wait for a response
from the credit card processor. TouchNet suggests a setting of 60000. (60-
second timeout.)

Reimbursement Attribute

RBSLynk will provide this 1-character value, which designates the
reimbursement fee applicable to a transaction.

Secondary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.

SettleAgentNumber

RBSLynk will provide this 4-character value or will instruct you to enter 0
for this field. Required for debit.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Store Number

Provided by bank. Length is 4 characters.
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Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.

This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code, either ECOMM, MOTO, RETAIL, RETAIL_DEBIT, depends on
how the merchant accepts payments through your TouchNet solutions or
other applications.

Tax Rate

Required by RBSLynk in your configuration but is not typically used by
applications. It is used only for payments made with commercial cards
(corporate cards). If your application takes this type of payment, enter the
tax rate. If the merchant is tax exempt, enter zero. The format is #.###. For
example, a tax rate of 7.625% would be specified as 7.625.

Terminal Number

Provided by bank. Length is 4 characters.

Terminal or V-Number

Terminal ID assigned by your bank. Also known as a V-Number. Length is 8
characters.

Time Zone

Merchant time zone, specified in a 3-digit code. If your bank does not
provide this code, use this list to find your time zone code:

705 - Eastern time zone

706 - Central time zone

707 - Mountain time zone

708 - Pacific time zone

105 - Eastern Standard Time (daylight savings not observed)

107 - Arizona (daylights savings not observed)

Use Merchant Batch Num

Enter "true" if you want the batch numbers to be sequential on a merchant
by merchant basis. Ask your processor what is preferred.
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TSYS Acquiring
Solutions
(formerly

Vital) -
Merchant

Config Fields

If you have the Modify Processor Identifier permission you can make
changes to these merchant configuration fields. Changes to the following
fields require approval by the user assigned the Approve Processor Identifier
Modifications permission.

• Acquirer BIN (Bank ID Number)

• Agent Bank Number

• Agent Chain Number

• Merchant Number

• Store Number

• Terminal Number

• Terminal or V–Number

When changes are made to these fields, an email notification is sent to any
user with the Administrator role and any user with the Approve Processor
Identifier Modifications permission. When the Administrator or Approver
logs in to Payment Gateway a list of the changes that need to be approved
display on the Payment Gateway home page. See "Maintaining Merchant
Information" on page 71 for more information about how to approve
merchant information changes.

Important! If you have both the Modify Processor Identifier and Approver
permissions, you can make changes to the merchant configuration fields,
but you can not approve your own changes.

Note: The credit card and debit merchant config fields you encounter in
your Payment Gateway Operations Center may differ from this list in some
ways. You may not see all of the these fields, and in some cases, a few of
your fields may have slightly different names.

ABA Number

TSYS Acquiring Solutions will provide this 9-character numeric value or
instruct you to enter 0 for this field. Required for debit.

Account Verification/Lockout

Select the Yes radio button to enable the account verification/lockout
feature for this merchant. When this feature is enabled, your school can
track credit card and debit card transaction authorization successes and
failures. You can also determine how long to track these authorizations and
what action should be taken for failures.

This allows schools to set the number of failed authorization attempts, track
them within a specified amount of time and prevent another authorization
from being attempted until the specified time has expired.

This is a form of velocity checking that attempts to prevent fraud.
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Auto Account Verification
This feature determines if Payment Gateway will automatically create a
zero-dollar or low dollar AVS/Authorization only request prior to the
original authorization request.

Using the Zero Dollar Authorization

Your school may want to use the zero-dollar AVS transaction if restrict
on AVS is turned on because only the AVS data are checked and the
funds are not encumbered. If the AVS data are invalid, the original
authorization request will not be attempted.

Using the Low Value Authorization

Your school may want to use the low value authorization if restrict on
AVS and/or CVV is turned on. Therefore, Payment Gateway will
check AVS and/or CVV data before authorizing the original amount
because only the specified low value amount will be encumbered by
the authorization. If the AVS and/or CVV data are invalid, the original
authorization request is not attempted.

To enable the auto account verification feature, complete the following
fields: 

Enable

Select the Yes radio button to turn on the auto account verification
requests. The default setting is no, indicating the auto account
verification feature is disabled.

Amount threshold which generates verification request

Enter the minimum amount (in cents) that will generate an system-
generated verification request.

Amount of verification request

Enter the amount (in cents) that will display in the verification
request.

Send AVS Data

Select the Yes radio button to include the address verification system
code (AVS) in the account verification request.

Select the No radio button to exclude the AVS code in the account
verification request.

Send CVV Data

Select the Yes radio button to include the credit card validation value
(CVV) in the account verification request.

Select the No radio button to exclude the CVV in the account
verification request.
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Acquirer BIN (Bank ID Number)

Provided by bank. Length is 6 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Agent Bank Number

Provided by bank. Length is 6 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Agent Chain Number

Provided by bank. Length is 6 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Batch Time

Time when Payment Gateway attempts to close/settle open batches. To turn
off automatic batch scheduling for a merchant, enter OFF. Default setting is
OFF.

Enter the time in military format (for example, 11:00 p.m. is entered as
23:00). Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in the
Central time zone.

City Code

Your ZIP code. You may enter either the 5 or 9-digit code. Do not use
hyphens.

Country Code

Do not change the default. Specifies US as the country.

Currency Code

Do not change the default. Specifies US currency.

Debit Sharing Group

A 1 to 30-character field provided by TSYS Acquiring Solutions. Required
for debit.

Host for IP connectivity

If SSL is used, the assigned host for IP connectivity. Provided by bank.

Long Description

Other information you want to save that describes the merchant. This is not
used by your bank, only the Operations Center. 80 character maximum.
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Max Auth Amount

Maximum amount that can be attempted to be authorized for a single
transaction. The maximum authorization amount allowed is
$21,474,836.47. Do not enter dollar sign or commas.

Max Batch Amount

Maximum total dollar amount for credits and sales allowed in a batch, up to
$21,474,836.47. Do not enter the dollar sign, the decimal point, or commas
with the amount.

For instance, if you set the maximum batch amount to 10000000, each
batch can contain up to $100,000 total in sales and credits. Payment
Gateway uses this setting to split large batches into smaller batches.

Max Batch Count

Maximum combined number of credits or sales to allow in a batch, up to
10,000. Payment Gateway uses this setting to split large batches into
smaller batches.

Max Detail Items

Maximum number of items to group when sending detail data during batch
settlement.

Merchant Cards or Card Table

Credit card types that the merchant accepts.

Merchant Category

Your industry classification, provided by bank. Length is 4 characters.

Merchant City

Your city or merchant phone number. Maximum length is 13 characters.

Merchant Location Number

Location number assigned by your bank. Length is 5 characters. If no
merchant location number is assigned by your bank, enter 00001.

Merchant Name

Merchant name that will appear on cardholder statement. Provided by bank.
Maximum length is 25 characters.

Merchant Number

Your merchant ID number, provided by bank. Length is 12 characters.
Changes to this information require approval by the user with theApprove
Processor Identifier Modifications permission.
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To match the Merchant Number with a merchant name, go to Payment
Processing Setup > [payment type] > Merchant. Select a merchant. The
Merchant Number displays at the top of the page.

Merchant State

Your state code. Use the 2-character, uppercase state abbreviation.

Minimum Auth Amount 

Minimum dollar amount the merchant will authorize. Do not enter the
dollar sign or the decimal with the amount. You can enter down to 1 as the
value, for the lowest authorized amount of $0.01.

Primary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.

Read Timeout and Write Timeout

Enter the number of milliseconds Payment Gateway will wait for a response
from the credit card processor. TouchNet suggests a setting of 60000. (60-
second timeout.)

Reimbursement Attribute

TSYS Acquiring Solutions will provide this 1-character value, which
designates the reimbursement fee applicable to a transaction.

Secondary Port for IP Connectivity

If SSL is used, the assigned port for IP connectivity. Provided by bank.

SettleAgentNumber

TSYS Acquiring Solutions will provide this 4-character value or will instruct
you to enter 0 for this field. Required for debit.

Short Description

Required field. Label to use in the Operations Center for the merchant. This
is not used by your bank, only the Operations Center. 20 character
maximum.

Store Number

Provided by bank. Length is 4 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Subdirectory

Required field. Payment Gateway stores payment data for the merchant’s
reports in this subdirectory. Choose a unique name similar to the name of
your merchant. Each merchant needs its own subdirectory name.
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This entry is required to correctly generate your reports. Do not change it
after you have processed your first authorization with Payment Gateway.

Target Market Environment or Target Market Type

The code, either ECOMM, MOTO, RETAIL, RETAIL_DEBIT, depends on
how the merchant accepts payments through your TouchNet solutions or
other applications.

Tax Rate

Required by TSYS Acquiring Solutions in your configuration but is not
typically used by applications. It is used only for payments made with
commercial cards (corporate cards). If your application takes this type of
payment, enter the tax rate. If the merchant is tax exempt, enter zero. The
format is #.###. For example, a tax rate of 7.625% would be specified as
7.625.

Terminal Number

Provided by bank. Length is 4 characters. Changes to this information
require approval by the user with the Approve Processor Identifier
Modifications permission.

Terminal or V-Number

Terminal ID assigned by your bank. Also known as a V-Number. Length is 8
characters. Changes to this information require approval by the user with
the Approve Processor Identifier Modifications permission.

Time Zone

Merchant time zone, specified in a 3-digit code. If your bank does not
provide this code, use this list to find your time zone code:

705 - Eastern time zone

706 - Central time zone

707 - Mountain time zone

708 - Pacific time zone

105 - Eastern Standard Time (daylight savings not observed)

107 - Arizona (daylights savings not observed)

Use Merchant Batch Num

Enter "true" if you want the batch numbers to be sequential on a merchant
by merchant basis. Ask your processor what is preferred.
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3.6 Adding a New Combo Merchant

Important! This combo merchant configuration only applies to Canadian
customers using the Moneris eSelect Plus processor.

A combo merchant is a TouchNet merchant that processes credit card and
debit card payments.

To enable the combo merchant feature in the Payment Gateway Operations
Center, from the home page, navigate to: Payment Processing Setup >
Credit Card > Merchant.

On the Credit Card – Merchant Configuration page, in the Enable Debit for
POS Merchant field, click the Yes radio button. Combo merchants are
identified by a credit-debit tag following the merchant name, on the
Merchant Configuration page.

Follow these steps to add a new combo merchant. This process requires
administrator rights.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > Credit Card > Merchant Configuration > Add
Merchant. The Add Merchant Credit Card page displays.

Required fields display a red exclamation mark box next to them.

Note: The fields are automatically populated with default values.
Change any values for the combo merchant you are adding. Your bank
will supply most of the information needed to complete the fields.

2 In the Short Description field, enter the label that displays in the
Operations Center for the account. This is the merchant name that
displays in reports and in Merchant's Activity.

3 In the Long Description field, enter a description for the merchant
account.

4 In the Merchant ID field, enter the merchant Ia name for the
directory where the account's payment data will be stored. Enter only
the directory name, not the full path. Do not use a subdirectory name
that you have already used for another merchant.

5 In the Enable Debit for POS merchant field, click the Yes radio
button.

Note: Combo merchants are identified by a credit-debit tag following the
merchant name.
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3.7 Maintaining Merchant Information
Your bank, credit card processor, or debit processor may occasionally send
you updated merchant information. You must enter the correct, current
information using the Merchant Configuration options under the Payment
Processing Setup option in the Payment Gateway Operations Center.

If you receive updated merchant information from your bank or processor
and do not update your configuration, your payment transactions may not
process properly. You must be assigned the Modify Processor Identifier
and/or the Approve Processor Identifiers Modifications role as well as the
TPG Administrator role change or approve merchant configuration
information.

Step-by-step information about how to change merchant configuration
information as well as detailed information about the merchant fields for
each processor are also available in Payment Gateway online help.

Important! Never delete text from your primary merchant to leave its
merchant fields blank. All fields must contain values. Leaving the fields
blank results in an inability to view or use merchant data in the
Operations Center.

3.8 Editing and Maintaining Existing Merchants

To edit an existing merchant's configuration information, follow these steps.
This process requires the Modify Processor Identifier permission.

The following lists some important tips to keep in mind when editing
existing merchant information:

• Always keep merchant information current.

• Never change the name of a subdirectory for an existing merchant.
This results in storage of payment data in multiple locations and
poses batch settlement risks. If you must change the subdirectory
name, contact TouchNet Customer Care for help.

• Never use the same subdirectory name for more than one
merchant. Each merchant needs its own subdirectory name.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment type] > Merchant Configuration. The
Merchant Description page for the selected payment type displays.
Depending on the type of merchant information you want to edit,
click on the desired link.
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The Merchant Configuration menu

2 Select the desired merchant configuration option from the left
navigation.

3 Make your changes.

Note: Changes to selected merchant configuration fields and processor
identifier fields must be approved prior to the changes being
accepted. The user with the Approve Processor Identifier
Modifications permission will approve or cancel these changes. See
"Approving Merchant Configuration Changes " on page 80 for
instructions on approving the merchant configuration changes.

4 Save your changes.

5 Stop and restart Payment Gateway. If your TouchNet solutions are
hosted on campus, see "Starting and Stopping Payment Gateway" on
page 89 for instructions. If your TouchNet solutions are hosted in the
TouchNet DataCenter, contact Customer Care for assistance.

Editing the
Merchant

Description

Access the Merchant Description page to edit or update a merchant's name
and description. You must have the Modify Processor Identifiers permission
to edit the merchant description.

Note: The merchant configuration options displayed are determined by the
payment type selected.
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To edit an existing merchant description, follow these steps.

1 From the Payment Gateway home page navigate to Payment
Processing Setup > [payment type] > Merchant Configuration. The
Merchant Description page displays.

The Merchant Description page

2 Select the desired merchant or the desired subtranscode from the
dropdown list.

3 Enter the desired merchant name change in the Short Description
field. The short description can be a maximum of 20 characters.

4 Enter the desired merchant long description in the Long Description
field. The long description can be a maximum of 80 characters.

5 Click the Update button.

Editing the
Processor
Identifiers

The Processor Identifiers page displays the processor identifiers for the
selected payment processor. From this page you can perform the following
actions:

• make changes to the processor identifiers

• approve or cancel processor identifier changes

• view a list of the the changes made to the processor identifiers

Note: The processor identifiers options displayed are determined by the
payment processor selected.

Note: Changes made to an existing merchant's processor identifier
information must be approved prior to the changes being accepted and
saved in Payment Gateway. See the Approving or Cancelling Processor
Identifier Changes steps for more information.
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To make changes to an existing processor identifier, follow these steps.

1 From the left navigation click Payment Processing Setup > [payment
type] > Merchant Configuration > Processor Identifiers. The
Processor Identifiers page displays for the selected payment type.

The Processor Identifiers page

2 Select the desired merchant or subtranscode from the dropdown list.

3 To edit the Merchant ID value, locate the desired processor identifier.
Enter the new value in the Current Value field.

4 Enter a brief description of the change in the Reason for modification
field.

5 Click the Update button.

6 To edit the Terminal ID value, locate the desired terminal ID. Enter
the new value in the Current Value field.

7 Enter a brief description of the change in the Reason for modification
field.

8 Click the Update button.

9 Repeat steps 2-8 for each processor identifier you wish to change.
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Approving or
Cancelling
Processor
Identifier
Changes

Once processor identifier changes are updated in Payment Gateway, an
email notification is sent to the user with the Approve Processor Identifier
Modifications permission. The approver can either approve or cancel the
changes. Changes that are approved are saved in Payment Gateway.
Cancelled changes are deleted and the original configuration settings are
saved in Payment Gateway.

To approve or cancel the processor identifier changes, follow these steps.

1 From the left navigation click Payment Processing Setup > [payment
type] > Merchant Configuration > Processor Identifiers. The
Processor Identifiers page displays for the selected payment type.

The Processor Identifiers page

2 Review the changes, click the Approve Modification button to accept
and approve the changes. The changes are saved in Payment
Gateway.

or

Click the Cancel Modification button to cancel the changes. The
changes are deleted and the original configuration settings are saved
in Payment Gateway.
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Viewing
Processor
Identifiers

History

The Processor Identifier History window allows you to view a listing of the
changes that have been made. You can filter the list to view all changes,
approved changes only, or cancelled changes only. You can not edit the
Processor Identifiers from this window.

The Processor Identifier History window
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Approving or
Cancelling
Processor
Identifier
Changes

Once processor identifier changes are updated in Payment Gateway, an
email notification is sent to the user with the Approve Processor Identifier
Modifications permission. The approver can either approve or cancel the
changes. Changes that are approved are saved in Payment Gateway.
Cancelled changes are deleted and the original configuration settings are
saved in Payment Gateway.

To approve or cancel the processor identifer changes, follow these steps.

1 From the left navigation click Payment Processing Setup > [payment
type] > Merchant Configuration > Processor Identifiers. The
Processor Identifiers page displays for the selected payment type.

The Processor Identifiers page

2 Review the changes, click the Approve Modification button to accept
and approve the changes. The changes are saved in Payment
Gateway.

or

Click the Cancel Modification button to cancel the changes. The
changes are deleted and the original configuration settings are saved
in Payment Gateway.
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Viewing
Processor
Identifiers

History

The Processor Identifier History window allows you to view a listing of the
changes that have been made. You can filter the list to view all changes,
approved changes only, or cancelled changes only. You can not edit the
Processor Identifiers from this window.

The Processor Identifier History window
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Editing the
Merchant
General

Configuration

Access the Merchant Configuration page to edit or update a merchant's
configuration settings. You must have the Modify Processor Identifiers
permission to edit the merchant configuration.

To edit an existing merchant configuration, follow these steps.

1 From the Payment Gateway home page navigate to Payment
Processing Setup > [payment type] > Merchant Configuration >
General Configuration. The Merchant Configuration page displays.

The Merchant Configuration page

2 Select the desired merchant or the desired subtranscode from the
dropdown list.

Note: The merchant configuration options displayed are determined
by the payment type selected.

3 Enter the desired changes in the Configuration fields.

4 Click Save Changes.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.

CONFIDENTIAL

3.0  Payment Processing Setup 79



80 Chapter 3

Note: Changes to selected merchant configuration fields and processor
identifier fields must be approved prior to the changes being
accepted. The user with the Approve Processor Identifier
Modifications permission will approve or cancel these changes. See
"Approving Merchant Configuration Changes " on page 80 for
instructions on approving the merchant configuration changes.

5 Stop and restart Payment Gateway. If your TouchNet solutions are
hosted on campus, see "Starting and Stopping Payment Gateway" on
page 89 for instructions. If your TouchNet solutions are hosted in the
TouchNet DataCenter, contact Customer Care for assistance.

3.9 Approving Merchant Configuration Changes
Selected changes made to an existing merchant's configuration information
must be approved prior to the changes being accepted and saved in
Payment Gateway. A user with the Approve Processor Identifier
Modifications permission must review these changes and either approve or
cancel the changes. Changes that are approved are saved in Payment
Gateway. Cancelled changes are deleted and the original configuration
settings are saved in Payment Gateway.

Changes to existing merchant configuration settings can only be made by
users with the Modify Processor Identifier permission. Once changes are
made, and the user saves the changes, if the configuration information is
flagged for approval, an email notice is sent to the system administrator and
the approver. See the "Configuring Email System Settings" section in the
Payment Gateway 6 Technical User's Guide for more information about
setting up the email notifications.

Email notification indicating changes need approval
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The Payment Gateway home page displays a message notifying the user
that these changes are awaiting approval.

Merchant configuration change notification on the Payment Gateway home page

The merchant configuration changes that must be approved are specific to
each merchant. To approve the merchant configuration changes, follow
these steps.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment type] > Merchant Configuration >
Processor Identifiers. The Processor Identifiers page displays listing
any pending changes.
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The Processor Identifiers page showing pending changes

2 Review the changes. Click the Approve Modifications button to save
and approve the changes.

3 An email notification is generated and sent to the designated users.

Email notification indicating changes were approved

4 Stop and restart Payment Gateway.

If your TouchNet solutions are hosted on campus, see "Starting and
Stopping Payment Gateway" on page 89 for instructions. If your
TouchNet solutions are hosted in the TouchNet DataCenter, contact
Customer Care for assistance.
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3.10 Cancelling Merchant Configuration Changes
Selected changes made to an existing merchant's configuration information
must be approved or cancelled. A user with the Approve Processor
Identifier Modifications permission must review these changes and either
approve or cancel the changes. Cancelled changes are deleted and the
original configuration settings are saved in Payment Gateway.

Changes to existing merchant configuration settings can only be made by
users with the Modify Processor Identifier permission. Once changes are
made, and the user saves the changes, if the configuration information is
flagged for approval, an email notice is sent to the system administrator and
the approver. See the "Configuring Email System Settings" section in the
Payment Gateway 6 Technical User's Guide for more information about
setting up the email notifications.

Email notification indicating changes need approval

The Payment Gateway home page displays a message notifying the user
that these changes are awaiting approval.
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Merchant configuration change notification on the Payment Gateway home page

The merchant configuration changes that need approval or cancelling are
specific to each merchant.

To cancel the merchant configuration changes, follow these steps.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment type] > Merchant Configuration >
Processor Identifiers. The Processor Identifiers page displays listing
any pending changes.
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The Processor Identifiers page showing pending changes

2 Review the changes. If you do not wish to accept these changes, click
the Cancel Modifications button to delete the changes and save the
original configuration settings.

3 An email notification is generated and sent to the designated
administrators indicating the changes were cancelled.

Email notification indicating changes were cancelled
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3.11 Viewing Merchant Configuration History
Some changes made to an existing merchant's configuration information
must be approved prior to the changes being accepted and saved in
Payment Gateway. A user with the Approve Processor Identifier
Modifications permission must review these changes and either approve or
cancel the changes. Changes that are approved are saved in Payment
Gateway. Cancelled changes are deleted and the original configuration
settings are saved in Payment Gateway.

Changes to existing merchant configuration settings can only be made by
users with the Modify Processor Identifier permission. Once changes are
made, and the user saves the changes, if the configuration information is
flagged for approval, an email notice is sent to the system administrator and
the approver. The Payment Gateway home displays a message notifying the
user that these changes are awaiting approval. See the "Configuring Email
System Settings" section in the Payment Gateway 6 Technical
User's Guide for more information about setting up the email notifications.

To view merchant configuration changes history, follow these steps.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment type] > Merchant Configuration >
Processor Identifiers. The Processor Identifiers page displays.

The Processor Identifiers page

2 Click the View History button. The Processor Identifier History
window displays.
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The Processor Identifier History

3 Click the Close Window button.

Cancelling
Merchant

Configuration
Changes

The merchant configuration changes that must be approved are specific to
each merchant. To approve the processor identifiers changes, follow these
steps.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment type] > Merchant Configuration >
Processor Identifiers. The Processor Identifiers page displays.

The Processor Identifiers page

2 Click the View History for the desired processor identifier changes.
The Processor Identifier History window displays.
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The Processor Identifier History

The Processor Identifier History window is used to approve or cancel the
processor identiifier modifications. The pending changes include the
original information, the proposed change, and the reason for the change.

3 Click the Cancelled radio button to cancel the changes and return the
merchant information to the original, saved information.

4 Click the Close Window button.

Step-by-step information about how to change merchant configuration
information as well as detailed information about the merchant fields for
each processor are available in Payment Gateway online help.

Important! Never delete text from your primary merchant or leave the
merchant fields blank. All fields must contain values. Leaving the fields
blank results in an inability to view or use merchant data in the
Operations Center.

Removing a
Merchant

Follow these steps to remove a merchant. This process requires
administrator rights.

Important! TouchNet recommends a best practices policy of never
deleting a merchant that has had production transactions processed against
it. After you remove a merchant, you cannot view reports, process credits,
or settle batches for it. Removing the merchant permanently removes
access to its information.

1 Select the merchant from the Current Merchant dropdown list.

2 Click the Delete Merchant button. If you have selected the default
merchant (the original merchant in Payment Gateway when it was
installed), this button will not appear because you cannot delete the
default merchant.

3 Verify your choice.
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4.0 Starting and Stopping Payment
Gateway

Note: The information in this section is for customers hosted on campus
only. If your solutions are hosted in the TouchNet DataCenter, contact
Customer Care for assistance.

This section describes startup and shutdown procedures for Microsoft
Windows operating systems or UNIX-based operating environment users.
Services for Microsoft Windows NT, Windows 2000, or Windows 2003
users, or shell scripts for Solaris users, as well as all required dependencies,
were set up during installation.

These services run when you start Payment Gateway on Windows-based
systems:

TN_TMGR[port]

Service name includes the Payment Gateway port number. Runs
Payment Gateway’s Transaction Manager component.

TN_PG_SQLLOG

Runs the module that connects to the database that holds payment
information.

TN_PG_TPGUTIL

Runs the module that connects to the database that holds Operations
Center user information.

Starting and
Stopping
Payment
Gateway
(Windows)

To start Payment Gateway, follow these steps.

1 Start your web server.

2 Navigate from the Start menu to Control Panel > Administrative
Tools > Services.

3 Start the Payment Gateway services/processes.

Note: During the original installation of Payment Gateway 6.0, the
Payment Gateway installer created three services on the application
server with the default name of TN_TMGR9460,
TN_PG6_TPGUTIL, and TN_PG6_SQLLOG. Use these services to
start Payment Gateway.

4 Close the Services window.
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To stop Payment Gateway, follow these steps.

1 Navigate from the Start menu to Control Panel > Administrative
Tools > Services.

2 Stop the Payment Gateway services/processes. During the original
installation of Payment Gateway 6.0, the Payment Gateway installer
created three services on the database server: TN_PG6_TPGUTIL,
TN_PG6_SQLLOG, and TN_TMGR9460. Use these services to stop
Payment Gateway.

3 Close the services window.

Starting and
Stopping
Payment
Gateway
(Solaris)

Start your web server before you start Payment Gateway. To start all
Payment Gateway processes as background processes, run this command.

./touchnet/tpg/start-tpg.sh

To stop Payment Gateway, run the following command:

./stop-tpg.sh

Setting Up Boot Time Startup

To set up processes so they start up automatically at boot time, copy the
S99tpg.sh file from your touchnet/tpg directory to the /ect/rc2.d directory.

Starting and Stopping Individual Processes

To run Payment Gateway processes individually in the foreground, run the
following commands. These scripts are located in the touchnet/tpg directory
of your Payment Gateway installation.

/tmgr.sh

/sqllog.sh

/tpgutil.sh

To stop a process that is running in the foreground, press CTRL+C for the
active window where the process is running.
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5.0 Commerce Configuration
When you use a TouchNet U.Commerce Central solution such as
Cashiering or Bill+Payment, you must configure both Payment Gateway
and the commerce solution. This allows for a smooth flow of information
and transactions so that payment information is recorded correctly and funds
are deposited to the correct merchant. Commerce Configuration in the
Payment Gateway Operations Center is where you configure this
information for Payment Gateway.

From the Payment Gateway Home page, click the Commerce Configuration
option in the left navigation menu to view the configuration elements.

Commerce Configuration menu

5.1 Adding and Maintaining Host Systems
The Host Systems page allows you to:

• Add, rename, or remove host systems.

• Add, rename, or remove host system accounts.

• Link payment methods to host system accounts.

• Link merchants to host system accounts.

• Link host payment methods IDs to host system accounts.
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What is a Host
System? 

Host systems in Payment Gateway are simply categories of host system
accounts. Think of them as folders for host system accounts.

The host systems you need in Payment Gateway are determined by the
TouchNet U.Commerce Central applications you use, what you use them
for, and to some extent, the ERP your school uses. For instance, if your
school has TouchNet Bill+Payment, TouchNet Cashiering, and TouchNet
Marketplace, you will likely need the following host systems: 

Important! This list is not definitive. Your TouchNet implementation
specialist will advise you on the proper set of host systems for your
school.

Typical host systems required for all three U.Commerce Central applications

Adding a New
Host System

In commerce configuration, you name your host systems so that payment
information can be routed to the correct data storage framework.

Bill+Payment typically has two host systems, one for student payments and
one for student deposits. TouchNet Cashiering usually has three host
systems: one for student payments and charges, one for finance for
departmental deposits, and one for student deposits. Marketplace has one
host system.

To add a host system, follow these steps. This requires administrator rights.

1 From the Payment Gateway home page, navigate to Commerce
Configuration > Host Systems. The Host Systems page displays.
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The Host Systems page

2 Enter the name of the new host system in the Add Host System
section Name field (at the top of the page).

Add the new host system name

3 Click the Add button. The new host system displays in the Host
Systems section.

Renaming a
Host System

To rename an existing host system, follow these steps. This requires
administrator rights.

Important! To maintain continuity for campus users of your system, it is
best not to change host system names once they are in use.

1 Go to: Commerce Configuration > Host Systems. The Host Systems
page displays.
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The Host Systems page

2 Click the Change button next to the host system you want to rename.

3 Enter the desired changes in the Host System Name field.

Enter the Host System name

4 Click the Save button.

5 Click OK to confirm your changes.

Removing a
Host System

Settings in your commerce solution must match settings in Payment
Gateway. Do not remove commerce configuration elements that are
currently in use by any of your commerce solutions.

Important! Host systems that are currently in use cannot be deleted.

Note: A host system cannot be removed unless the host system accounts
associated with it are deleted first. Refer to "Removing a Host System
Account" on page 102 for instructions on removing a host system account.

To remove a host system, follow these steps. This process requires
administrator rights.

1 Click the trash icon for the host system you want to remove.

2 Click OK to confirm you want to remove the host system.
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5.2 Adding and Maintaining Host System Accounts
From the Host System Accounts page you have the ability to add, edit, and
remove a host system account. You can also link payment methods to a host
system account.

What is a Host
System
Account?

Host system accounts contain information used to process payments and
update bank accounts. This is accomplished by tying one or more payment
methods to a host system account and associating a Payment Gateway
merchant to that payment method.

Each host system contains one or more host system accounts.

For instance, if your school has TouchNet Bill+Payment Suite, TouchNet
Cashiering, and TouchNet Marketplace Suite, you may need the following
host system accounts: 

Important! This list is not definitive. Your TouchNet implementation
specialist will advise you on the proper set of host systems and host
system accounts for your school.

Typical host systems and host system accounts required for all three commerce applications
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Adding a New
Host System

Account

To add a host system account follow these steps. This process requires
administrator rights.

1 From the Payment Gateway home page, navigate to Commerce
Configuration > Host Systems. The Host Systems page displays.

2 Click the View/Edit Accounts button for the host system for which
you want to add an account. The Host System Accounts page displays.

The Host System Accounts page

Before you enter a new HSA, review the Host System field to verify the
host system is correct.

2 Enter the name of the new host system account in the Name field in
the Add Host System Account section at the top of the page.

Add a new host system account

3 Populate the ERP Account Code field based on the following: 

• Schools running Ellucian™'s Colleague® enter the AR Type for the
corresponding account in their host system.

• PeopleSoft schools enter their business unit.

• If your school offers payment plans, enter the code associated with
the payment plan.

• If you are a multi-campus school, enter the code associated with
each campus or student level.
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4 Select the applicable institution from the Institution dropdown list.
This list is populated based on the Institutions that were previously
created in U.Commerce Central for your multi-campus system.

5 Click the Add button.

Note: Next, you must link payment methods (as well as merchants and host
payment method IDs) to the host system account. The only exception is
when you have created a student charge host system account for Cashiering.
Do not add payment methods in this case.

5.3 Linking Host System Accounts

Linking Host
System
Accounts

Linking your host system accounts to your institution provides for detailed
reporting capabilities down to the institution level. This detail is vital for
multi-campus schools; allowing for reporting at the individual institution
level rather than the system level. This institution level detail is presented
to schools via the U.Commerce Central Dashboard.

You must have administrator rights in order to add an HSA and link it to the
appropriate institution.

To link your host system accounts, follow these steps.

1 From the Payment Gateway home page, click the Commerce
Configuration link. The Host Systems page displays.

The Host Systems page

2 Click the View/Edit Accounts button next to the host system you wish
to link. The Host System Accounts page displays.
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The Host System Accounts page

3 Click the Edit button next to the host system account you wish to
link. The Name, ERP Account Code and Institution fields are active
and available to change. To link the HSA to the Institution, we will
only be reviewing the steps to change the Institution field.

4 Select the applicable institution from the Institution dropdown list.
This list is populated based on the Institutions that were previously
created in U.Commerce Central for your multi-campus system.

Select the desired Institution

5 Click the Save button.

In this example, the TouchNet Bill+Payment Banner Student Account
HSA is now linked to the TNDV institution within your multi-campus
system. Any transactions for this HSA will be reported for this
institution on the U.Commerce Central Dashboard. For more
information about the Dashboard, see the U.Commerce Central User
Guide.
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Renaming a
Host

System Account

To rename an existing host system account, follow these steps. This
requires administrator rights.

Important! To maintain continuity for campus users of your system, it is
best not to change host system account names once they are in use.

1 Go to: Commerce Configuration > Host Systems. The Host Systems
page displays.

2 Click the View/Edit Account button for the host system that contains
the host system account you want to rename. The Host System
Accounts page displays.

Changing the name of a host system account

3 Click the Edit button for the host system account you want to rename.

4 Replace the old name with the new one in the Name field.

5 Colleague® users may edit the ERP Account Code, if needed.

6 Click the Save button to save the change, or click the Cancel button
to abandon the change and retain the original name.

7 Click OK to confirm the name change.
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Editing the ERP
Account Code

To edit an existing ERP account code, follow these steps. This requires
administrator rights.

1 Go to: Commerce Configuration > Host Systems. The Host Systems
page displays.

2 Click the View/Edit Account button for the host system that contains
the ERP account code you want to edit. The Host System Accounts
page displays.

Changing the name of a host system account

3 Click the Edit button for the account code you want to edit.

4 Replace the existing code with the new code in the ERP Account
Code field.

The ERP Account Code field

5 Click the Save button.

6 Click OK to confirm your change.
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Editing the
Institution

Code

To edit an existing institution that is linked to a host system account, follow
these steps. This requires administrator rights.

1 Go to: Commerce Configuration > Host Systems. The Host Systems
page displays.

2 Click the View/Edit Account button for the host system that contains
the institution code link you want to edit. The Host System Accounts
page displays.

Changing the name of a host system account

3 Click the Edit button for the institution code you want to edit.

4 Select the desired institution from the dropdown list.

The Institution field

5 Click the Save button.

6 Click OK to confirm your change.
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Removing a
Host System

Account

Settings in your commerce solution must match settings in Payment
Gateway. Do not remove commerce configuration elements that are
currently in use in any of your commerce solutions.

Note: Host system accounts that are currently in use should not be deleted.

Important! Consult with TouchNet Customer Care before making
changes in your product environment. Certain changes may render one or
more of your commerce applications inoperable.

To remove a host system account, follow these steps. This process requires
administrator rights.

1 Click the View/Edit Account button for the host system that contains
the host system account you want to remove.

2 Click the trash icon for the host system account you want to remove.

3 Click OK to confirm removing the HSA.

Important! This will also remove the linked payment method associated
with the HSA.

5.4 Adding and Maintaining User-Defined Payment
Methods

User-defined payment methods can be created to address special payment
methods that exist at your school, such as campus cards. User-defined
payment methods can only be used in TouchNet Cashiering. They are cash-
like payment methods that can be linked to specific host system accounts.

The Payment Methods page allows you to:

• View the list of predefined payment methods already available in
Payment Gateway.

• Add user-defined payment methods, if needed.

• Link payment methods to host system accounts.

What Is a
Payment
Method?

A payment method is a form of money that is acceptable for a particular
host system account. They typically include cash, credit and debit cards,
campus cards, and different types of checks. Each U.Commerce Central
solution allows certain payment methods. For instance, Bill+Payment
allows only credit card, PINless debit, campus cards, or ACH.
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Adding a User-
Defined
Payment
Method

When you set up a commerce solution, some payment methods are pre-
loaded into Payment Gateway. You can also define your own payment
methods, as long as they are cash or cash-like. For example, your school
may sell campus cards that students can use like cash to pay for food or
merchandise on campus only. In this case, you may create a campus card
payment method so that these purchases can be tracked separately.

Create a user-defined payment method when:

• A method you need is not in the pre-loaded list.

• You will need payments processed using the same payment type but
different host payment method IDs (different subcodes or detail
codes, for instance).

Note: Payment method settings in your commerce solution must match
settings in Payment Gateway. Your commerce solution specifies the use of
payment methods named in Payment Gateway.

Payment Methods page

To add a user-defined payment method, follow these steps. This requires
administrator rights.

1 From the Payment Gateway home page, navigate to Commerce
Configuration > Payment Methods. The Payment Methods page
displays.

2 In the Name field, enter a payment method name of up to twenty
characters.

3 Click the Add button.
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Note: Before you can take payments, you must link the payment method to
a host system account and specify further information to show how the
payment method is used with that account. See "Adding and Maintaining
Host System Accounts" on page 95 for more information.

Linking
Payment
Methods to
Host System

Accounts

Before you can link payment methods, you must set up the host system and
host system account that will use them.

The payment method settings in your commerce solution must match the
payment method settings in Payment Gateway. When you take payments
using your commerce solutions, you can use only the payment methods that
have been linked to the appropriate host system accounts in Payment
Gateway.

To link a payment method to a host system account, follow these steps.
This requires administrator rights.

1 From the Payment Gateway home page, navigate to Commerce
Configuration > Host Systems. The Home Systems page displays.

2 To see the host system accounts for a host system, click the View/Edit
Accounts button. The Host System Accounts page displays.
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Link the payment method to the host system account

3 Click the Link Payment Methods button of the host system account
you want to edit. The Link Payment Methods page displays.

The Host System and Host System Account fields are pre-populated
based on your previous selections. Select the desired option from the
dropdown list to change either of these fields.
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Link Payment Methods page

4 Select the applicable payment method that is used to make payments
into the host system account from the Payment Method dropdown list.

To set up a payment method for accepting ACH payments, choose
WebCheck from the dropdown list. To set up credit card payment
methods, select the credit card type (Visa, MasterCard, American
Express, Discover, etc.) from the list.
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The Payment Method dropdown list

5 Select the Payment Gateway merchant that will process payments
from the TPG Merchant dropdown list.

The TPG Merchant dropdown list

6 In the Host System Method ID field, enter the Host Payment Method
ID your school uses in host system accounts to record payments.

The Host Payment Method ID field
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7 Click the Add button. The payment method displays in the Linked
Payment Methods section.

Renaming a
User-Defined

Payment
Method

To rename a user-defined payment method, follow these steps. This
requires administrator rights.

Important! To maintain continuity for campus users of your system, it is
best not to change payment method names once they are in use.

1 From the Payment Gateway home page, navigate to Commerce
Configuration > Payment Methods. The Payment Methods page
displays.

2 Click the Rename button for the payment method you want to
rename.

3 Type the new name in the Name field.

4 Click the Save button to save the change.

5 Click OK to confirm the name change or click the Cancel link to
abandon the change and retain the original name.

Removing a
User-Defined

Payment
Method

To remove a user-defined payment method, follow these steps. This process
requires administrator rights.

Important! Settings in your commerce solution must match settings in
Payment Gateway. If you remove a user-defined payment method in
Payment Gateway, you must remove that same payment method in your
commerce solution.

Note: Payment methods that are currently in use cannot be deleted.

1 From the Payment Gateway home page, navigate to Commerce
Configuration > Payment Methods. The Payment Methods page
displays.

2 Click the trash icon for the payment method you want to remove.

3 Click OK to confirm the removal, or click Cancel to abandon the
change.
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5.5 Commerce Configuration View
The Commerce Configuration View allows you to review your institution's
host system hierarchy. This page displays the host systems that you have set
up for your institution and the associated host system accounts. The ERP
account codes, payment methods and the institution ID are also displayed
for each host system. This page is view only, no changes to host systems or
host system accounts can be made from this page.

To access the Commerce Configuration View from the Payment Gateway
Home page, click the Commerce Configuration option in the left
navigation menu and click the Commerce Configuration View option. The
Commerce Configuration View page displays.

The Commerce Configuration View

To aid in quickly viewing a specific host system, select the desired host
system from the View Host System dropdown menu. The page is redirected
to the host system you selected. To return to the top of the page, click the
Top link.

You can view the commerce configuration information online or export the
information as a comma-separated value (CSV) file. The saved CSV files can
then be opened in spreadsheet programs.
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6.0 Credit Card Payment Processing
The Payment Gateway Operations Center is used to track and manage the
credit card payments your school accepts. You will use it to settle batches,
look up transactions or batches when resolving issues, process credits, and
view reports.

There are some differences in how Payment Gateway works with three
credit card processors: Concord EFSnet, MIGS, and Moneris e-Select Plus. If
you use one of these processors, you should familiarize yourself with the
differences.

Concord EFSnet, MIGS, and Payment Gateway

Concord EFSnet and MIGS are a host-based credit card processors. This
means transactions are authorized and settled without using the batch files
familiar to users of terminal-based processors. Therefore, some Operations
Center tasks and features do not apply to Concord EFSnet and MIGS the
same way as to other processors.

What Concord EFSnet and MIGS Users Should Do

Use the Batch Details report to see accurate data about settled transactions.

Moneris e-Select Plus and Payment Gateway

Moneris e-Select Plus is a host-based credit card processor. This means
transactions are authorized and settled a little differently than the terminal-
based processors. Payment Gateway sends a batch close request to Moneris
and compares the totals in the response from Moneris with the batch file. If
the transactions match up the file is ready to send, however if the
transactions do not match, an error is logged and needs to be corrected.
Therefore, some Operations Center tasks and features do not apply to
Moneris e-Select Plus the same way as to other processors.

What Moneris e-Select Plus Users Should Do

• Use the Payment Gateway Operations Center, not the Moneris e-
Select Plus interface, to process credits and voids or manually enter
transactions.

Important! Payment Gateway will not recognize transactions completed
through a separate interface.
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• Use the Payment Gateway batch scheduling feature instead of the
Moneris e-Select Plus interface feature. Disable batch scheduling
through Moneris e-Select Plus.

• A full credit is processed as a VOID, if the batch has not already been
closed; otherwise it is processed as a CREDIT.

• When a batch close attempt fails to be sent to Moneris, the batch file
will not be changed/renamed so that requests to add or close the
batch can be added at a future date.

• If a batch failure occurs, contact TouchNet Customer Care for
assistance.

6.1 Settling the Pending Batch Manually
Successfully authorized credit card payments are typically batched and
settled together.

You can schedule a time for Payment Gateway to automatically submit the
current batch for settlement each day or you can settle the current batch
manually at any time.

Note: Concord EFSnet and MIGS users, you are not technically scheduling
batch settlement. You are scheduling the time to generate the batch details
for the previous day's activity. All Concord EFSnet and MIGS users should
set a time.

Follow these steps to manually settle a pending batch. This process requires
bursar rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [credit card merchant] > Settle Batch.
The Pending Credit Card Payment page displays.

Pending Credit Card Payments page

2 Review the list of pending, authorized transactions.
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3 To remove one or more transactions from the batch, mark the
appropriate checkboxes, then click the Remove button. Confirm your
choice.

4 When you are ready to settle, click the Settle the batch button and
confirm your choice. The Settlement Results page reports settlement
success or any exception that caused a failed settlement.

The Pending Transactions report shows the same information as the Settle
Batch page. On the Settle Batch page, however, bursars can remove
transactions or settle the batch. Voided transaction amount (which are
removed from the pending batch) appear in red as 0.00.

Step-by-step information about automating credit card batch settlements is
available in Payment Gateway Operations Center online help.

Removing
Transactions

from the
Pending Batch

Payment Gateway allows you to remove a credit card transaction from a
pending batch. Alternately, you may choose to credit the transaction in the
pending batch, which allows you to make further changes to the charge up
until the time of settlement. For instructions, see "Credit Card Credits" on
page 122.

Note: Concord EFSnet and MIGS users should not remove transactions as
described here. Removing a transaction would have the same effect as
issuing a credit.

After removal, you will still see the voided transaction in the pending batch
with an amount of 0.00. The pending batch shows the voids so that you can
see all batch activity.

To remove one or more transactions from a pending batch, follow these
steps. This process requires bursar rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [credit card merchant] > Settle Batch.
The Pending Credit Card Payments page displays.

2 Mark the checkboxes of the transactions you want to remove.

3 Click the Remove button.

4 Click Ok to confirm removing the transaction.

After you remove the transaction, you can either settle the batch or exit the
page without settling.

Note: Most credit card processors will not unencumber the payer's credit
card when processing a void. The amount will be restored to the card after a
time period specified by the card issuer.
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You can see removed transactions in these reports:

• Pending Transactions report and the Settle Batch page—Removed
transactions appear with 0.00 amounts, displayed in red.

• Activity report—The original transaction displays in the Activity
report with the designation PUR, or purchase. Another record displays
showing the same transaction as a VOID. The two records include the
same reference number, so you can see that both the purchase and the
void belong to the same payment transaction.

6.2 Resubmitting a Failed Credit Card Batch
The Payment Gateway Operations Center is used to track and manage the
credit card payments your school accepts. From the Operations Center you
can settle credit card batches, resubmit failed batches, process credits, and
view reports.

When a credit card payment batch fails, for any reason, designated users are
notified via a failed batch email message generated from Payment
Gateway. A failed batch notification is also displayed on the U.Commerce
Central Dashboard. Once the user with the resubmit failed batch merchant
role receives the email notification, they can use the file name displayed in
the email to locate the failed batch from the Credit Card Batch Settlement
report, review the failed batch details and resubmit it.

Important! Use caution when resubmitting a failed batch. Resubmitting a
failed batch may double-charge your customers. Before a failed batch is
resubmitted it should be thoroughly researched and verified with your
bank to ensure that the batch actually failed and it was not settled
successfully by your processor. Remember, resubmitting a failed batch
without ensuring that it has not been settled could double-charge your
customers.

Refer to the "Configuring Failed Batch Email Settings" section in the
Payment Gateway 6 Technical User's Guide for information on setting up
the email notification.

For instructions on editing a user profile to add the resubmit failed batch
role, see "Changing Users' Roles" on page 248.
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Credit Card
and Debit Card

Processors

There are some differences in how Payment Gateway works with the credit
card processors. For some processors resubmitting a batch is not allowed. Be
sure that your processor allows resubmitting a batch before you attempt it.

Note: The resubmit failed batch fields may not display in your Payment
Gateway Operations Center if your processor does not allow for
resubmitting a batch.

Determining whether a processor allows resubmitting a batch depends on a
combination of the batch type (debit or credit) and the processor type. The
following table identifies the available credit card and debit card processors
and whether they allow you to resubmit a failed batch based on batch type.

Processor Credit Card Batch Debit Card Batch

Concord EFS Net false false

FDC Nashville true false*

FDC North true true

FDC South true false

Elavon (Nova) true false

GPS East true true

MIGS false false*

Moneris false false

Paymentech true false

TSYS (Vital) true true

*Not applicable since debit is not allow for this processor

Note: Concord EFSnet, Moneris, and MIGS are host-based credit card
processors. This means transactions are authorized and settled without using
the batch files familiar to users of terminal-based processors. Therefore, the
resubmit failed credit card batches feature does not apply to Concord
EFSnet, Moneris, and MIGS.
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Viewing Failed
Credit Card

Batches

When a credit card batch fails, an email notification is sent to designated
users and a notification is also displayed on the U.Commerce Central
Dashboard. The email contains the name of the settle file that failed. Use
the settle filename to view the file details on the Credit Card Batch
Settlement report. The TPG RC (Response Code) column displays the
success-or-fail response code from Payment Gateway. Failed codes are
typically -1700, -1800, or -1900 series exception codes.

To view the Credit Card Batch Settlement report, follow these steps.

1 From the Payment Gateway home page, navigate to Reports. The
Report Selection page displays.

The Report Selection page

2 Select the Credit Card payment type.

3 Select the Batch Settlement report type.

4 Select the desired begin and end date and time to filter your report.
For complete instructions on selecting the date and time filters, see
"Running Reports" on page 184. 

Note: You can also narrow the results of your report by selecting
options from the following search fields:

• Merchant Accounts - to select an individual merchant.

• Optional Search Fields - to select individual applications.

• Credit Card and Debit Card - to select individual credit cards.
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5 Click the View Report button. The Credit Card Batch Settlement
report displays.

The Credit Card Batch Settlement report
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Resubmitting
the Failed

Batch

To resubmit a failed batch, follow these steps.

Important! Use caution when resubmitting a failed batch. Resubmitting a
failed batch may double-charge your customers. Before a failed batch is
resubmitted it should be thoroughly researched and verified with your
bank to ensure that the batch actually failed and it was not settled
successfully by your processor. Remember, resubmitting a failed batch
without ensuring that it has not been settled could double-charge your
customers.

1 On the Credit Card Batch Settlement report page, using the Batch
# field, locate the failed batch that you wish to resubmit.

Note: The file name is displayed in the failed batch email notification and
looks something like this: Settle.RB12345-6789-123-456789.

The Credit Card Batch Settlement report
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2 Click the Batch # link. The Credit Card Pending Transaction report
displays.

The Credit Card Pending Transactions report

3 The batch details display on the page. Before resubmitting the failed
batch, be sure that you have thoroughly researched the batch and you
have contacted your processor to confirm that the batch was not
settled successfully.

Note: In the example shown, the batch only includes one transaction.

Note: If a "no rows returned" message displays on this page, click the
Back to Batch Settlement Report button and search for the batch by
modifying the begin and end date to redisplay the failed batch file.

4 Click the Resubmit batch button.

5 A window displays prompting you to verify you have contacted your
processor. Click OK to continue. The batch is resubmitted
immediately.

6 Once the failed batch has been resubmitted, you can review the
Credit Card Batch Settlement report to verify the batch was
successfully submitted. A notice at the top of the report page
indicates that the batch settlement was successful.
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Note: If the batch is not successful after resubmitting it, users will be
notified again via email and the Dashboard. Contact TouchNet Customer
Care for assistance.

Viewing the
Resubmit

Failed Batch
File Activities

You can use the User Audit Log to view user activity in the Operations
Center. To view the resubmit failed batch activities, you can filter the User
Audit Log by the Resubmit Failed Batches File action. You can also filter
the resubmit batch activities by an individual user.

To view resubmit failed batch activities, follow these steps.

1 From the Payment Gateway home page, navigate to Users > User
Audit Log. The User Audit Log displays.

The User Audit Log

2 Enter the desired beginning and ending date and time in the date
range fields. The current date defaults in both the begin and end
fields.

3 In the Select User field, select the desired user from the dropdown
list. The default is all users.

4 In the Select Action field, select the Resubmit Failed Batch File from
the dropdown list.
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The Select Action dropdown menu

5 Click the View Log button. The user audit log results appear.

The User Audit Log results
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6.3 Credit Card Credits
You can process a credit before or after the initial credit card payment
transaction is settled. When you enter a credit, you can modify the adjusted
amount up until the time the payment is settled.

Payment Gateway limits the amount you can credit so it is never greater
than the original purchase amount. Once you have settled a credit, Payment
Gateway limits further credits to the amount currently settled. (For
example, if a $10 credit is issued on a $100 transaction, future credits are
limited to a total of $90.)

Note: Remember, purchases are funds that flow into your accounts; credits
are funds that flow back into the cardholder’s account.

Notes on Credits

Credits, partial reversals, and voids

Refunded amounts are submitted to your credit card processor as credits,
partial reversals, or voids, depending on the amount of the credit and
whether it has been settled. When you process a credit, Payment Gateway
automatically processes the correct type of refund for the payment and for
your credit card processor.

Important! TouchNet Payment Gateway Operations Center cannot be
used to credit transactions taken or processed through non-TouchNet
applications.

Credits disallowed before settling

Some credit card processors will not allow you to change the authorized
amount before settling. In those cases, you must settle first, then process a
credit against the settled amount.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



Processing a
Credit

Credit card credits are processed using the Manage Credit Payments screen.

To process a credit, follow these steps. This requires either bursar rights or
process credit rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [credit card merchant] > Manage
Credit Payments. The Credit Card Payment Search page displays.

2 Click the calendar icon to select the desired begin and end date
range. You can also select one of the following date options: 

• Today - click the today button to search for credit card payments
for the current day.

• Last 24 hours - click the Last 24 hours button to search for credit
card payments for the last running 24 hours.

• Year to date - click the Year to date button to search for credit card
payments for the last twelve months.

3 Enter any applicable card information to narrow your search.

4 Click the Search button. The Search Results page displays.

5 Locate the payment and click its Reference #. The Process Credit Card
Credit page displays.
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Process Credit Card Credit page

6 Credits may already have been processed for the transaction. Review
the Activity and Settlement History sections at the bottom of the page
before proceeding.

7 Edit the ancillary data if you want to record information about the
credit. Ancillary data displays in Payment Gateway reports. The
original ancillary data will still be shown with the purchase record.

8 Adjust the amount to charge by entering an amount in either the
Adjusted Amount field or the Credit Amount field.
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• In the Adjusted Amount field, enter the new amount to charge.

Example: If the original charge was $15.50 and the charge has
settled, an Adjusted Amount entry of 10.00 results in a $5.50
credit. If the original charge has not settled, the net result is a
$10.00 charge with no credit.

An entry of 0.00 is processed as a void if before settlement of the
original amount and as a full credit if after settlement.

For an additional example, see "Example – Credits Using the
Adjusted Amount" on page 128.

• In the Credit Amount field, enter the amount to credit the card.

Example: If the original charge was $100.00 and the charge has
settled, a Credit Amount entry of 20.00 results in a $20.00 credit.
If the original charge has not settled, the net result would be an
$80.00 charge with no credit.

An entry of 100.00 is processed as a void if before settlement of
the original amount and as a full credit if after settlement.

For an additional example, see "Example - Credits Using the
Credit Amount" on page 129.

9 Click the Preview Credit button to see how much money will be
charged to the card and how much will be returned to the cardholder
after the credit.

10 When everything has been entered correctly, click the Process Credit
button.

11 Click OK to confirm the credit.
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Process Credit Fields

Credit card credit fields and examples

Transaction date/time

Date and time that the transaction was authorized.

Payment type

The type of payment.

Card type

The type of credit card used for the purchase.

Credit card number

Credit Information about the credit card used for the purchase, displaying
only the last four digits of the card number for security reasons.

Authorization reference number

Unique transaction number assigned by Payment Gateway. (For some
processors, this number is unique only within a merchant's transactions; two
merchants may have a transaction with the same reference number).
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Ancillary data

Information about the payer or the transaction, i.e., a payer’s ID number.
This data is typically passed from your payment application to Payment
Gateway. If your credit card processor places limits on AVS data, the
ancillary data will include up to the number of characters allowed.

Current status

Show the current status of the transaction, either AUTHORIZED, PENDING,
SETTLED, CREDITED, or VOIDED.

Settled balance

Last settled balance for the transaction. It will be $0.00 if the transaction has
not yet been settled, a void has been settled for it, or it has been credited
for the full amount and settled. If a void has been settled, it displays in the
Activity.

Pending activity

Transaction amount waiting to be settled. Pending Activity of $0.00 occurs
when the transaction has no pending activity, a void has been entered, or it
has been credited for the full amount and settled. If a void is entered but
not yet settled, it shows the last pending settle amount.

Adjusted balance

Amount currently charged to the card, including any credits, partial
reversals, or voids that have not yet been settled.

Adjusted amount (in dollars)

Enter the adjustment amount in dollars and cents.

Credit amount (in dollars)

Enter the credit amount in dollars and cents.
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Example –
Credits Using
the Adjusted

Amount

Here, a purchase of $100.00 has been made. The user has entered $90.00 in
the Adjusted Amount field. The Preview Credit button has been clicked,
and we see that the card will be credited $10.00.

How to get to this page:

Payment Tasks > Merchant Administration > [credit card merchant] >
Manage Credit Payments

Entering an adjusted amount for a credit card transaction - example
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Example -
Credits Using
the Credit
Amount

Here, a purchase of $100.00 has been made. The user has entered $20.00 in
the Credit Amount field. The Preview Credit button has been clicked, and
we see that the card will be credited $20.00.

Entering a credit amount for a credit card transaction - example

Viewing
Previous Credit

Activity

You can view credit card transaction history using the Manage Credit
Payments screen.

To view the previous credit card activity on the Manage Credit Payments
screen, follow these steps.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [credit card merchant] > Manage
Credit Payments. The Credit Card Payment Search page displays.

2 Select the date range and another criteria that will help narrow the
search.

3 Click the Search button. The Search Results page displays.

4 Locate the payment and click its Reference #. The Process Credit Card
Credit page displays.

5 Review the Activity and Settlement History sections at the bottom of
the page. They show a record of attempted, successful, and settled
transaction activity.
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Example of credit card transaction activity and history

Voiding a
Payment
Before

Settlement

To void a payment, process a zero-dollar amount for the payment. To do so,
enter 0 in the Adjusted Amount field when you process the credit (or enter
the full amount in the Credit Amount field). In your reports, it will look the
same as if you removed a transaction from the pending batch. The payment
is voided and nothing appears on the cardholder’s account.

Note: If a payment has been voided but not settled, its Pending Activity
and Adjusted Balance will both be $0.00.
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Viewing
Credits in
Reports

To see credits before settlement, use these reports:

• Activity Report

One record shows the originally charged amount. For reversals (a
credit processed before the transaction was settled), another record
shows the new amount charged with a transaction type of REV, or
partial reversal. The same reference number and approval code appear
in both records. For voids (when the credit is for the full amount), the
type is VOID.

• Pending Transactions Report

Shows only the currently charged amount.

To see credits after settlement, use these reports:

• Activity Report

One record shows the originally charged amount. Another shows the
new amount with a transaction type of CR, or credit. The same
reference number and approval code appear in both records.

• Batch Settlement Report

The batch total is reduced by the amount returned to the cardholder’s
account.

• Batch Details Report

For credits, the payment record shows a transaction type of CR, or
credit. The amount returned to the cardholder’s account is shown as a
negative dollar amount.

For reversals, the payment record shows a transaction type of PUR, or
settled purchase, with the amount charged at the time of settlement.
The amount shown is not the amount removed from the purchase; it is
the new amount charged to the card.

For voids, the payment record shows type VOID.

6.4 Single Credit Card Authorizations

Important! Single authorization amounts are not transmitted to your host
system records. If you charge a single authorization amount to a
cardholder’s account, you must update that payer’s account in your host
system.

For single credit card authorizations, a Single Authorization Usage
Agreement screen displays prior to entering each single credit card
authorization. You must accept the terms and conditions of the agreement
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before you can proceed with a single authorization. This agreement was
added for PCI PA-DSS compliance requirements.

When you process a single authorization, you enter all the credit card
information that a cardholder would have entered through your online
payment application. If you use single authorizations to test payment
transactions, you must use a valid card number. You may use a test credit
card number provided by your bank.

Note: For test transactions, TouchNet suggests that you always include
“test” or a similar indicator in the ancillary data. This will help you locate
test transactions in your reports.

Important! Don’t batch transactions using test credit cards with real credit
card transactions. Close the test batch before running the real transactions.

Single authorization example

Step-by-step information about single credit card authorizations is available
in Payment Gateway online help, including:

• How to process and settle single credit card authorizations.

• How to add an authorized transaction to a batch.

• How to check the settlement status of an authorization.
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7.0 Processing ACH Transactions
TouchNet Payment Gateway includes features and functions used to process
ACH payments. If your license includes ACH processing, then you can
accept online payments from personal checking or savings accounts and use
Payment Gateway to process the ACH transactions.

Only U.Commerce Central applications can send ACH payments to
Payment Gateway. When the ACH payment transactions are sent to
Payment Gateway from the U.Commerce Central applications, Payment
Gateway prepares the batch file that is sent to the bank. Once sent to the
bank, your payment transactions are processed and settled directly into your
bank account. TouchNet does not handle the ACH funds nor add time to the
settlement process. Your bank also notifies you directly.

7.1 ACH Transaction Overview
A user who submits an ACH payment through a TouchNet U.Commerce
Central solution (such as Marketplace, Bill+Payment, or Cashiering) enters
required information: the name and address from the checking or savings
account, the payment amount, and the bank account’s routing and account
numbers.

After Payment Gateway validates the routing number, the user must
explicitly authorize the transaction by accepting the ACH payment
agreement. The user’s payment information, the agreement text, and the
time and date of the agreement are encrypted and saved in the Payment
Gateway databases.

The Payment Gateway user with bursar rights generates ACH files from the
submitted payment information and sends this information to a bank.

The following diagram shows the typical work flow for processing ACH
transactions.
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The ACH Transaction Process in Payment Gateway
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7.2 Generating and Reviewing ACH Files
To process ACH payments you generate ACH files and send them to your
bank using the method your bank recommends. These ACH files are written
in the standard format used by banks and described by the current NACHA
Operating Rules and Guidelines.

The Operations Center also allows you to mark ACH files as settled,
regenerate ACH files, and reinitiate eligible payment transactions rejected
for reasons such as insufficient funds.

Payment Gateway is automatically configured not to create ACH files on
Saturdays and Sundays. Weekend transactions are automatically batched
into the Monday ACH file. Your Payment Gateway may be configured not
to create ACH files on Federal Reserve holidays as well. If it does not skip
holidays and you would prefer that it did, contact TouchNet for assistance.

Use the Manage ACH File feature to look up an ACH file for further
processing, including regenerating the file or marking the file as settled.

You can also look up a file using the ACH File report, but you will not be
able to perform further processing on the file.

Looking Up
ACH Files

To look up an ACH file, follow these steps. This requires process return file
rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH File.
The ACH File Search page displays.

2 Choose the date range (required). The default search is month-to-date.

3 Enter the ACH File ID (optional) in the Field Id field.

4 Click the Search button. A list of ACH files for the selected date
range displays on the ACH File Search Results page.

You can also look up ACH files using the ACH File report, see "ACH
Reports" on page 221.

Looking Up
ACH

Transactions

To view ACH payment transaction details, follow these steps. This requires
process return file rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH
Payments. The ACH Payment Search page displays.

2 Enter the date range and any additional information that will help
Payment Gateway search for the transaction.

or
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If you know the transaction ID for the ACH payment, enter the
transaction ID number in the Reference number\Transaction id field.

3 Click the Search button. The ACH Payment Search Results page
displays.

Note: If there are multiple files that meet the criteria, the ACH File
listing displays. You must click on the Transaction ID link to view the
individual ACH transaction entries.

The ACH Payment Search Results page

4 Click the Trans ID link for the transaction you want to view. The ACH
Payment Details page displays.

Note: If only one transaction is found, you are taken directly to its
details page.
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ACH Payment Details page

Payment Details

The following information displays on the ACH Payment Details page.

Transaction ID

Numeric transaction identifier assigned by Payment Gateway.

Date

The date and time the original purchase was made.

App

Name of the TouchNet application where the payment originated.

TPG Merchant

Name of the merchant for the transaction.

TPG Merchant SubTransCode

Unique identifier code assigned to the Payment Gateway merchant.
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Amount

Amount of the payment.

Name

Payer's name as entered with the payment.

Account Type

Checking or Savings.

Origin (Standard Entry Code)

SEC code for the method of payment presentment.

Memo

Student ID number (if available) and any information entered with the
payment.

Payer ID

The user ID of the person initiating the payment transaction.

Institution Unit

Institution level code linking to a Host System Account.

Status

Status of the transaction (UNSETT, WAIT, RETURN, SETTLED, NOC,
VOIDED, REMOVED).

Return or NOC Reason

The reason the transaction was returned or the NOC reason.

Reinitiations

Number of attempts to reinitiate the payment. Maximum of two attempts
allowed.

Agreement

Click the View agreement link to view the ACH payment agreement
completed by the user authorizing the transaction.

Account restricted

Yes, indicates the bank account for this payment is on the Payment
Gateway restricted accounts listing.

Parent Transaction

Indicates this ACH payment transaction is related to a parent transaction.
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Return and Restrict

Mark transaction with NOC or return code

The return reason code. If the code begins with an R, the transaction was
rejected (possibly because of insufficient funds). If the code begins with a
C, the transaction was returned as a notification of change to the account.
Follow your bank's guidelines for handling NOCs.

Add to restricted account list
Click the Yes button to add this bank account to the Payment Gateway
restricted accounts listing. The restriction is specific to the payment's
account type (checking or savings). Click the Apply button to add the
account to the Payment Gateway restricted accounts listing. For more
information on how to handle restricted accounts, see "Restricting an
Account Manually " on page 160 and "Restricting Accounts Automatically "
on page 161

History

Date

The date and time the action was taken.

Type

Type of ACH payment processed, as provided by NACHA rules. The most
common type is PUR (purchase).

Amount

Amount of the payment.

Reinintiated Count

Number of times the transaction has been reinitiated on accounts that were
previously rejected with reasons that allow reinitiation.There is a maximum
of two reinitiation attempts.

Action

Description of an action that has been taken on the transaction.

Trx Status

Status of the transaction (UNSETT, WAIT, RETURN, SETTLED, NOC,
VOIDED, REMOVED)

Reject Msg

Return number and description.
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Generating the
Current
ACH File

To submit ACH payments to your bank, you must first generate the ACH
file. You can generate an ACH file manually, as described here, or you can
schedule ACH files to be generated automatically at a specific time each
day.

Generating an ACH file manually requires bursar rights.

To create the ACH file, follow these steps.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Generate ACH
file. The Pending ACH Payments page displays. A listing of all the
pending ACH payments displays.

The Pending ACH Payments page

2 If you want to remove a transaction from the generated file, mark the
checkbox in the Remove column to the left of the desired transaction.

Note: For information on removing ACH transactions from the batch,
see "Removing a Transaction from a Generated ACH File" on page
144.

3 You can also create a manually generated ACH file and include
transactions from a specific timeframe by selecting a specific cutoff
time. To select a cutoff time, mark the Use File Cutoff Time?
checkbox.
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The File Cutoff fields

4 Enter the desired cutoff time in the File Cutoff Time field. Enter the
time in military time 00.00.00 (two digit hour, two digit minutes, two
digit seconds). This is the timeframe for when transactions in the
ACH file should be cutoff.

5 To include ACH transactions in a number of days before the cutoff,
enter the number of days to before the cutoff in the File Cutoff Offset
field. Zero days (0) is the default, enter 1 for yesterday, 2 for two days
prior, etc.

6 Click the Generate ACH file button.

7 Click OK to verify you wish to generate the ACH file.

Note: Each time you generate the ACH file, it contains all transactions that
have not been captured previously in an ACH file. It also contains the
configuration information needed by the bank to process the file.

ACH file successfully generated

Each ACH file name includes the unique, seven-digit, sequential number
that identifies the file.

For step-by-step information about how to automatically generate ACH files
see Automatically Generating ACH Files below. These steps are also
available in Payment Gateway online help.

Note: Payment Gateway does not impose upper or lower limits on the
number of transactions within an ACH file.

Important! For security reasons, TouchNet recommends that you delete
the ACH file from your location after sending it to the bank. You should
use a secure wipe tool type cleaning program such as TouchNet's Seek-N-
Secure™ to delete ACH file.
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You can regenerate any ACH file. For details, see "Post-Settlement
Processing of ACH Files" on page 145.

Automatically
Generating
ACH Files

You can configure Payment Gateway to automatically generate ACH files at
a scheduled time each day. Before you do this, you should know:

• Payment Gateway can automatically generate your ACH file but it
cannot send the file to your bank. You must send the file in the way
that your bank expects it, which varies by institution.

• Even if you have an automatic ACH batch time scheduled, a user with
bursar rights can still generate an ACH file at any time.

Follow these steps to set an automatic, daily ACH file generation time. You
must have administrator rights to do this.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > ACH > Merchant. The ACH - Merchant
Configuration page displays.

2 Choose the correct ACH merchant from the Current Merchant
dropdown list.

3 Scroll down to find the Batch Time field. Enter the time you want
Payment Gateway to generate the daily ACH file.

Use military format (for example, 11:00 p.m. is entered as 23:00).
Also, DataCenter customers must be aware that the time you enter
here is Central Time because the TouchNet DataCenter is located in
the Central time zone.

To turn off automatic ACH file generation, enter OFF.

Time to Run Batch Batch Time Format

2:30 a.m. 02:30

1:00 p.m. 13:00

12:15 a.m. 00:15

No automatic batch scheduled OFF

Batch Schedule Time Examples

4 Click the Save Changes button.

5 Stop and restart Payment Gateway. If your TouchNet solutions are
hosted on campus, see "Starting and Stopping Payment Gateway" on
page 89. If your TouchNet solutions are hosted in the TouchNet
DataCenter, contact Customer Care for assistance.
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Voiding an
ACH Payment

You can remove a pending ACH transaction, even if it is already included
in a generated ACH file as long as the ACH file has not been sent to the
bank.

Removing a transaction voids the ACH payment in reports and in the ACH
file.

Removing a Pending ACH Transaction

To remove an ACH payment from pending transactions, follow these
steps.This process requires bursar rights.

1 From the Payment Gateway home page, navigate to the Payment
Tasks > Merchant Administration > [ACH merchant] > Generate
ACH File. The Pending ACH Payment page displays.

The Pending ACH Payments page

2 In the Pending ACH Payments list, locate the transaction to be
removed.

3 Mark the Remove checkbox.

4 Click the Remove button.

5 A confirmation window displays. Click OK to confirm removal of the
pending transaction.

Important! Removing a transaction from the ACH file removes it from
the next ACH file regeneration, but it does not remove the transaction
from the ERP.

Note: The transaction information still displays but the status is
changed to VOIDED and the totals reflect the removal.
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Removing a Transaction from a Generated ACH File

You can remove an ACH transaction from an ACH file as long as the file
has not yet been sent to the bank.

Important! If you remove a transaction from a generated file, always
regenerate the file.

To remove an ACH payment from a generated file, follow these steps. This
process requires bursar rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH File.
The ACH File Search page displays.

The ACH File Search page

2 Click the Begin and End Date calendar icon and select the desired
date range.

Note: If you know the ACH File ID, you can enter it and search for
that file only.

3 Click the Search button. The ACH File Search Results page displays.

4 Click the ACH File ID link for the file that contains transactions to be
removed. The ACH File Details page displays.
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The ACH File Details page

5 Locate the transaction to be removed and mark the Remove
checkbox.

6 Click the Remove button and click OK to confirm your choice.

Note: If the Remove checkbox is not displayed, the transaction's
status does not allow for removal.

7 Click the Regenerate File button and click OK to confirm your
choice.

The amount of the removed transaction displays in red after the file is
regenerated.

7.3 Post-Settlement Processing of ACH Files
Banks use a variety of methods to confirm and notify you about successful
and rejected ACH transactions. Typically, your institution will use the same
method of confirmation currently used in paper check processing.

When you receive the ACH file from your bank, save the ACH file using
your current processes. The saved location and the file name are used to
upload the ACH return file in Payment Gateway.
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When you need to perform further processing for your ACH files, you can:

• Regenerate your ACH file if it was initially rejected due to incorrect
header information. See "Regenerating an ACH File" on page 156, for
more information.

• Mark ACH files as “settled.” For more information, see "After your
bank has processed the ACH transactions and you have removed
rejected transactions from your ACH file, you must mark the ACH file
as settled." on page 146.

After your bank has processed the ACH transactions and you have removed
rejected transactions from your ACH file, you must mark the ACH file as
settled.

Important! Make sure you complete all processing of the ACH file and
the transactions contained in it before marking the file as settled. Once an
ACH file is settled, neither it nor the files in it can be altered in any way.

To remove a rejected transaction from an ACH file, see "Removing a
Transaction from a Generated ACH File" on page 144.

Marking an
ACH File as

Settled

To mark an ACH file as settled, follow these steps. This process requires
bursar rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH File.
The ACH File Search page displays.

2 Choose the date range (required). The default search is month-to-date.
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3 Enter the ACH File ID, if known (optional).

4 Click the Search button. A list of ACH files for the selected date
range displays.

5 Select the Mark as Settled checkbox for the desired file.

Marking an ACH file as settled

6 Click the Mark as Settled button.

7 Click OK to confirm your settlement selection. The transaction is
marked as Settled.

Important! Once an ACH file has been marked as settled, you cannot
reverse its status to pending, you cannot perform further actions on
transactions on the file, and you cannot regenerate the file.

7.4 Processing a Returned ACH Payment
If the bank returns an ACH-standard file detailing returned transactions, you
can upload the ACH return file and review the returned transactions. If the
transaction was rejected for a reason that allows reinitiation, such as
insufficient funds, you can reinitiate the transaction. When you build and
send the next ACH file, reinitiated transactions will be submitted with that
file. To process an ACH return file, you must have the process return file
role.

Current NACHA guidelines allow a total of three submissions for a
payment transaction. The ACH Payment Details page and the ACH
Rejections report shows the number of times a payment has been
submitted. For details about the ACH Rejections report, see "ACH Reports"
on page 221.
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Note: The ACH transaction ID is required for this process. Your bank’s
ACH-standard information will include the transaction ID, which may be
labeled as the “individual identification number.”

If your bank rejects an ACH file, the file probably contains incorrect header
information. If your ACH file is rejected for this reason, correct the
information in your ACH merchant configuration before you regenerate the
ACH file. See "Editing and Maintaining Existing Merchants" on page 71 for
information about editing existing merchant configurations. DataCenter
customers should contact TouchNet customer care for assistance.

Note: If your bank indicates that an invalid payment transaction within the
ACH file has caused the entire file to fail, please contact TouchNet
Customer Care for assistance in resolving the problem.

Returned ACH
Transactions

The bank may return one of two types of codes for a transaction.

• If the code begins with a C (Notification of Change), the ACH
payment has been processed successfully. It is not rejected, but was
submitted with incorrect data. The transaction has been settled.

• If this code begins with an R (Return), you can reinitiate the ACH
payment if it is eligible after you have marked it as returned in the
Operations Center.

Note: Follow your bank's guidelines when making changes to account
information related to NOC.

It is important to record the return codes for returned ACH transactions in
Payment Gateway to ensure the accuracy of reports. When recorded
properly, returned transactions are removed from the ACH file information
and are not shown in the ACH File or ACH File Details reports.
Transactions marked with a C code are not rejections and therefore do not
appear in the ACH Rejections report.

Understanding NOC Codes

Some payment transactions may receive a status code of NOC from the
bank. NOC stands for Notification of Change. A NOC does not represent a
failed financial transaction. It is a notification that a correction was made to
some data associated with the transaction during settlement.

When a payment receives a NOC status code, you should examine the
reason for the code. For example, you may receive a NOC code as a result
of a mistyped account number. Follow your bank's guidelines when making
changes to account information related to NOC.
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7.5 Uploading the ACH Return File
When the return file is sent to your school from the bank, save the return
file using your school's procedures. Refer to your bank's guidelines for
handling NOC files. TouchNet can only accept files with the format
specified by NACHA.

You must have the Process Return File role to upload and process an
ACH NACHA return file.

To upload the ACH return file, follow these steps.

1 Access Payment Gateway and from the Payment Gateway home page,
navigate to Payment Tasks > Upload ACH Return file. The Upload
ACH Return File page displays.

2 Click the Browse button to locate and select the desired return file.
The return file name is displayed in the ACH returns file to upload
field.

The Upload ACH Return File page

3 Click the Upload button. The file details display in the Import ACH
File section.
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4 If the file is uploaded without any errors, you are ready to submit the
return file and process the payments. Click the Submit File button.

The TouchNet processed payments are marked "returned".

Returned file details display in the Import ACH File section

If there are errors in the file, an error message displays in the Import
Messages field. The ACH return file is not uploaded. Click the Clear
button. Download the return file from the bank again and upload the
ACH file again.

An error message displays if errors appear in the uploaded ACH file

5 If there are no errors in the uploaded file, the ACH Return File
Results page displays listing the returned payment transactions.
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The ACH Return File Results page

The Affected Payments section lists the returned payment transactions
and the status of the transaction after the ACH file was submitted. The
following information displays: 

Transaction ID

The transaction number. Click the Details link to view the details
about the individual payment transaction.

TouchNet Status

The status of the submitted payment.

Returned Reason Code

The reason the payment was returned.

6 Click the Transaction ID details link to view the details about the
payment. The ACH Payment Details page displays.

The following fields are automatically populated for each returned
ACH payment transaction:

• Status

• Return or NOC reason

• Mark transaction with NOC or return code

• History section

Note: The Host System Account is not automatically updated during the
ACH Return File upload process.
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Manually
Recording a
Return Code
for an ACH
Payment

To record a return code for a returned ACH payment, follow these steps.
This process requires bursar rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH
Payments. The ACH Payment Search page displays.

2 Enter the date range and any additional information to help search for
the transaction.

3 Click the Search button.

4 If multiple transactions are returned, click the Trans ID for the
transaction you want to view. The ACH Payment Search Results page
displays.

If only one transaction is found you are taken directly to the ACH
Payment Details page.

5 Enter the Return or NOC reason code in the Mark transaction with
NOC or return code field.

6 If you want to restrict this ACH account so that no future transactions
are accepted from it, click Yes in the Add to restricted account list
field.

7 Click the Apply button.

8 Click OK to confirm you wish to add this account to the restricted list.

If you entered a return code, this transaction now has a status of
RETURN in Payment Gateway. The return displays in the transaction
history at the bottom of the page. You may now reinitiate the
payment transaction. For instructions, see "Manually Reinitiating a
Returned ACH Payment" on page 154.

If you entered a NOC code, the transaction now has a status of
SETTLED in Payment Gateway and requires no further action.

7.6 Automatically Reinitiating ACH Files
Payment Gateway provides the ability to automatically reinitiate ACH
return files, automatically charge a reinitiation fee, and set the default
reinitiation fee amount. To automatically reinitiate the ACH return files you
will need to make changes to these settings in the ACH configuration file.
The automatic reinitiation applies to all returned transactions with the R01
(insufficient funds) return code. These settings are merchant specific.

The following reinitiation settings need to be modified for the automatic
reinitiation: 
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AutoApplyReinitFee – when this field is set to true, the fee defined in the
DefaultReinitFeeAmount field, is automatically applied to the ACH
returned transactions with the R01 return code. The default setting is false.

DefaultReinitFeeAmount – enter the dollar amount in this field, that you
wish to automatically apply to the ACH returned transactions with the R01
return code. The default fee amount is $25.00.

AutoReinitiate – when this field is set to true, the ACH returned transaction
with the R01 return code are automatically reinitiated and sent when the
next ACH file is generated and sent to the bank.

Entering the
Automatic
Reinitiation

Settings

To access the ach.xml file and set the reinitiation settings to automatically
reinitiate returned ACH files, follow these steps.

1 Stop Payment Gateway. If your TouchNet solutions are hosted on
campus, see See "Automatically Reinitiating ACH Files" on page 152.
If your TouchNet solutions are hosted in the TouchNet DataCenter,
contact Customer Care for assistance.

2 In a text editor, open this file:

• For Windows users: \touchnet\tpg\payment\ach.xml

• For Solaris users: touchnet/tpg/payment/ach.xml

3 In the ach.xml file, locate the line that begins with
<AutoApplyReinitFee. (If you have more than one ACH merchant,
locate the first <AutoApplyReinitFee line in the file.

4 If you wish to automatically apply a reinitiation fee to all returned
ACH transaction with the R01 (insufficient funds) return code, replace
>FALSE< with>TRUE<. The line will look like this:

<AutoApplyReinitFee>TRUE</AutoApplyReinitFee>

5 To enter the dollar amount for the reinitiation fee, locate the line that
begins with<DefaultReinitFeeAmount. Enter the desired reinitiation
fee (in pennies, no punctuation). If you do not want to charge a fee,
enter 0.

For example, if you want to apply a $5.00 fee, you would enter 500.
The line will look like this: 

<DefaultReinitFeeAmount>500</DefaultReinitFeeAmount>

Note: This will apply the fee to all returned ACH transactions with
the R01 return code.

6 If you wish to automatically reinitiate all returned transactions with
the R01 return code, locate the line that begins with
<AutoReinitiate. replace >FALSE< with>TRUE<. The line will
look like this: 

<AutoReinitiate>TRUE</AutoReinitiate>
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7 Save and close the file.

8 Restart Payment Gateway.

These setting are merchant specific and will apply to all ACH merchants. If
you have multiple ACH merchants and you want each merchant to have
different reinitiation settings, you will need to modify the reinitiation
settings for the desired merchants.

For example, if the default reinitiation fee for Merchant A is $15.00 but the
reinitiation fee for Merchant B is $20.00, you would need to modify the
reinitiation fee for each merchant.

Setting the reinitiation fee and sending the reinitiation file can be done
manually. For more information, see See "Manually Reinitiating a Returned
ACH Payment" on page 154. DataCenter customers should contact
TouchNet customer care for assistance.

Manually Reinitiating a Returned ACH Payment

If you do not have the automatic reinitiation option configured, you can
manually record a returned ACH payment. When you record a returned
ACH payment (returned payments have codes that begin with R).

To reinitiate the payment, follow these steps:

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH
Payments. The ACH Payment Search page displays.

2 Click the Begin and End Date calendar icon and select the desired
date range.

3 Enter the reference number or transaction ID in the Reference
number/Transaction id field. This is an optional entry.

4 Click the Search button.

5 If multiple transactions are returned, click the returned transaction's
Trans ID. The ACH Payment Search Results page displays.

If only one transaction is found, you are taken directly to the ACH
Payment Details page.
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ACH payment search results page

6 Click on the Trans ID link for the desired ACH payment transaction.

7 Scroll down to the Return and Restrict section.

Entering an ACH return code

8 To charge a reinitiate fee, enter the amount in the Add Fee field. You
must enter an amount in the fee field even if it is $0.

Reinitiating a returned ACH payment

9 Click the Reinitiate button.

10 Click OK to confirm the reinitiation. The transaction is added to the
list of pending transactions for the next ACH file.

You can reinitiate an ACH payment two times, for a total of three
transaction submissions to the bank.

If you have recorded a return code for a returned transaction in Payment
Gateway, you may void that return code for that transaction (in Payment
Gateway only). This may happen if you accidentally entered one incorrectly
or if you entered a return code for the wrong transaction.

Voiding a Return Code Recorded in Payment Gateway

To void a return code, follow these steps.
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1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH
Payments

2 Enter the date range and any additional information that will help find
the transaction.

3 Click the Search button.

4 If multiple transactions are returned click the transaction's Trans ID.
The ACH Payment Details page displays.

If only one transaction is found you are taken directly to the ACH
Payment Details page.

5 Scroll down to the Return and Restrict section.

6 Click the Void Return button.

7 Click OK to confirm you want to void the return. The void is recorded
in the transaction history at the bottom of the page.

Note: This does not update the payment amount on the host.

Voiding a return code

7.7 Regenerating an ACH File
You can regenerate an ACH file if it has not been marked as settled. If you
need to resubmit an ACH file to your bank, you must resolve any problems
related to the file then regenerate the file. You must have the Process
Refunds role to regenerate an ACH file.

To regenerate an ACH file, follow these steps. This process requires bursar
rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage ACH File.
The ACH File Search page displays.
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The ACH File Search page

2 Click the calendar icons for the Begin Date and End Date and select
the desired date range. The default search is month-to-date.

To view the current date, click the Today button. To view transactions
that have processed during the last 24 hours, click the Last 24 hours
button. To view transaction for the last rolling twelve months, click
the Year to date button.

3 Enter the ACH File ID in the File ID field. This is an optional entry.

7.8 Resolving ACH Payment Disputes
When you need to resolve a disputed payment, you can retrieve the ACH
agreement that the payer signed.

To look up an ACH agreement, you can search by the payment’s transaction
ID or by the date. If you know details such as the payer’s name or payment
amount, you can search for the transaction ID in the Current Status report.

The ACH agreement information includes:

• The terms and conditions that were current when the agreement was
signed.

• The name submitted with the payment.

• The amount submitted for the payment.

• The routing number and account number submitted with the payment.

• For ACH payments submitted through TouchNet applications, the IP
address of the browser from which the terms and conditions were
agreed to.
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Looking Up
ACH

Agreement

To look up an ACH agreement, follow these steps. This process requires
bursar or cashier rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [ACH merchant] > Manage
ACH Payments. The ACH Payment Search page displays.

2 Enter the begin and end date range and any other information that
will help find the transaction.

3 Click the Search button. The ACH Payment Search Results page
displays.

4 Click the Trans ID link for the transaction you want to view. The ACH
Payment Details page displays.

5 Click the View Agreement link. The ACH Agreement displays on the
page.

7.9 Managing ACH Account Restrictions
ACH checking and savings accounts may be restricted so that any attempted
ACH transaction using that account through any TouchNet U.Commerce
Central application or Web API will be rejected. When an account is
restricted, the user attempting to pay will receive a -1748 Declined -
Account Restricted exception.

The TouchNet Payment Gateway Operations Center allows you to view
currently restricted accounts, restrict accounts, or remove restrictions from
accounts. Schools may use the account restriction functionality for a variety
of purposes:

• Restricting the accounts of problem payers saves your school time and
money.

• Placing a restriction on your school’s own checking and savings
accounts may help prevent fraud. Some people have successfully paid
school charges using the account and ABA numbers found on a
school’s refund check. Restrict your school’s bank accounts in
Payment Gateway so these fraudulent payments will not be accepted.

• Setting up automatic restrictions on accounts that have had a certain
number of returns may save bank charges. Some banks charge steep
fees when an account’s transactions must be continually returned.

Viewing All
Restricted ACH

Accounts

To view a list of all restricted accounts, the user must have the administrator
role. From the Payment Gateway home page, navigate to Payment
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Processing Setup > ACH > Restricted Accounts > Accounts. The
Restricted Accounts page displays.

Viewing Restricted Accounts

Note: The restriction status of accounts are not visible in Payment Gateway
Operations Center reports because only users with the administrator role
may view restriction status.

Accounts marked in green have had their restriction removed.

To change the type of account for an account that is restricted, click the
Update link for that account.
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Restricting an
Account
Manually

When a transaction is returned by the bank, you have the option to restrict
that account while recording the return in Payment Gateway. Use the Add
Restricted Account page to restrict checking and savings accounts. You must
have the administrator role to restrict an account.

To manually restrict an account, follow these steps.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > ACH > Restricted Accounts > Add. The Add
Restricted Accounts page displays.

The Add Restricted Account page

2 Enter the bank routing number for the account you are restricting in
the ABA routing number field.

3 Enter the bank account number for the account you are restricting in
the Account number field.

4 Enter the name of the person associated to the bank account being
restricted in the Name field.

5 Enter a description for the account being restricted in the Descriptor
field. This is an optional field.

6 Check the type of account (checking and/or savings) being restricted
in the Account Type field.

7 Click the Add Restriction button. The account is restricted and added
to the Restricted Accounts listing. If an ACH transaction is processed
for the restricted account, the user attempting to pay will receive a -
1748 Declined - Account Restricted exception.

For information on removing a restriction from an account, see
"Removing a Restriction From an Account " on page 161.
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Restricting
Accounts

Automatically

You can set up your ACH merchant configuration so that any ACH account
will be automatically restricted after a certain number of returns from the
bank. You must have the administrator role to complete this process.

Note: The following procedure restricts accounts regardless of which ACH
merchant they attempt to process through.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > ACH > Restricted Accounts > Merchant. The
ACH - Merchant Configuration page displays.

2 Select the desired merchant from the Current Merchant dropdown list.

3 In the Use Account Restriction field, verify the Yes radio button is
selected. The default is Yes.

4 In the Restrict After Reject Num field, enter the number of rejections
that should automatically restrict that account. The default is 4.

For example, if the Restrict After Reject Num field is set to 1, only
one bank return on that account will be allowed. The second time a
transaction is returned, the account will be restricted automatically.

Removing a
Restriction
From an
Account

To remove an account restriction, you must have the Administrator role.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > ACH > Restricted Accounts. The Restricted
Account page displays.

Remove a restriction from an ACH account

2 Click the Update link for the account you want to remove the
restriction from. The Update Restriction Account page displays.
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The Update Restriction Account page

3 Clear both Change Restriction checkboxes, checking and savings.

4 Click the Update button.

5 Click OK to confirm removal of the restriction. The restriction is
removed.

The Restricted Accounts page displays. The account is marked "not
restricted."

7.10 Processing an ACH Reversal File
There are times when transactions in an ACH File sent to the bank need to
be reversed. Payment Gateway allows you to send a reversing file to the
bank to correct any issues.

The reversing file can come from the bank or the school can get a notice
from the bank asking for a reversing file to be sent. A file that has been
settled cannot be reversed.
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Generating an
ACH Reversing

File

To generate an ACH reversing file, follow these steps. You must have the
Process Returns role to generate an ACH reversing file.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > Manage ACH File. The ACH File
Search page displays.

The ACH File Search page

2 Click the Begin and End Date icons to select the desired date range or
enter the file ID.

3 Click the Search button. The ACH File Search Results page displays.

The ACH File Search Results page

4 Locate the desired ACH file you wish to reverse and click the Status
link. The ACH File Status page displays. From this page you can
generate a reversing file for all the transactions in the file.

Note: You can also download the ACH file by clicking the Download
link.
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The ACH File Status page

5 Click the Generate a reversing file button.

6 Click OK to confirm creating the reversing file.

7 A window displays prompting you to save this file to your computer.
Follow your school's procedures for saving files.

8 Send the reversing file following the bank's instructions for
submitting a reversing file.
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8.0 Debit Payment Processing
You will use the Payment Gateway Operations Center to view transactions
details and review reports to see totals or details of debit payments you
accept. Before you can perform these tasks, you must add your debit
merchants.

At this writing, Payment Gateway works with ten debit processors:

• Concord EFSnet

• Elavon (formerly Nova)

• FDC North

• FDC South

• Global Payment Systems East

• Mastercard International Gateway Service (MIGS)

• Moneris e-Select Plus (Pinless debit available through INTERAC
Online)

• Paymentech

• RBS Lynk

• TSYS Acquiring Solutions (formerly Vital)

All of these processors process PIN debit transactions. Only Concord
EFSnet, Elavon, Global Payment Systems East, Moneris e-Select Plus,
FDCNorth, and TouchNet Merchant Services currently process PINless debit
transactions.

What Concord EFSnet and MIGS Users Should Do

• Use the Batch Details report to see accurate data about settled
transactions.

• If you want to schedule the generation of trailer records on specific
days of the week, contact TouchNet Customer Care for assistance.

8.1 View Debit Transaction Details
You can view debit transaction details either before or after the initial
payment transaction is settled.

To view debit transaction details, follow these steps. This process requires
bursar or cashier rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [debit merchant] > Manage Debit
Payments. The Debit Payment Search page displays.
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2 Click the Begin and End Date calendar icons to select the desired
date range.

3 Enter any other desired search criteria to narrow your search.

4 Click the Search button. The Search Results page displays.

5 Locate the payment and click its Reference #. The page displays.

Note: To see failed activity, mark the Display Failed Activity option.

Note: You will not see a settlement history for transactions that have
not been settled.

Debit transaction details
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Transaction Details Fields

Transaction Date/Time

Date and time that the transaction was authorized.

Payment Type

Shows DEBIT.

Card Number

Shows the last four digits of the card number.

Debit Type

Shows either PIN or PINless.

Authorization Reference Number

Unique identifier for the transaction.

Ancillary Data

Additional information about the transaction entered at the time payment
was made.

Current Status

Shows Settled even if the batch is pending.

Settled Balance

The balance shown is $0 if the transaction has not been settled.

Cashback

Amount of cash given to the customer over and above the purchase amount
using the debit in the same transaction.

Available for Refund

Total minus any cashback amount.

Activity

Purchase details for the transaction.

Settlement History

Settlement of activity for the transaction.

When you are finished click the Search button to get back to the search
criteria page or the Transactions button to get back to the transactions page.
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8.2 Settling the Pending Batch Manually
Debit transaction batches are different than credit card transaction batches.
Debit payments are authorized and settled between the payer and the debit
processor at the time of the transaction. What remains is the settlement
between the debit processor and your school.

You can schedule the time for Payment Gateway to automatically submit
the batch for settlement each day. Or you can settle the pending batch
manually whenever you choose. This section tells you how to settle a
pending batch manually.

For information about settling batches automatically, see the "Automating
Debit Card Batch Settlements" topic in online help.

Note: FDC South customers should not settle debit batches manually. You
should use automatic batch settlement instead. Set the batch time to your
local time that corresponds with 4 a.m. Eastern, which is when FirstData's
autoclose runs.

To settle a pending batch manually, follow these steps. This process
requires bursar rights.

1 From the Payment Gateway home page, navigate to Payment Tasks
> Merchant Administration > [debit merchant] > Settle Batch. The
Pending Credit Card Payments page displays.

Pending Debit Card Payments page

2 Review the list of pending, authorized transactions on the Pending
Debit Payments page.

3 Click the Settle this batch button and confirm your selection.

The Settlement Results page reports either settlement success or any
exception that caused a failed settlement.
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8.3 Resubmitting a Failed Debit Card Batch
The Payment Gateway Operations Center is used to track and manage the
debit card payments your school accepts. From the Operations Center you
can settle debit card batches, resubmit failed batches, automate batch
settlement, and view reports.

When a debit card payment batch fails, for any reason, designated users are
notified via a failed batch email message generated from Payment
Gateway. Once the user with the resubmit failed batch merchant role
receives the email notification, they can locate the failed batch from the
Debit Card Batch Settlement report, review the failed batch details and
resubmit it.

Important! Use caution when resubmitting a failed batch. Resubmitting a
failed batch may double-charge your customers. Before a failed batch is
resubmitted it should be thoroughly researched and verified with your
bank to ensure that the batch actually failed and it was not settled
successfully by your processor. Remember, resubmitting a failed batch
without ensuring that it has not been settled could double-charge your
customers.

Refer to the "Configuring Failed Batch Email Settings" section in the
Payment Gateway 6 Technical User's Guide for information on setting up
the email notification.

For instructions on editing a user profile to add the resubmit failed batch
role, see "Changing Users' Roles" on page 248.
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Credit Card
and Debit Card

Processors

There are some differences in how Payment Gateway works with the credit
card processors. For some processors resubmitting a batch is not allowed. Be
sure that your processor allows resubmitting a batch before you attempt it.

Note: The resubmit failed batch fields may not display in your Payment
Gateway Operations Center if your processor does not allow for
resubmitting a batch.

Determining whether a processor allows resubmitting a batch depends on a
combination of the batch type (debit or credit) and the processor type. The
following table identifies the available credit card and debit card processors
and whether they allow you to resubmit a failed batch based on batch type.

Processor Credit Card Batch Debit Card Batch

Concord EFS Net false false

FDC Nashville true false*

FDC North true true

FDC South true false

Elavon (Nova) true false

GPS East true true

MIGS false false*

Moneris false false

Paymentech true false

TSYS (Vital) true true

*Not applicable since debit is not allow for this processor

Note: Concord EFSnet, Moneris, and MIGS are host-based credit card
processors. This means transactions are authorized and settled without using
the batch files familiar to users of terminal-based processors. Therefore, the
resubmit failed credit card batches feature does not apply to Concord
EFSnet, Moneris, and MIGS.
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Viewing Failed
Debit Card
Batches

When a debit card batch fails, an email notification is sent to designated
users and a notification is also displayed on the U.Commerce Central
Dashboard. The email contains the name of the settle file that failed. Use
the settle filename to view the file details on the Debit Card Batch
Settlement report. The TPG RC (Response Code) column displays the
success-or-fail response code from Payment Gateway. Failed codes are
typically -1700, -1800, or -1900 series exception codes.

To view the Debit Card Batch Settlement report, follow these steps.

1 From the Payment Gateway home page, navigate to Reports. The
Report Selection page displays.

The Report Selection page

2 Select the Debit Card payment type.

3 Select the Batch Settlement report type.

4 Select the desired begin and end date and time to filter your report.
For complete instructions on selecting the date and time filters, see
"Running Reports" on page 184. 

Note: You can also narrow the results of your report by selecting
options from the following search fields:

• Merchant Accounts - to select an individual merchant.

• Optional Search Fields - to select individual applications.

• Credit Card and Debit Card - to select individual debit cards.
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5 Click the View Report button. The Debit Card Batch Settlement
report displays.

The Debit Card Batch Settlement report
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Resubmitting
the Failed

Batch

To resubmit a failed batch, follow these steps.

Important! Use caution when resubmitting a failed batch. Resubmitting a
failed batch may double-charge your customers. Before a failed batch is
resubmitted it should be thoroughly researched and verified with your
bank to ensure that the batch actually failed and it was not settled
successfully by your processor. Remember, resubmitting a failed batch
without ensuring that it has not been settled could double-charge your
customers.

1 On the Debit Card Batch Settlement report page, locate the failed
batch that you wish to resubmit.

Note: The file name is displayed in the failed batch email notification and
looks something like this: Settle.RB12345-6789-123-456789.

The Debit Card Batch Settlement report

2 Click the Batch # link. The Debit Card Pending Transaction report
displays.
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The Debit Card Pending Transactions report

3 The batch details display on the page. Before resubmitting the failed
batch, be sure that you have thoroughly researched the batch and you
have contacted your processor to confirm that the batch was not
settled successfully.

Note: In the example shown, the batch only includes one transaction.

Note: If a "no rows returned" message displays on this page, click the
Back to Batch Settlement Report button and search for the batch by
modifying the begin and end date to redisplay the failed batch file.

4 Click the Resubmit batch button.

5 A window displays prompting you to verify you have contacted your
processor. Click OK to continue. The batch is resubmitted
immediately.

6 Once the failed batch has been resubmitted, you can review the
Debit Card Batch Settlement report to verify the batch was
successfully submitted. A notice at the top of the report page
indicates that the batch settlement was successful.

Note: If the batch is not successfully processed after resubmitting it, users
will be notified again via email and the Dashboard. Contact TouchNet
Customer Care for assistance.
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Viewing the
Resubmit

Failed Batch
File Activities

You can use the User Audit Log to view user activity in the Operations
Center. To view the resubmit failed batch activities, you can filter the User
Audit Log by the Resubmit Failed Batches File action. You can also filter
the resubmit batch activities by an individual user.

To view resubmit failed batch activities, follow these steps.

1 From the Payment Gateway home page, navigate to Users > User
Audit Log. The User Audit Log displays.

The User Audit Log

2 Enter the desired beginning and ending date and time in the date
range fields. The current date defaults in both the begin and end
fields.

3 In the Select User field, select the desired user from the dropdown
list. The default is all users.

4 In the Select Action field, select the Resubmit Failed Batch File from
the dropdown list.
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The Select Action dropdown menu

5 Click the View Log button. The user audit log results appear.

The User Audit Log results
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8.4 Automating Debit Batch Settlements
When you use automatic, daily batch scheduling, Payment Gateway begins
to check for an available connection at the time you schedule. The batch is
processed as soon as possible after the scheduled time.

Note: Concord EFSnet and MIGS users are not technically scheduling batch
settlement. Concord EFSnet and MIGS settle transactions during
authorization. You are scheduling the time to generate the batch details for
the previous day's activity. All Concord EFSnet and MIGS users should set a
time.

You can schedule the batch settlement time for each of your merchants, or
you can turn off automatic batch scheduling for any merchant.

Note: Do not use the Moneris e-Select Plus interface to schedule batch
settlement. Use Payment Gateway instead. Disable batch scheduling
through Moneris e-Select Plus.

Note: FDC South users should not use the Settle Batch link for debit
merchants. If Settle Batch is used instead of (or in addition to) automatic
batch scheduling, there may be discrepancies between Payment Gateway
report totals and bank statement totals.

If you have more than one merchant you can schedule a different batch
time for each. If batches are scheduled to run at the same time Payment
Gateway will settle them in the order it finds them. If you must know the
order in which batches will run, schedule each merchant for a different
time.

Although your scheduled batch runs automatically, you can manually settle
a pending batch at any time. See "Settling the Pending Batch Manually" on
page 168.

Follow these steps to schedule automatic batch settlement. This process
requires administrator rights.

1 From the Payment Gateway home page, navigate to Payment
Processing Setup > Debit > Merchant. The Debit Card – Merchant
Configuration page displays.

2 Use the Current Merchant dropdown list to select the merchant.

3 Complete the Batch Time field. Use military time in the 00:00 format
with two digits each for hours and minutes. If the field is left blank,
the time will default to midnight.

DataCenter customers, be aware that the time you enter here is
Central Time because the TouchNet DataCenter is located in the
Central time zone.
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Note: To turn off automatic batch scheduling for a merchant, enter
OFF in the Batch Time field.

Time to Run Batch Batch Time Format

2:30 a.m. 02:30

1 p.m. 13:00

12:15 a.m. 00:15

No automatic batch scheduled OFF

Batch Schedule Time Examples

4 Click the Save Changes button.

5 Stop and restart Payment Gateway. If your TouchNet solutions are
hosted on campus, see "Starting and Stopping Payment Gateway" on
page 89. If your TouchNet solutions are hosted in the TouchNet
DataCenter, contact Customer Care for assistance.
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9.0 Managing ERP Transactions
Note: Users who do not have the View ERP Transactions and/or the Manage
ERP Transactions user roles will not be able to view or access this page.

The ERP Update Transactions page provides information about transactions
that have and have not updated the ERP, by TouchNet solution application,
for a specified date range.

Note: The transaction history is only available for the 30 days prior to the
current date. For example, on December 1st, transaction data would be
available for November 1 through December 1.

From the Payment Gateway home page, navigate to Payment Tasks >
ERPUpdate Transactions. The ERP Update Transactions page displays.

The ERP Update Transactions page
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There are three main sections to the page:

• At the top is a table displaying the received, posted, and outstanding
totals, by application.

• Failed Updates—Displays transactions that have attempted to update
your ERP system and have failed for any reason. Users with Manage
ERP Transactions rights can retry failed transactions or may mark a
transaction as complete if it has been resolved manually.

• Pending Updates—Displays transactions that have not yet attempted
to update your ERP system. If transactions in this table have failed in
the past, users with Manage ERP Transactions rights can retry failed
transactions or may mark a transaction as complete if it has been
resolved manually.

9.1 Failed Update Transactions
The Failed Updates section lists transactions that have attempted to update
your ERP system and have failed for any reason.

Note: Users with Manage ERP Transactions rights can retry failed
transactions or may mark a transaction as complete if it has been resolved
manually.

The Failed Updates section on the ERP Update Transactions Page
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For each transaction listed in the Failed Updates section, you have the
option to update individual transactions, retry all failed transactions, mark
all failed transactions as complete, or reset all selected transactions. Each of
these actions can be performed using the buttons at the top of the Failed
Updates section. Those buttons are:

• Update Selected Failed Updates

• Retry All Failed Updates

• Complete All Failed Updates

• Reset Selections

Updating
Selected Failed

Updates

Prior to updating a failed transaction, you should research the reason for the
failed transaction and attempt to manually correct it.

For example, if the failure reason code indicates the transaction is missing a
Banner detail code, you would access the TouchNet Bill+Payment
application, locate the failed transaction and correct it. Once the transaction
is corrected you would return to the Payment Gateway ERP Update
Transactions page and mark the corrected transaction to either retry to
process it again or complete it.

To update individually selected failed transactions, follow these steps.

1 Locate the desired failed transaction and select either the Retry or
Complete radio button in the Action column.

2 Click the Update Selected Failed Updates button.

Failed transactions marked as completed are removed from the Failed
Updates section.

Marking an individual failed transaction
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Retry All Failed
Updates

To retry all the failed transactions displayed for the selected date range,
follow these steps.

1 Click the Retry All Failed Updates button to mark all the transactions
listed in the Failed Updates section to retry them.

2 Click OK to confirm you want to retry all the failed transactions.

The transactions display in the Pending Updates section.

Complete All
Failed Updates

To complete all the failed transactions displayed for the selected date
range, follow these steps.

1 Click the Complete All Failed Updates button to mark all the
transactions listed in the Failed Updates section as complete.

2 Click OK to confirm you want to retry all the failed transactions.

The failed transactions are removed from the Failed Updates section.

Reset
Selections

To remove all the retry and complete actions previously selected, for the
failed transactions displayed, click the Reset Selections button. The radio
button selections are removed.

9.2 Pending Update Transactions
The Pending Updates section displays transactions that have not yet
attempted to update your ERP system. If transactions in this table have
failed in the past, users with Manage ERP Transactions rights can retry failed
transactions or may mark a transaction as complete if it has been resolved
manually.

Note: Users with Manage ERP Transactions rights can retry failed
transactions or may mark a transaction as complete if it has been resolved
manually.
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10.0 Payment Gateway Reports
Payment Gateway’s reports show you all payment activity for credit card,
signature debit only, debit, ACH, and campus card payment processing.
Each of the reports can be customized to display payment data at the
merchant level, application level or transaction level. The reports also show
information about exceptions incurred in processing.

You can view the Payment Gateway reports in a separate window if you are
using Internet Explorer, or in a separate tab if you are using Firefox. You
can also export the report data to a CSV-format file for use in spreadsheet
programs.

The following pages include a review of each report and descriptions of the
report fields, as well as ways to search for data.

Step-by-step information about reports including searching, printing, sorting,
and exporting to CSV is also available in Payment Gateway online help.
The CSV file details for each report are also available in online help.

10.1 Payment Gateway Report Types
Payment Gateway builds six types of reports. If you are licensed for credit
card, signature debit only, debit, ACH, and campus cards you can see all
reports for all payment types. In your reports, you can only include the
merchants for which you have the accountant role.

Reports for All
Payment

Types

The following reports are available for all payment types:

• Payment Transactions report

• Payment Transactions - Merchant Summary report

• Batch and ACH File report

• Batch and ACH File - Merchant Summary report

• Tender Summary report (displays on the Payment Gateway Home
page)
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Credit Card
Reports

The following credit card reports are available in Payment Gateway:

• Activity report

• Credit Card Type Usage report

• Pending Transactions report

• Batch Settlement report

• Batch Details report

• Authorized Not Settled report

• Exception Log report

ACH Reports
The following ACH reports are available in Payment Gateway:

• Pending Transactions report (next ACH file)

• Current Status report (Transactions)

• ACH File report

• ACH File Details report

• Rejections report

• Failed Attempts report

Debit Reports The following debit reports are available in Payment Gateway:

• Activity report

• Pending Transactions report

• Batch Settlement report

• Batch Details report

Campus Card
Reports

The following campus card report is available in Payment Gateway:

• Activity report

10.2 Running Reports
A variety of reports can be run based on the payment type and report type
selected. The information included in these reports varies by the report type
and the additional search criteria selected. You can narrow your search for
particular transactions, files, error message, etc.

You must have accountant rights to view reports in the Operations Center.
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Important! What you see in reports depends on which payment methods
are accepted by your school and configured in Payment Gateway, and
your assigned merchants. If credit card, debit, ACH, and campus cards,
payments are accepted, you can show reports for all of these merchants.
However, if you are not assigned as an accountant for a particular
merchant, you won’t be able to include that merchant in the reports.

To run reports in the Operations Center, follow these steps.

1 From the Payment Gateway home page, navigate to Reports. The
Report Selection page displays.
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The Report Selection page
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You can narrow the results of a report by selecting options from the
following search fields:

• Merchant Accounts

• Optional Search Fields

• Credit Card and Debit Card

• ACH

Note: If you do not see the Credit Card and Debit Card search fields or the
ACH search fields, click the Additional Fields Show radio button at the
bottom of the page.

2 Select the applicable payment type or select All to view all payment
types.

3 Select the desired report type.

4 Select the desired date and time to filter your report using one of the
following options: 

Using the calendar icons:

• Click the Begin Date calendar icon, the calendar popup window
displays. By default, the current date is highlighted.

Select the date and time from the calendar

Click the desired start date for the report.

Note: Click the to display the previous months calendar, in

descending order. Click the to display the previous calendar

months and years calendar, in descending order. Click the to
display the upcoming months calendar, in ascending order. Click

the to display the upcoming year calendars, in ascending
order.

• Click the hour and minute fields to select the desired begin
time for the report.

Select the hour and minutes for the report start date
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• Click the am field to change to pm. The am/pm field is a
toggle.

• Click the End Date calendar icon and select the desired month,
day, year and time for the end of the report.

Using the predefined date/time buttons:

• Click the Today button to filter report information for the
current day.

Select the predefined report date and time

• Click the Last 24 hours button to filter report information for
the last twenty four hours.

• Click the Month to date button to filter report information from
the first day of the current month to the current date.

• Click the Year to date button to filter report information from
January 1st to the current date.

Merchant Accounts section

5 Based on your payment type, select the desired merchants accounts in
the Merchant Accounts section. To select all merchants, click the All
Merchants radio button or click the Select Individual Merchants
radio button and check the desired individual merchants you wish to
display on the report.

Remember you will only be able to select merchants based on the
payment methods your school accepts.
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The Merchant Accounts section on the Report Selection page

Optional Search Fields section

In the Optional Search Fields section you can narrow your report results by
a specific application, application module, ancillary data, amount, response
code, and exception codes.

The Optional Search fields on the Report Selection page

6 Complete the desired search fields.
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Optional Search Fields

Applications

Mark the desired application(s) checkboxes.

Application Modules

Mark the desired application module(s) checkboxes.

Ancillary Data

To search transactions by the exact ancillary data, select the Exactly radio
button and enter the search string for the ancillary data. If you don't know
the exact data you are searching for, you can enter a partial match of the
ancillary data by selecting the Partial Match radio button and entering a
partial search string.

Search by the ancillary data

Amount

To search for an exact dollar amount for a transaction, select the Exactly
radio button and enter the exact dollar amount. To search for a dollar
amount range, select the From/To radio button and enter a dollar range in
the From and To fields.

Response Code

To narrow your report results by a particular exception code, choose Specify
Exception Code from the Response Code option dropdown list. Then enter
the code in the Exception Code field (leave off the minus sign). When you
click View Report, only transactions that have received this exception code
display.

Exception Log

This option is only available for the report named Exception (Error) Log.
Select the Update Host option to view all transactions that have not
attempted to post yet, that attempted to post but failed and will be
attempted again, and that attempted to post and will not be tried again. If
the Update Host option is not selected, all transactions that have updated or
attempted to update the host will be listed.

Debit Type

To filter your report by debit type, check one of the available debit filters.
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Credit Card and Debit Card Fields section

In the Credit Card and Debit Card Fields section you can filter your report
results by a specific credit card or debit card number, reference number, and
batch number.

The credit and debit card search fields

7 Complete the desired search fields.

Credit Card and Debit Card Search Fields

Card Number

To view a specific credit or debit card, enter the last four digits of the card
number.

Card Type

Select the desired credit card type from the dropdown menu.

Reference Number

Enter the reference number for the credit or debit card.

Batch Number

If you want to view credit card and debit card transaction a pending or
rejected batch, enter the applicable batch number.

View Batch In Progress

Click the Yes radio button to view the transaction in a current pending
batch.

View Rejected Batch

Enter the filename of a rejected batch to view rejected transactions. Contact
TouchNet if you need assistance in finding the rejected batch filename.
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ACH Fields section

In the ACH Fields section you can filter your report results by a specific
transaction, transaction status, name, ACH file name, number, status,
transaction type, account type, and error message.

The ACH search fields

8 Complete the desired search fields.

ACH Search Fields

Transaction ID

Search for the transaction by it's transaction number.

ACH Transaction Status
Select an available status to show only transaction for that status.

Name
Search using the name entered with the original payment.

ACH File Name
The ACH file is assigned a name in Payment Gateway. Use it to limit your
search to a specific file as it is named on the server.

ACH File Number
Show the ACH file by number.
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ACH File Status
Show all ACH files or display only ACH files that have been created and
not settled.

Transaction Type
Show only ACH purchases or ACH credits.

Account Type
Show only transaction from checking or savings accounts.

Exception Msg (Error Message)
Search only for transactions that have received a particular exception
message. Enter the desired exception message or a portion of the exception
message.

9 Once you have selected the desired report criteria, click the View
Report button to display the report in a separate Internet Explorer
browser window (or a separate tab if you are using Firefox).

10 To export the report data to a comma-separed value, click the Export
to CSV button. The saved CSV files can then be opened in
spreadsheet programs.

11 Click the Close Window button to close the report window and return
to the Report Selection page.

12 To reset your report search selections on the Report Selection page,
click the Reset button.

10.3 Reports for All Payment Types
This section describes the reports available for all payment types.

The reports display in a separate window if you are using Internet Explorer,
or in a separate tab if you are using Firefox. Click the Close Window button
to close the report and return to the Report Selection page in the Payment
Gateway Operations Center.
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Review the Report Fields list for a brief description of each of the fields
displaying on the report.

Payment
Transactions

Use this report to see all payment activity for the selected date range for all
payment types.

The All Payment Transactions report

Report Fields

App

Name of the TouchNet application where the payment originated.

Module

Name of the TouchNet module where the payment originated.

Merchant

Name of the Payment Gateway merchant for the transaction.

Date

Date and time that the payment transaction was generated.

Tender

Name of the payment method.
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Type

Identifies transactions as one of the following types: 

• PUR, for payment

• CR, for credits

• REV, for reversals

• RIN, for reinitiations

• VOID, for completely voided transaction

Reference #
Unique number that Payment Gateway assigned to the ACH payment
transaction.

(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

To view the payment details page for a desired transaction, click the
Reference # link. The Payment Details page displays. Refer to the "Viewing
Payment Details" on page 234 for information about the Payment Details
page.

Amount

Amount of the payment transaction.

TPG RC

Payment Gateway success-or-fail response code. A zero indicates the
authorization was successful. A negative number indicates the authorization
failed. See "Exception Codes" on page 257.

Payer ID

The user ID of the person initiating the payment transaction.

Ancillary Data

Additional data submitted with payment. If ancillary data is entered when
processing a credit, it displays here.
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Payment
Transactions

Merchant
Summary

Report

Use this report to see all payment activity for the selected date range,
totaled at the merchant level. The report totals successful, failed, and
attempted transactions.

The Merchant Summary report

Report Fields

Merchant

Name of each merchant included in the report.

Pay Type

• Credit Card

• ACH

• Debit

• Campus Cards

Count

Number of successful, failed, and attempted transactions that were
processed for the merchant during the date range of the report.

Amount

Dollar amounts of successful, failed, and attempted transactions processed
for the merchant during the date range of the report.

Totals

Totals for all successful, failed, and attempted transaction counts and dollar
amounts.
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Batch and ACH
File Report

This report provides batch settlement and ACH file summary information for
the merchants and date range selected.

The Batch and ACH File report

Report Fields

Merchant

Name of each merchant included in the report.

Date

Date and time that the batch was settled or the ACH file generated.

Payment Type

• Credit Card

• ACH

• Debit

Batch ID/File Nbr

Batch ID or the generated ACH file number.

Batch Trx Count

Number of transactions in the batch or ACH file.

Batch Amount

Net dollar amount of all transactions in the batch or ACH file.

RC

Success-or-fail response from the credit card processor. The format varies by
processor. See "Exception Codes" on page 257.
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TPG RC

Success-or-fail response from Payment Gateway. A zero indicates that the
authorization was successful.

Totals

Total number of transactions and the total net dollar amount for all batches
and ACH files in the report.

Batch and ACH
File Merchant
Summary

Report

Use this report to see batch and ACH file information for the selected date
range, totaled at the merchant level. The report sums transaction counts and
amounts in batches and generated ACH files.

Note: You will not see this report unless your school is licensed for ACH
processing.

The Batch and ACH File - Merchant Summary report

Report Fields

Merchant

Name of each merchant included in the report.

Pay Type

• Credit Card

• ACH

• Debit

Counts

Number of successful, failed, and attempted batches for each merchant. For
ACH merchants, the columns show the number of ACH files generated (by
success, failure, or attempt to generate).
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Amounts

Total dollar amount of successful, failed, and attempted batches for each
merchant. For ACH merchants, the columns show the amounts contained in
generated ACH files (by success, failure, or attempt to generate).

Totals

Totals for all successful, failed, and attempted transaction counts and dollar
amounts.

Tender
Summary

Report

This report only displays transactions that have been settled.

Each tender type is broken down by its component types in its own table.
For example, ACH is broken down by WEB, PPD, ARC, POP, TEL, and
BOC, while Credit Card is broken down by Visa, MasterCard, etc.

Note: The Tender Summary report also displays on the Payment Gateway
home page.

Note: For PayPath customers with multiple Customer IDs, the Tender
Summary report displays settled totals for each Customer ID.

The Tender Summary report
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10.4 Credit Card Reports
This section describes the reports available for credit card and signature
debit only type payments. Review the report fields listed with each report
for a brief description of the fields displaying on the report.

The reports display in a separate window if you are using Internet Explorer,
or in a separate tab if you are using Firefox. Click the Close Window button
to close the report and return to the Report Selection page in the Payment
Gateway Operations Center.

The following reports are available for credit card transactions:

• Activity report

• Credit Card Type Usage report

• Pending Transactions report

• Batch Settlement report

• Batch Details report

• Authorized Not Settled report

• Exception Log

Activity Report The Activity report shows all attempted credit card authorizations, reversals,
voids, and credits for the date range and other search criteria you select. All
search criteria are allowed with this report.

Use this report to review payment activity, including declined payment
attempts. Also, use this report to see any credits that have been processed
for a payment. In the report, a payment transaction and any credits against it
share the same reference number or approval code. All transactions related
to a single payment are listed together when you sort the report by these
columns.

Use the report to review authorization success-or-fail responses from
Payment Gateway. These responses, including any exception codes, appear
in the TPG RC column.

You can narrow the results for the Credit Card Activity report by selecting
the desired optional search fields: 

• Merchant Accounts

• Optional Search criteria (applications, application modules, ancillary
data, payment amount, response code, and exception code). In the
Optional Search Fields section of the Report Selection page, narrow
your report search criteria by selecting the desired options.

• Credit Card and Debit Card

• ACH

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



Note: If you do not see the Optional Search Fields, Credit Card and Debit
Card Fields, and ACH Fields search options on the Report Selection page,
click the Additional Fields Show radio button at the bottom of the page.

For example, to narrow your report results by a particular exception code,
choose Specify Exception Code from the Response Code option dropdown
list. Then enter the code in the Exception Code field (leave off the minus
sign). When you click View Report, only transactions that have received
this exception code display.

You can also search transactions by the ancillary data they contain by
entering a search string in the Ancillary Data field in the Optional Search
Fields section of the Report Selection page.

You can view the Activity report online or export the report data as a
comma-separated value (CSV) file. The saved CSV files can then be opened
in spreadsheet programs.

The Credit Card Activity report

Report Fields

App

Application where the credit card transaction originated.

Module

Application module where the credit card transaction originated.

Merchant

Name of the merchant for the transaction.

Date

Date and time the transaction was authorized.
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Type

Identifies the transaction as one of these types:

• PUR, for purchase.

• REV, for reversal, which is a credit processed before settlement.

• CR, for a credit processed after settlement.

• VOID, for a voided payment.

Card Type

The type of credit or debit card (VISA, MasterCard, etc.) used for the
purchase. If the card is used as a signature debit, the card type displays
"Debit" following the card name. For example, "Visa Debit".

Amount

Amount charged to the card during the transaction. A VOID will show the
negative of the original amount. A REV or CR type will show the amount
credited.

Reference #

Unique transaction number assigned by Payment Gateway. A REV, CR, or
VOID type will have the same reference number as the original payment.

(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

To view payment details for an individual transaction, click the Reference #
link for the desired transaction. The Payment Details page displays.

Approval

Code assigned by the credit card processor. These numbers are assigned
only to successful transactions. Note that a REV, CR, or VOID type will
have the same approval code as the original payment.

TPG RC

Success of fail response code from Payment Gateway.

Payer ID

The user ID of the person initiating the payment transaction.

Ancillary Data

Any additional data submitted with the payment. For credits, it shows the
latest ancillary data entered. If you entered ancillary data when processing a
credit, it will appear here. Otherwise, credit transactions will include any
ancillary data entered with the payment.
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Credit Card
Type Usage

Report

The Credit Card Type Usage report is a merchant-level report. It shows the
number of settlements for each credit card type, the total amount charged to
that type of card, and the average amount (across all card types) per
successfully settled transaction. This report also shows the number of
settlements and total amount charged for credit card and signature debit
transactions.

You can search by the ancillary data they contain by entering a search string
in the Ancillary Data field in the Optional Search Fields section of the
Report Selection page.

The Credit Card Type Usage report

Report Fields

Credit Card and Signature Debit section

Merchant

Name of the merchant for this record.

Credit Card (Count and Amount)

The total number of settled credit card purchase transactions for the
merchant and the total dollar amount of those transactions.

Signature Debit
Visa

Total number of settled Visa signature debit purchase transactions for the
merchant and the total dollar amount of those transactions.
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MasterCard

Total number of settled MasterCard signature debit purchase transactions for
the merchant and the total dollar amount of those transactions.

Combined Total (Count and Amount)

The combined total count of all the credit card and signature debit purchase
transactions for the merchant and the total combined dollar amount of those
transactions.

Credit card totals section

Count

Number of settled credit card purchase transactions broken down by the
credit card types accepted (e.g., Visa, Discover) for payment for the
merchant.

Amt

Amount of money charged for each credit card type.

Total

Includes the combined total dollar amount for all card types for the
merchant and the average dollar amount of the transactions.

Pending
Transactions

Report

The Pending Transaction report displays merchant-specific payment detail.
Use the Pending Transactions report to view the current credit card batch. It
shows all payments and credits that have been authorized and are pending
settlement. This list of pending transactions constitutes the current batch.

This report page is also used to view failed credit card batch details and
resubmit failed credit card batches. You must have the Resubmit Failed
Batches merchant role to view and resubmit these batches.

Note: Concord EFSnet and MIGS users do not use this report. Your
transactions are sent to the credit card processor and are not collected in a
pending batch.
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The Credit Card Pending Transactions report

Report Fields

Summary section

Count

The total number of credit card transaction in the batch.

Amount

The total dollar amount of the credit card transactions in the batch.

Pending Transactions for merchant section

Date

Depending on your credit card processor, shows either when the original
purchase was authorized or when it was processed. Credits show the date
for the original purchase authorization, not the date of the credit.

Type

Identifies the transaction as one of these types:

• PUR, for purchase.

• REV, for reversal, which is a credit processed before settlement.

• CR, for credit processed after settlement.

• VOID, for voided payment.

If you have processed credits for payments that were not yet settled, the
report will show the currently charged amount with a settle flag of PUR.

TouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.

CONFIDENTIAL

10.0  Payment Gateway Reports 205



206 Chapter 10

Card

The credit card type.

Card Nbr

The last four digits of the credit card number.

Exp Date

Credit card expiration date.

Amount

Amount to be applied to the cardholder's account. For credits against
previously settled payments, the amount to be returned to the cardholder's
account is shown as a negative dollar amount.

Reference #

Unique number that Payment Gateway assigned to the original payment
transaction. Matches the reference number shown in the Activity report. To
view the payment details page for a desired transaction, click the Reference
# link.

(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

Approval

Approval code that the credit card processor returned at authorization. This
matches the transaction’s approval code shown in the Activity report.

Ancillary Data

Any additional data submitted with payments. For credits, it shows the
latest ancillary data entered. If you entered ancillary data when processing a
credit, it will appear here. Otherwise, credit transactions will include any
ancillary data entered with the payment.

Batch
Settlement

Report

This report summarizes each attempted credit card batch settlement for the
date range. Use it to review batch success-or-fail responses from the credit
card processor and Payment Gateway and to identify failed credit card
batches that may need to be resubmitted. Success-or-fail responses,
including any exception codes, appear in the RC and TPG RC columns.
Search by date and amount. To open batch details, click a batch number.

This report could be used to answer the following questions:

• Did any credit card batches fail that need to be resubmitted?

• How many signature debit vs. credit payments were processed?
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• How many signature debit payments and credit payments were
processed for the last month, year, etc.?

• How many credit only cards were processed for the last month, year,
etc.?

• Which merchant is processing the largest amount of signature debit or
credit card payments?

The Credit Card Batch Settlement report

Report Fields

Summary section

Payment Count

Displays the total number of payment transactions in the batch separated by
credit card or signature debit card payment types.

Payment Amount

Displays the total dollar amount for the payment transactions in the batch
separated by credit card or signature debit card payment types.

Merchant

Name of the merchant for this batch.

Date

Displays the date and time the batch details were processed.

Batch #

Code returned from the processor for successful settlements. Matches the
batch number shown in the Batch Details report, and is the same for all
transactions in a batch.
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Credit Card (Count and Amount)

Displays the total number and total dollar amount of credit card transactions
included in the batch for the merchant.

Signature Debit (Count and Amount)

Displays the total number and total dollar amount of signature debit
transactions included in the batch for the merchant.

Batch Total (Count and Amount)

Displays the total number and total dollar amount of all transactions
included in the batch for the merchant.

TPG RC

Success-or-fail response code from Payment Gateway.

Batch Details
Report

This report shows transaction details for credit card batches in the date
range. Use it to reconcile settlements against your banking records, or to
look up records of settled transactions. All search criteria are allowed with
this report.

Note: For some processors, Payment Gateway can automatically remove a
failed transaction from a batch and resubmit the batch. In these cases, the
failed transaction displays in the Batch Details report, while the Batch
Settlement report shows a successful batch.

You can search transactions by the ancillary data they contain by entering a
search string in the Ancillary Data field in the Optional Search Fields
section of the Report Selection page.

The Credit Card Batch Details report
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Report Fields

Summary section

Payment Count

Displays the total number of payment transactions in the batch separated by
credit card or signature debit card payment types.

Payment Amount

Displays the total dollar amount of payment transactions in the batch
separated by credit card or signature debit card payment types.

App

TouchNet application for the payment transaction.

Module

Module for the payment transaction.

Merchant

Name of the merchant for the batch.

Date

Displays the date and time the batch details were processed.

Type

Identifies transactions as one of the following types:

• PUR, for payment settlements.

• CR, for credits that refund part of a previously settled payment.

• VOID, for credits that completely void a previously settled payment.

If you have processed credits for payments that were not yet settled, the
report will show the currently charged amount with a settle flag or PUR.

Card Type

Type of card used for the transaction. If the card is used as a signature debit,
the card type displays "Debit" follow the card name. For example, "Visa
Debit".

Card Nbr

Last four digits of the card used for the transaction.

Exp Date

Expiration date for the card used for the transaction.
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Amount

Dollar amount for the transaction.

Reference #

Unique number assigned by Payment Gateway to the original payment
transaction. Matches the reference number shown in the Activity report.
(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

Batch #

Code returned from the processor for successful settlements. Matches the
batch number shown in the Batch Details report, and is the same for all
transactions in the batch.

Payer ID

The user ID of the person initiating the payment transaction.

Ancil Data

Additional data submitted with the payment. For example, a payer's ID
number. If you entered ancillary data when processing a credit, it appears
here. Otherwise, credit transactions include ancillary data entered with the
payment.

Authorized Not
Settled Report

This report lists credit card transactions that have been authorized by the
processor but have not yet been added to the batch for settlement.
Negative response codes in the TPG RC column indicate exceptions. When
this occurs, see "Exception Codes" on page 257.

You can search transactions by the ancillary data they contain by entering a
search string in the Ancillary Data field in the Optional Search Fields
section of the Report Selection page.

The Authorized Not Settled report
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Report Fields

App

Name of the application for the payment transaction.

Module

Name of the module for the payment transaction.

Merchant

Name of the Merchant for the transaction.

Date

The date and time the credit card processor attempted to settle the
transaction.

Type

Identifies the transaction as one of the following types: 

• PUR, for payment settlements.

• CR, for credits that refund part of a previously settled payment.

• VOID, for credits that completely void a previously settled payment.

Card Type

The type of credit card used for the transaction. If the card is used as a
signature debit, the card type displays "Debit" following the card name.

Amount

Amount to be authorized and applied to the cardholder's account. Amounts
credited for previously settled payments are shown as a negative dollar
amount.

Reference #

Unique number that Payment Gateway assigned to the original payment
transaction. Matches the reference number shown in the Activity report. To
view the payment details page for a desired transaction, click the Reference
# link.

(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

Approval

Code assigned by the credit card processor. These numbers are assigned
only to successful transactions. Note that a REV, CR or VOID type will have
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the same approval code as the original payment.

TPG RC

Success-or-fail response from Payment Gateway. A negative number
indicates that the authorization failed.

Payer ID

The user ID of the person initiating the payment transaction.

Ancillary Data

Additional data submitted with the payment. If ancillary data is entered
when processing a credit, it appears here.

Exception Log
Report

The Exception Log report gives you exception troubleshooting data about
credit card batch settlement exceptions, Payment Gateway database logging
exceptions, and exceptions from host updates of payments from TouchNet
U.Commerce Central solutions like Bill+Payment or Cashiering. The report
does not reflect exceptions from authorizations.

When the Batch Settlement report shows an exception, the corresponding
Exception Log report can help you pinpoint the cause of the exception.

Note: Depending on your credit card processor, the Error (Exception) Log
report may show which transaction failed within the batch. In some cases,
Payment Gateway is able to remove failed transactions and resend the
batch.

You can search by the ancillary data they contain by entering a search string
in the Ancillary Data field in the Optional Search Fields section of the
Report Selection page.

In the Optional Search Fields section at the bottom of the Report Selection
page, select the Update Host option to view all exception transactions:

• that have not attempted to post yet,

• that attempted to post but failed and will be attempted again, and

• that attempted to post and will be not tried again.

If the Update Host option is not selected, all transactions that have updated
or attempted to update the host will be listed.
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The Exception Log (Error Log) report

Report Fields

Merchant

Name of the merchant.

Date

Date and time the exception response was returned.

Type

Identifies exceptions as:

• BAT for batch-level failure.

• LOG, for payment log posting failure, when a data file could not be
posted to the Payment Gateway database. (Transactions missing from
reports may show this exception.)

• UPDT, for host update unsuccessful or failed attempt. "Unsuccessful"
attempts indicate that Payment Gateway will continue trying to
update the host. "Failed" attempts indicate that Payment Gateway is
no longer trying to update the host for this transaction.

Reference Nbr

The reference number is not used for payment log exceptions.

• For BAT exceptions, it shows the unique number that Payment
Gateway assigned to the original payment transaction. This number
matches the reference number showing in the Batch Details and
Authorization reports.
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Note: For some processors, this number is unique only within a
merchant's transactions. two merchants may have a transaction with
the same reference number.

• For UPDT exceptions, it shows the reference number from the credit
card, ACH, or cash transaction submitted through a TouchNet
U.Commerce Central solution.

Description

Cause of the exception.

TPG RC

Response code from Payment Gateway.

10.5 Debit Reports
This section describes the reports available for debit card type payments.
Review the report fields listed with each report for a brief description of the
fields displaying on the report.

The reports display in a separate window if you are using Internet Explorer,
or in a separate tab if you are using Firefox. Click the Close Window button
to close the report and return to the Report Selection page in the Payment
Gateway Operations Center.

The following reports are available for debit transactions:

• Activity

• Pending Transactions

• Batch Settlements

• Batch Details

Activity Report This report shows all attempted debit authorizations for the date range and
other search criteria you select. All search criteria are allowed with this
report. Use it to review payment activity, including declined payment
attempts.

Also use the report to review authorization success-or-fail responses from
the debit processor and Payment Gateway. These responses, including any
exception codes, appear in the RC and TPG RC columns.

You can search this report type by a particular exception code. In the
Optional Search Fields at the bottom of the Report Selection page, under
Response Code, choose Specify Exception Code from the Option dropdown
list. Then enter the code in the Exception Code field (leave off the minus
sign). When you click View Report, only transactions that have received
this exception code will appear.
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You can also search transactions by the ancillary data they contain by
entering a search string in the Ancillary Data field in the Optional Search
Fields section of the Report Selection page.

The Debit Card Activity report

Report Fields

App

Name of the TouchNet application where the payment originated.

Module

Name of the TouchNet sub-application where the payment originated.

Merchant

Name of the merchant for the transaction.

Date

Date and time that the transaction was authorized.

Type

Identifies the transaction type as PUR, for purchase.

Debit Type

Identifies the debit type as PIN or PINLESS.
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Amount

Amount charged to the card during the transaction (including any cashback).

Cashback

Amount given to the customer and charged to the debit card during the
transaction.

Reference #

Unique transaction number assigned by Payment Gateway. (For some
processors, this number is unique only within a merchant's transactions; two
merchants may have a transaction with the same reference number.) To
view the payment details page for a desired transaction, click the Reference
# link.

TPG RC

Success-or-fail response from Payment Gateway. A negative number
indicates that the authorization failed.

Payer ID
The user ID of the person initiating the payment transaction.

Ancil Data

Information about the payer or the transaction, for instance, a payer’s ID
number. This data is typically passed from your payment application to
Payment Gateway.

Pending
Transactions

Report

Use this report to view the current debit batch. It shows all payments
pending settlement. This list of pending transactions constitutes the current
batch. No search criteria are allowed for this report.

The Debit Card Pending Transactions report
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Report Fields

Summary section

Count

The total number of debit card transactions in the batch.

Amount

The total dollar amount of the debit card transactions in the batch.

Pending Transactions

Date

Depending on your debit processor, shows either when the original
purchase was authorized or when it was processed.

Type

Identifies transactions as type PUR, for payments to be settled.

Card

The debit card type.

Card Nbr

The last four digits of the debit card.

Exp Date

The date the debit card expires.

Amount

Amount to be applied to the cardholder's account.

Reference #

Unique number that Payment Gateway assigned to the original payment
transaction. Matches the reference number shown in the Activity report. To
view the payment details page for a desired transaction, click the Reference
# link.

(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

Approval

Approval code that the debit processor returned at authorization. Matches
the transaction's approval code shown in the Activity report.
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Ancil Data

Additional data submitted with payment.

Batch
Settlement

Report

This report summarizes each attempted debit batch settlement for the
selected date range. Use it to review batch success-or-fail responses. These
responses, including any exception codes, are shown in the RC and TPG RC
columns.

You can search this report by date and amount. To open batch details from
this report, click a batch's number link.

Note: Payment Gateway will not attempt to settle an empty batch. If a
scheduled batch does not appear in the Batch Settlement report, log into
the Operations Center with bursar rights and click the Settle Batch link. If
no transactions are pending, the batch was empty and no settlement was
attempted.

Note: Some processors allow Payment Gateway to split debit transaction
batches and some do not. When the batches are split, the Batch Settlement
report shows records for each batch created.

You can search this report by a particular exception code. In the Optional
Search Fields at the bottom of the Report Selection page, under Response
Code, choose Specify Exception Code from the Option dropdown list. Then
enter the code in the Exception Code field (leave off the minus sign).
When you click View Report, only transactions that have received this
exception code will appear.

The Debit Card Batch Settlement report

Report Fields 

Summary Section

Count

The total number of debit card transactions in the batch.
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Amount

The total dollar amount of the debit card transactions in the batch.

Merchant

Name of the merchant for the batch.

Date

Date and time the batch settlement was attempted.

Batch #

Approval code returned from the processor for successful settlements, or the
settle.RB file name for failed batches. Click the link to view the batch's
details report page.

Trx Count

Total number of transactions submitted with the batch.

Amount

Net amount of each batch included in the report. Zero amounts appear in
red and indicate transactions that have been voided or removed.

Cashback

Amount given to the customer as cash and charged to the debit card during
the transaction.

RC

Success-or-fail response from the processor. Format varies by processor. A
negative number indicates the batch settlement failed. For more details,
view your Exception Log report.

TPG RC

Success-or-fail response from Payment Gateway. A negative number
indicates batch settlement failure. For more details, view the Exception Log
report.

Batch Details
Report

This report shows transaction details for debit batches in the selected date
range. Use it to reconcile settlements against your banking records, or to
look up records of settled transactions. All search criteria are allowed with
this report.

Note: For some debit processors, Payment Gateway is able to automatically
remove a failed transaction from a batch and resubmit the batch. In these
cases, the failed transaction displays in the Batch Details report, while the
Batch Settlement report shows a successful batch.
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You can search transactions by the ancillary data they contain by entering a
search string in the Ancillary Data field in the Optional Search Fields
section of the Report Selection page.

The Debit Card Batch Details report

Report Fields

App

Name of the TouchNet application where the payment originated.

Module

Name of the TouchNet sub-application where the payment originated.

Merchant

Name of the merchant for the transaction.

Date

These columns show when the debit processor returned a success-or-fail
response for the batch settlement.

Type

Identifies transactions as PUR, for payment settlements.
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Debit Type

Identifies the debit type as PIN or PINless.

Amount

Amount applied to the cardholder's account (including any cashback).

Cashback

Amount given to the customer as cash and charged to the debit card.

Reference #

Unique number that Payment Gateway assigned to the original payment
transaction. This number matches the reference number shown in the
Activity report. To view the payment details page for a desired transaction,
click the Reference # link.

(For some processors, this number is unique only within a merchant's
transactions; two merchants may have a transaction with the same reference
number.)

Batch #

Code returned from the processor for successful settlements. This number
matches the batch number shown in the Batch Settlement report, and is the
same for all transactions in a batch.

Payer ID

The user ID of the person initiating the payment transaction.

Ancil Data

Any additional data submitted with payments, for instance, a payer's ID
number.

10.6 ACH Reports
This section describes the reports available for ACH type payments. Review
the report fields with each report for a brief description of the fields
displaying on the report.

The reports display in a separate window if you are using Internet Explorer,
or in a separate tab if you are using Firefox. Click the Close Window button
to close the report and return to the Report Selection page in the Payment
Gateway Operations Center.

The following ACH transaction reports are available in Payment Gateway:

• Pending Transactions (next ACH file)

• Current Status (Transactions)
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• ACH File

• ACH File Details

• Rejections

• Failed Attempts

Note: Credit transactions in ACH reports are displayed as negative amounts.

ACH Pending
Transactions

Report

The Pending report shows all ACH payments that have been submitted and
are pending inclusion in an ACH file. This list of pending transactions
constitutes the next ACH file to be generated. The Date Range search
criteria is disabled when this report is selected.

You can search transactions by the ancillary data they contain by entering a
search string in the Ancillary Data field in the Optional Search Fields
section of the Report Selection page.

The ACH Pending Transactions report

Report Fields

App

Name of the TouchNet application where the payment originated.

Merchant

Name of the merchant for the transaction.
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Date

Date and time of the originally submitted payment.

Origin

SEC code for the method of payment presentment.

Type

Type of ACH payment processed, as provided by NACHA rules. The most
common type is PUR (purchase).

Trans ID

Unique ID for the transaction. The transaction keeps this ID even if you
reinitiate it, and allows you to follow the transaction's progress through
reports.

To view detail for a transaction click the Trans ID link. The ACH
Transaction Info Report displays. The ACH Transaction Info Report shows
details about a specific ACH transaction.

Amount

Amount of the payment.

Name

Name that appears on the check.

Payer ID

The user ID of the person initiating the payment transaction.

Check Memo

Student ID number (if available) and any memo information entered with
the payment.
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Current Status
Report

The Current Status report shows the status of all ACH transactions within the
search criteria you have selected. Use this report to review payment
activity, including rejected transactions. All criteria are available for this
search.

The ACH Current Status report

Report Fields

App
Name of the TouchNet application where the payment originated.

Merchant

Name of the merchant for the file.

Date

The date and time the ACH file was generated.

Origin

How the ACH transaction was entered.

Type

Type of ACH payment processed, as provided by NACHA rules. The most
common type is PUR (purchase).
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Trans ID

Unique ID for the transaction. The transaction keeps this ID even if you
reinitiate it, and allows you to follow the transaction's progress through
reports.

To view payment details for a transaction, click the Trans ID link. The ACH
Transaction Info Report displays. The ACH Transaction Info Report shows
details about a specific ACH transaction.

Amount
Amount of the Payment.

Check Name

Name that appears on the check.

Reinit (Reinitiate)

Number of attempted batches for each merchant. For ACH merchants, the
column shows the number of ACH files generated.

When the bank returns an ACH payment (for insufficient funds, for
example), the transaction must be marked as returned in the Payment
Gateway Operations Center (See "Manually Recording a Return Code for an
ACH Payment" on page 152). Then the ACH transaction can be sent back to
the pending ACH payments list and batched with the next ACH file (See
"Manually Reinitiating a Returned ACH Payment" on page 154), usually
with a returned check fee added.

Payer ID
The user ID of the person initiating the payment transaction.

Check Memo

Student ID number (if available) and any memo information entered with
the payment.

Status

Status of the transaction (UNSETT, WAIT, RETURN, SETTLED, NOC,
VOIDED, REMOVED).

ACH File
Report

The ACH File report shows transaction, status, and amount information for
ACH files. To view transaction information in an ACH file, click the ACH
File ID.

The Amount and Ancillary Data search criteria are disabled when this report
is selected.
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The ACH File report

The following fields appear on the ACH File report.

Report Fields

Merchant

Name of the merchant for the file.

Date

Date and time the ACH file was generated.

ACH File ID

Unique ID for the ACH file in reports.

To view the ACH File Details report for a specific file, click the ACH File
ID link. The ACH File Details report displays. The ACH File Details report
shows detailed information about a transaction.

File

Name of the ACH file. The file name includes a unique seven-digit number
that identifies the file to your bank.

Status

File's status:

• Created, if the ACH file has been generated but not yet settled.

• Settled, if the ACH file has been marked as settled.

• Deleted, if the ACH file has been deleted.

Current File Count and Amount

Number and amount of ACH transactions to be processed by the bank.
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ACH File
Details Report

The ACH File Details report shows detailed information about transactions
in an ACH file. Removed transactions are shown in red. The report
separately totals current, removed, and attempted payments. You can search
this report by date, transaction amount, and ancillary data. The Amount
search criteria is disabled when this report is selected. To view specific
transaction information, click the Trans ID.

The ACH File Details report

Report Fields

App

Name of the TouchNet application where the payment originated.

Merchant

Name of the merchant for the transaction.

Date

The date and time the ACH file was generated.

Type

Type of ACH payment processed, as provided by NACHA rules. The most
common type is PUR (purchase).

File ID

The unique seven-digit number that identifies the file to your bank.
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Trans ID

Unique ID for the transaction. This transaction keeps this ID even if you
reinitiate it, and allows you to follow the transaction's progress through
reports.

To view detail for a specific ACH transaction, click the Trans ID link. The
ACH Transaction Info report displays. The ACH Transaction Info Report
shows details about a specific ACH transaction.

Amount

Amount of the payment.

Name

Name that appears on the check.

Payer ID

The user ID of the person initiating the payment transaction.

Check Memo

Student ID number (if available) and any memo information entered with
the payment.

Status

Status of the transaction (UNSETT, WAIT, RETURN, SETTLED, NOC,
VOIDED, REMOVED).

Rejections
Report

The Rejections report shows transaction data for each ACH payment you
have marked as rejected. This data includes the amount of the payment and
number of reinitiations. All criteria are available for this search.

You can search transactions by the ancillary data they contain by entering a
search string in the Ancillary Data field in the Optional Search Fields
section of the Report Selection page.

The ACH Rejections report

The following fields appear on the Rejections report.
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Report Fields

App

Name of the TouchNet application where the payment originated.

Merchant

Name of the merchant for the transaction.

Date

Date and time of the original payment.

Origin

SEC code for the method of payment presentment.

Type

Type of ACH payment processed, as provided by NACHA rules. The most
common type is PUR (purchase).

Trans ID

Unique ID for the transaction. The transaction keeps this ID even if you
reinitiate it, and allows you to follow the transaction's progress through
reports.

Amount

Amount of the payment.

Reinit

Number of times the payment has been marked as rejected and then
reinitiated. (You can initiate a payment up to three times.)

Payer ID

The user ID of the person initiating the payment transaction.

Check Memo

Student ID number (if available) and any memo information entered with
the payment.

Reason

Rejection code and the reason for rejection.
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Failed
Attempts
Report

This report shows transaction data for each ACH payment that failed before
it could be sent to the bank. These are typically accounts that have been
restricted in Payment Gateway and transactions that listed a bad ABA
routing number.

You can search this report type by a particular exception code. In the
Optional Search Fields at the bottom of the Report Selection page, under
Response Code, choose Specify Exception Code from the Option dropdown
list. Then enter the code in the Exception Code field (leave off the minus
sign). When you click View Report, only transactions that have received
this exception code appear.

You can also search transactions by the ancillary data they contain by
entering a search string in the Ancillary Data field in the Optional Search
Fields section of the Report Selection page.

The ACH Failed Attempts report

The following fields appear on the Failed Attempts report.

Report Fields

App

Name of the TouchNet application where the payment originated.

Merchant

Name of the merchant for the transaction.

Date

Date and time of the original payment.
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Origin

SEC code for the method of payment presentment.

Type

Type of ACH payment processed, as provided by NACHA rules. The most
common type is PUR (purchase).

Trans ID

Unique ID for the transaction. The transaction keeps this ID even if you
reinitiate it, and allows you to follow the transaction's progress through
reports.

Amount

Amount of the payment.

Reinit

Number of times the payment has been marked as rejected and then
reinitiated. (You can initiate a payment up to three times.)

Payer ID

The user ID of the person initiating the payment transaction.

Check Memo

Student ID number (if available) and any memo information entered with
the payment.

Err Msg

Rejection code and the reason for rejection.

RC

The Payment Gateway return code.
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10.7 Campus Cards Report
This section describes the activity report available for campus card type
payments. Review the report fields section for a brief description of the
fields displaying on the report.

The report displays in a separate window if you are using Internet Explorer,
or in a separate tab if you are using Firefox. Click the Close Window button
to close the report and return to the Report Selection page in the Payment
Gateway Operations Center.

Activity Report This report shows all attempted campus card authorizations for the date
range and other search criteria you select. Use this report to review
payment activity, including declined payment attempts, and review
authorization success-or-fail responses. All search criteria are allowed with
this report.

The Campus Card Activity report

Report Fields

App

Name of the TouchNet application where the payment originated.
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Module

Name of the TouchNet sub-application where the payment originated.

Merchant

Name of the merchant for the transaction.

Date

Date and time that the transaction was authorized.

Type

Identifies the transaction as one of these types:

• PUR, for purchase.

• REV, for reversal, which is a credit processed before settlement.

• CR, for a credit processed after settlement.

• VOID, for a voided payment.

Amount

Payment amount.

Reference #

Reference number for the campus card payment.

TPG RC

Success-or-fail response from Payment Gateway. A negative number
indicates the transaction failed.

Payer ID

The user ID of the person intiating the payment transaction.

Ancil Data

Additional data submitted with payments. If ancillary data is entered when
processing a credit, it displays here.
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11.0 Viewing Payment Details
Payment Gateway reports provide a variety of detail about payment
transactions based on the payment type, report type, date, and merchant(s)
you select.

To manage the large volume of report data displaying on the Payment
Gateway reports page, the following reports include a link to a Payment
Details page to view the report data for a specific transaction.

To access the Payment Details page, click the Reference # link for the
desired transaction. To return to the report, click the previous link. To close
the report window and return to the Report Selection page, click the Close
Window button.

The following reports contain a link to the Payment Details page:

• All Payment Transactions reports for Credit card, ACH and Debit

• Credit Card Activity report

• Credit Card Pending Transactions report

• Credit Card Batch Details report

• Debit Activity report

• Debit Pending Transactions report

• Debit Batch Details report

Note: On the Page Details page, the TPG Reference Number is formatted
to make it easier to read the date and transaction number. The TPG
Reference Number format is: YYYY MM DD 000001.

11.1 Printing Reports
To print a report from the report window, right-click on the report and select
your browser’s print option.

You can also export the report as a comma-separated value (CSV) file. The
saved CSV files can be opened in a spreadsheet program and printed. See
"Exporting a Report to a CSV File" on page 235 for more information.

11.2 Sorting Report Results
To sort report results, click the heading of the column you want to sort. For
example, to sort by date, click the Date heading.
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11.3 Exporting a Report to a CSV File
You can export any Payment Gateway report as a comma-separated value
(CSV) file. The saved CSV files can then be opened in spreadsheet
programs.

Follow these steps to export a report to a CSV file. This process requires
accountant rights.

1 After choosing your report criteria, click the Export to CSV button.

2 In the Download CSV File page, right-click the file name and use
your browser's options to save the file.

3 Click the trash can icon to delete the file. For security, this removes
the file's generated copy from your server.

Note: If your browser and operating system support opening CSV files
directly into an installed spreadsheet program, you can left-click the file
name to view its contents.

Note: Detailed descriptions of the fields in each CSV-format report type are
available in Payment Gateway Operations Center online help.

Changing the
CSV File

Numbering
Format in

Microsoft Excel

If you use Microsoft Excel to display the data in the exported CSV file, you
may want to change the numbering format for certain columns, such as the
TPG Reference Number column, so that the full number displays instead of
exponential numbering.

To change the numbering format for any column, follow these steps.

1 In the Microsoft Excel spreadsheet, click the column header or the
specific cell you want to change.

2 Select Format > Cells from the Excel toolbar.

3 Click the Number option in the Category dropdown list.

4 Change the number in the Decimal Places field to zero.

5 Click OK to save your changes.
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12.0 Managing Operations Center Users
In the Payment Gateway Operations Center you control who at your
institution can perform Payment Gateway management tasks. Some users
may need the ability to perform all payment processing and configuration
tasks, others may only need to view reports. Some users may need to work
with all merchants, others may only need access to one merchant.

When you add a new Operations Center user you assign both the user’s role
and access to merchants.

You must assign an initial merchant to all users. You will also need to
assign a U.Commerce Central username and password for each new user.
The first time the new user logs in to U.Commerce Central, the usernames
and passwords set up in Payment Gateway and U.Commerce Central are
synced up and the user will only be required to enter one username and
password to log in to both U.Commerce Central and Payment Gateway. See
Creating a New User in the U.Commerce Central User Guide for
instructions on creating a U.Commerce Central username and password.

An administrator can change another user's password for security or when a
user forgets his or her password.

This guide explains each user role type as well as the username and
password requirements.

Step-by-step instructions for the following procedures are included in this
guide: 

• Adding a new user

• Changing user roles

• Granting user access to merchants

• Changing user passwords

• Inactivating users

• Tracking user access using the User Audit Log

Note: Instructions for these procedures are also available in Payment
Gateway online help.

12.1 Payment Gateway User Roles
User roles in Payment Gateway are divided into two categories: System
Roles and Merchant Roles. System roles allow the user certain permissions
within the entire Payment Gateway. Merchant roles are specific by
merchant. A user may be assigned different merchant roles for different
merchants. For example, a user could have the Bursar role for Merchant 1
and the Accountant role for Merchant 2.
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System Roles To view a breakdown of the system roles and the users assigned to those
roles click Users > System Role View in the left navigation. The System
Role View page displays.

System Role View

The following system user roles are available in Payment Gateway:

• TPG Administrator

• Manage ERP Transactions

• View ERP Transactions

• Process ACH return file

• Modify Processor Identifiers

• Approve Processor Identifiers Modifications

Administrator Role

The administrator role allows a user to: 

• View and change merchant configuration

• Add Operations Center users

• Enable and disable users

• Edit user roles

• Assign other users access to merchants

• Grant ERP roles to users

• Run user and function audits

• Configure system settings
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If licensed for ACH, credit card, and debit processing, the administrator can
also change ACH, credit card, and debit configurations. Only administrators
can be given the permission to assign users permission to add or edit
merchants.

Manage ERP Transactions

Assign this role to a user who must be able to view the ERP Update
Transactions page and who must be able to retry failed attempts or mark
failed attempts as complete. Users who are not assigned this role or the
View ERP Transactions role will not be able to see the ERP Update
Transaction page.

View ERP Transactions

Assign this role to any user who must be able to view the ERP Update
Transactions page. Users who are not assigned this role or the Manage ERP
Transactions role will not be able to see the ERP Update Transactions page.

Process Return File

Assign the process return file role to users who are allowed to process ACH
return files. Users assigned this role can upload, store, and process an ACH
returns file.

The process return file role is not merchant specific.

Modify Processor Identifiers

Assign the Modify Processor Identifier permission to users who are allowed
to change merchant configuration information. Users assigned this
permission can edit an existing merchant's configuration information. This
user can be assigned the Approve Processor Identifier Modifications
permission at the same time, however they can not approve their own
changes.

Important! Users assigned the Modify Processor Identifiers role must also
be assigned the TPG Administrator role.

Approve Processor Identifiers Modifications

Assign the Approve Processor Identifier Modifications permission to users
who are allowed to approve or cancel the changes to existing merchant
configuration information requested by the modify processor identifier.
Users assigned this permission can approve or cancel an existing merchant's
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configuration information, but they are not allowed to change the merchant
configuration information. This user can be assigned the modify processor
identifier permission at the same time, however they can not approve their
own changes.

Important! Users assigned the Approve Processor Identifiers
Modifications role must also be assigned the TPG Administrator role.

Merchant
Roles

To view a breakdown of the merchant roles and the users assigned to those
roles click Users > Merchant Role View in the left navigation. The
Merchant Role View page displays.

The Merchant Role View

The following merchant user roles are available in Payment Gateway:

• Accountant Role

• Bursar Role

• Cashier Role

• Process Credit Role

• Resubmit Failed Batch Role

Accountant

An accountant can review all Operations Center reports for his or her
assigned merchant(s). If your school uses campus cards in Payment
Gateway, the user with the accountant role can edit the campus card title
and merchant configuration information.
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Bursar

A bursar for a credit card merchant can process credits, settle batches, and
remove payment transactions from batches for that merchant type. For a
debit card merchant a bursar can settle batches and remove payment
transactions from batches.

A bursar must be assigned the cashier role in order to process single credit
card authorizations.

A bursar for an ACH merchant can generate ACH files, mark ACH files as
settled, remove payment transactions from ACH files, and delete ACH
files. This bursar can also mark payments as rejected and reinitiate
payments.

Important! If your school uses ACH processing, bursars can see sensitive
data associated with ACH payments. Do not assign the ACH bursar's role
to a user who is not authorized to see this data.

Cashier

A cashier for a credit card merchant can process single authorizations.

A cashier for an ACH merchant can view transaction details, mark payments
as rejected, and reinitiate payments.

A cashier for a debit merchant can view debit transaction details.

Process Credit

Assign this role to any user who will have the ability to process credit card
credits.

Resubmit Failed Batch

Assign this role to any user who will have the ability to resubmit failed
credit card and/or debit card batches. Users with this role will receive the
failed batch email notification.

Note: The user would also need to be assigned the Accountant role.
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12.2 Username and Password Requirements
For a standalone installation of Payment Gateway, the username must meet
these requirements:

• It must be at least 5 alphanumeric characters long. This length
requirement may be increased. To do so, contact TouchNet Customer
Care for assistance.

• It cannot exceed 50 characters.

• It can only contain characters A-Z, a-z, and 0-9. No special characters
(for example, $, #, or &) are allowed.

Note: You will be prompted to enter a different username if the one you
choose does not satisfy these requirements.

A user password must meet these requirements.

• It must be at least 8 characters long. This length requirement may be
increased. To do so, contact TouchNet Customer Care for assistance.

• It cannot exceed 30 characters.

• It must include at least one digit.

• It must include at least one lowercase letter.

• It must include at least one uppercase letter.

• It cannot contain the username.

• It can only contain characters A-Z, a-z, and 0-9. No special characters
(for example, $, #, or &) are allowed.

Note: You will be prompted to enter a different password if the one you
choose does not satisfy these requirements.

Password
Expiration

Your school's Payment Gateway user passwords have been configured to
expire at regular intervals - either 30, 60, or 90 days. As each interval
lapses, users will be prompted to enter a new password upon login to the
Payment Gateway Operations Center. You can change the password
expiration interval by

The Forgot Password link allows individual users to reset their password. If
the user you forgets their password, you can click the Forgot Password? link
and quickly change your Password. Users no longer need to contact the
U.Commerce Central administrator and wait for the password to be reset.

To change your password, using the Forgot password link, follow these
steps.

CONFIDENTIALTouchNet Payment Gateway 6.0 Business User Guide
©2012 TouchNet Information Systems, Inc.



1 From the U.Commerce Central login page, click the Forgot password?
link.

The Forgot password? link

2 Enter your User Name, First Name, Last Name, and E-mail Address on
the page provided and click Verify.

Verify your user profile information

Note: U.Commerce Central validates your user information based on all
four of these entries, so they must be entered correctly. For security
purposes, a generic message displays if you enter incorrect information in
any of these fields. indicating the information you entered is invalid, if any
of your entries on this page are incorrect.

3 A message displays asking you to check your email to continue with
your login.

4 You will receive a password reset request email from U.Commerce
Central. Click the Reset Password button at the bottom of the page.
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Reset request email from U.Commerce Central

5 The Security Questions page displays. Select your three security
questions, from the dropdown lists and enter the answers in the fields
provided. Click the Update Selections button.

Note: You must select three different security questions.

Security questions

6 Once you have completed all the information for your password reset,
and your password successfully resets, you will receive a reset
confirmation email.

Email confirmation your password reset

7 Proceed with logging in using your new password.

Note: On your next login to the U.Commerce Central interface, you
will be prompted to provide the password verification information.
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12.3 Adding a New User
In the Payment Gateway Operations Center, you add new users who
perform various tasks in Payment Gateway. Use the Add New User page to
enter new users, assign their initial username and password, and their initial
roll and access to merchants.

If your school has Payment Gateway integrated with U.Commerce Central,
the process for adding a new user is two-fold. First, It involves creating a
new user in U.Commerce Central User Management, and then creating the
new user in Payment Gateway and assigning the Payment Gateway user
roles.

The process for adding a new user in U.Commerce Central User
Management is described in the U.Commerce Central User Guide.
Typically, not all Payment Gateway users will have access to User
Management in U.Commerce Central, so the task of creating a new
U.Commerce Central user may need to be completed by a User
Management administrator.

Note: TouchNet recommends that the user be created in U.Commerce
Central User Management first and then in Payment Gateway. Following
this order allows you to hand off just one set of U.Commerce Central login
credentials to the new user. If you create the user in Payment Gateway first,
two sets of login credentials (one for Payment Gateway and one for
U.Commerce Central) will have to be given to the new user.

You can assign only one initial role for one initial merchant to a new user.
You can assign additional roles later. See "Changing Users' Roles" on page
248 for instructions on assigning additional roles and merchants.

Note: Additional roles and merchants are added on the Edit User Roles
page.

To add a new user, follow these steps. This process requires administrator
rights.

Note: You must enter user information in the required fields marked with
red exclamation point.

1 From the Payment Gateway home page, navigate to Users > Add
New User. The Add New User page displays.

2 Enter the new user name in the Username field. This is a required
field.

Hover over the question mark icon to view the username
requirements.

3 Enter the user's first name in the First name field. This is a required
field.
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4 Enter the user's last name in the Last name field. This is a required
field.

5 Enter the user's e-mail address in the E-mail address field. This is a
required field.

6 Enter the user's U.Commerce Central username in the U.Commerce
Login field. The U.Commerce Central login is created in
U.Commerce Central User Management. Once the user logs into
U.Commerce Central for the first time, they will use their
U.Commerce login. This is the user's single signon login. Refer to the
U.Commerce User Guide for the User Management steps to create
the U.Commerce Central login.

7 In the Initial Merchant Role section, select the initial role and
merchant for the user from the dropdown lists. These are optional
fields.

Note: Do not assign a merchant to a user with the administrator role.

Important! If you use ACH processing, bursars can see sensitive data
associated with checks. Do not assign the bursar's role to a user who is
not authorized to see this data.

8 In the Phone section, enter the user's contact information (daytime,
evening, and mobile phone numbers). These are optional fields.

9 Click the Submit button to add the new user.

10 Notify the new user of his or her login username and password.

Important! If you are using Payment Gateway integrated with
U.Commerce Central users cannot log in to Payment Gateway without
first logging in to U.Commerce Central. You must make sure that the
Payment Gateway users have U.Commerce Central login credentials and
the U.Commerce Central URL.

12.4 Granting Users Access to Merchants
After you add a merchant, you must designate the Operations Center users
who can work with that merchant. Operations Center users see only the
merchants they have been assigned. Under each merchant name, users see
the tasks that their roles allow.

For instance, a bursar for “Merchant One” will see the tasks to settle
batches and process credits for that merchant. A cashier for “Merchant Two”
will only see Merchant Two’s tasks but will not see Merchant One at all.

To give a user access to a merchant, follow these steps. This process
requires administrator rights.
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1 From the Payment Gateway home page, navigate to Users > Manage
Users. The Manage Users page displays.

2 Locate the desired user name from the Manage Users listing.

3 In the Actions column at the end of the row, use the dropdown list to
select Edit Roles. The Edit User Roles page displays.

Edit User Roles page

4 Under Merchant Roles, use the dropdown list to select the desired
merchant type (credit card, ACH, debit, or campus card).
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5 For each merchant, mark the checkboxes to assign one or more roles
to the current user.

6 Click the Add Merchant Roles button.

12.5 Changing Users' Roles
You can assign Operations Center users any combination of the roles for
multiple merchants. At login, Operations Center users will see only the
merchants they have been assigned.

For instance, on the Payment Tasks>Merchant Administration page, users
see only the tasks for the merchants they have been assigned.

To change a user's roles, follow these steps roles. This process requires
administrator rights.

1 From the Payment Gateway home page, navigate to Users > Manage
Users. The Manage Users page displays.

2 Locate the desired user name from the Manager Users listing.

3 In the Actions column at the end of the row, choose Edit Roles from
the user’s dropdown list.The Edit User Roles page displays.
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The Edit User Roles page

4 Verify the user you selected displays in the Edit a User field.

5 In the Administration Roles section:

• To add a role, mark the checkbox for the role from the Available
Roles section and click the Add System Roles button. You can
select multiple roles. Click OK to confirm the addition of the new
role.

• To remove a role, mark the checkbox for the role in the Current
Roles section and click the Remove System Roles button. You can
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select multiple roles. Click OK to confirm the removal of the role.

6 Use the Merchant Roles dropdown list to select the desired merchant
type (credit card, ACH, or debit).

7 In the Merchant Roles section:

• To add a role, mark the Available Roles checkbox for the new role
and click the Add Merchant Roles button. You can select multiple
roles. Click OK to confirm the addition of the new role.

Add a merchant role

• To remove a role, mark the Current Roles checkbox for the
unwanted role and click the Remove Merchant Roles button. You
can select multiple roles. Click OK to confirm the removal of the
role.
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Current user roles

You can use the User Audit Log to view user activity in the Operations
Center. The audit log includes the date and time of the activity, the session
ID number, the user name, action performed, details of the action, and the
applicable merchant. You can filter the audit log data by user, date and time
of login, and tasks performed.

To view the User Audit Log, follow these steps. You must have accountant
rights to view the User Audit Log.

1 From the Payment Gateway home page, navigate to Users > User
Audit Log. The User Audit Log page displays.
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2 Enter the desired beginning and ending date and time in the date
range fields. The current date defaults in both the begin and end
fields.

3 Select the desired user from the Select User dropdown list. The
default is all users.

4 In the Select Action field, select the desired action from the
dropdown list. The default is all actions.

Note: To view a short description of each of the user actions, click the
question mark icon.

5 Click the View Log button. The user audit log results appear.

You have the ability to filter the user audit log results. See "Filtering the
User Audit Log Results" on page 254 for more information.

12.6 Viewing the User Audit Log Results
You can use the User Audit Log to view user activity in the Operations
Center. The audit log includes the date and time of the activity, the session
ID number, the user name, action performed, details of the action, and the
applicable merchant. You can filter the audit log data by user, date and time
of login, and tasks performed.

1 From the Payment Gateway home page, navigate to Users > User
Audit Log. The User Audit Log displays.

The User Audit Log
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2 Enter the desired beginning and ending date and time in the date
range fields. The current date defaults in both the begin and end
fields.

3 In the Select User field, select the desired user from the dropdown
list. The default is all users.

4 In the Select Action field, select the desired action from the
dropdown list. The default is all actions.

The Select Action dropdown menu

Note: To view a short description of each of the user actions, click the
question mark icon.
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5 Click the View Log button. The user audit log results appear.

The User Audit Log results

Filtering the
User Audit Log

Results

You have the ability to filter the results displayed on the User Audit Log.
Once the desired results appear on the page you can filter the audit log data
by the date, user, and action fields.

To view an entire user session, click the Session number. All the actions
performed during the selected session display.

Use the following fields to filter the user audit log data.

Date Range

To select the desired date range, click the calendar icon and select the
desired dates for the Begin and End date fields.

Select User

Click the Select User dropdown list and select the desired username. The
default is all users.

Select Action

Click the Select Action dropdown list and select the desired action.
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Note: In the Select Action field, select the desired action from the
dropdown list. The default is all actions.

Date

Click the arrow in the Date column to sort the dates in ascending or
descending order.

Session

Click the desired session link to view the entire user session.

User

Click the link next to the user name to sort user audit information by user
role.

Action

To sort the user actions by a specific action, click the desired user link. All
occurrences of the action appear at the top of the audit log.

Note: To display another user action, click the Select Action field dropdown
list and select the desired action.

Details

Shows the computer IP address where the user performed the action.

TPG Merchant

Displays the TPG merchant for the merchant action performed.
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13.0 Troubleshooting Payment Processes
In a properly functioning Payment Gateway environment, occasional
exceptions can cause authorizations or batch settlements to fail. These
failures can be caused by factors such as connectivity problems, problems in
your credit card or debit processor’s operations, or invalid payment
information submitted by payers.

13.1 Exception Codes

Types of
Exception

Codes

The authorization, batch settlement, and batch details reports include
records of exceptions/errors that caused authorizations or settlements to fail.
In these reports, you may see these types of exception codes.

-50 to -99 Exceptions

Typically, these exception codes indicate file related problems. To look up
a -50 to -99 exception code, see "Looking Up Exception Codes" on page
259.

If one of these exceptions occurs, contact your network administrator for
assistance with the cause of the exception, then contact TouchNet Customer
Care for assistance with affected batch settlements.

-1300 to -1399 Exceptions

Typically, these exceptions are network related. To look up a -1300 to -
1399 exception code, see "Looking Up Exception Codes" on page 259.

If one of these exceptions occurs, contact your network administrator for
assistance with the cause of the exception, then contact TouchNet Customer
Care for assistance with affected batch settlements.

-1600 to -1699 and -4000 to -4999Exceptions

These response codes may appear in the authorization or batch settlement
reports and indicate that problems occurred at your credit card or debit
processor. To look up a -1600 to -1699 or -4000 to -4999 exception code,
see "Looking Up Exception Codes" on page 259.

TouchNet does not resolve exceptions that occur at the processor. This
information is based on specifications provided by the processors, and is
subject to change by them.
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-1700 to -1799, -1800 to -1849, and -1900 to -1999 Excep-
tions

Exception codes -1700 to -1799, -1800 to -1849, and -1900 to -1999
typically indicate problems with the card data or your Payment Gateway
configuration. When these exceptions occur, they are recorded in the
Activity report or Batch Settlement report.

When these exceptions occur, always check the exception report, which
may provide more exact information about the cause of the exception.
Then, follow the exception’s resolution procedure as described on the
TouchNet Client Community. See "Looking Up Exception Codes" on page
259 for instructions on how to look up an exception code on the Client
Community.

Important! If an exception occurs during the response from the processor,
your reports might not show the completed settlement or authorization.
Always contact your processor when indicated.

-5000 to -5999 Exceptions

Customers of FDC credit card or debit processors may encounter -5000 to -
5999 exceptions. These are related to Datawire configuration or
connectivity issues. To look up a -5xxx series exception code, see "Looking
Up Exception Codes" on page 259.

Other Exception Codes

Other types of response codes you may see in reports include exception
codes -1 to -10 and exception codes in your own applications.

Exception Codes -1 to -10

Exception numbers -1 to -10 typically do not occur after Payment Gateway
is configured and operating properly. If you receive one of these
exceptions, contact TouchNet Customer Care for help with your
configuration.

Exception Codes in Your Applications

Payment Gateway does not return exception messages for display in online
applications. All payment-related exception messages in your applications
are set up in that application’s files.
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Looking Up
Exception

Codes

To look up an exception code, follow these steps.

1 Access the TouchNet Client Community at
https://clientcommunity.touchnet.com.

2 Click the Log In link at the top of the page.

3 Enter your user name and password.

4 The Client Community home page displays. Click the Identify
Exception Codes link in the Quick Links section.

5 Exception Codes and FAQs screen displays. Enter the applicable
message code in the Search field.

6 Click the Search button.

7 Click the desired exception code from the search results listing. The
exception code description displays in the right pane.

Before
Contacting

Customer Care

If you need to contact TouchNet Customer Care for help resolving
problems, please have the following information ready.

• The name of your credit card or debit processor.

• The version number of your payment processor module.

• The exception code you have encountered.

• Information from your exception report about the problem.

• The number of times you have tried to resubmit your batch.

• Whether you are able to process authorizations.

• In the Payment Gateway Operations Center, go to View System
Information and click the Export System Information button. Save the
file to your local drive. Customer Care will ask you to e-mail that file
to them for troubleshooting purposes.

Trouble–
shooting With
the Exception
Log Report

Some exceptions can occur for more than one reason. The Exception Log
report compiled by Payment Gateway contains details that may help you
pinpoint causes of exceptions. To check the Exception Log report:

1 Log into the Operations Center as an accountant.

2 In the left navigation, click Reports.

3 Under Payment Type, select Credit Card.

4 Under Report Type, select the Exception Log report.

5 Choose a range of dates to search.

6 Select a specific merchant or all merchants.

7 Click the View Report button to open the Exception Log report.
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8 Click the settle.RB file link to view details of a failed batch.

Trouble–
shooting Credit
Card or Debit
Configuration

If the exception report or exception resolution steps indicate that you need
to troubleshoot your configuration, follow these steps.

1 Log into Payment Gateway Operations Center with administrator
rights.

2 From the Payment Gateway home page, navigate to Payment
Processing Setup > [payment type] > General. The General
Configuration page displays.

3 Ensure that Enable multiple merchants field is set correctly. Click the
Save Changes button if you change it.

4 In the left navigation, click Merchant and select the merchant from
the Current Merchant dropdown list.

5 Verify that all entries contain the information required by the
processor and that the card types you accept are correctly marked.
Click the Save Changes button if you have made any changes.

Note: Do not change the Subdirectory entry. Do not use the same
subdirectory name for multiple merchants. The subdirectory must be
unique to each merchant.

6 If you have made any changes, stop and restart Payment Gateway. If
your TouchNet solutions are hosted on campus, see "Starting and
Stopping Payment Gateway" on page 89.

Note: If your TouchNet solutions are hosted in the TouchNet
DataCenter, contact Customer Care for assistance.

13.2 Troubleshooting Batch and Update Problems
Step-by-step information about troubleshooting batch failures due to
connectivity and troubleshooting batch settlement for Moneris e-Select Plus
is available in Payment Gateway online help.
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14.0 Terms and Definitions
ACH file
A batch of ACH transactions saved by Payment Gateway as a single file in
the standard format in which banks receive information to process ACH
payments.

Ancillary data
Additional data recorded with a payment transaction, for instance, a payer’s
ID number.

Acquiring bank
A bank that enables merchants to accept credit card transactions. This bank
sets up the merchant and deposits daily credit card sales, minus any
applicable fees, into the merchant. An acquiring bank is sometimes called a
“merchant bank.”

Authorization
Approval of a credit card or debit transaction by a card processor, on behalf
of the issuing bank. All transactions must be authorized before they can be
settled.

AVS
Address Verification System. This system checks the customer’s billing
address to make sure it matches the credit card. Use of AVS is determined
by your credit card processor.

Batch
A set of authorized payment transactions that are settled together.

Capture
The credit card processor’s record of the authorized amount as an amount to
be billed to the cardholder’s account. At settlement, the credit card
processor compares the amount in the capture to the amount you submit for
settlement.

Card verification value (CVV)
This number is printed, not imprinted, on the back (or front in the case of
American Express) of a credit card and is usually located in the card’s
signature area or above the imprinted number on the card. Also referred to
as CVV2, CVC2, or CID.

Client
A computer or software component that sends transaction requests to a
server. For instance, when a user makes a payment using a web browser,
that web browser is a client to the web server that receives the request.
When the web server passes the request on to Payment Gateway, the web
server is a client to the computer where Payment Gateway is running.
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Client ID
The ID that a client passes to Payment Gateway. Payment Gateway only
accepts requests from clients listed in the Payment Gateway client ID table.

Commerce solutions
Applications such as TouchNet Bill+Payment or TouchNet Cashiering, that
allow a school to accept payments online and process them through
Payment Gateway.

Credit
An amount returned to a cardholder’s account to refund part or all of a
payment. (See also Reversal and Void.)

Credit card processor
An institution that provides banking services to your acquiring bank. The
credit card processor authorizes and settles credit card transactions and
coordinates transfers of funds between issuing banks and acquiring banks.

CVV
See card verification value.

Data packet
For any transaction, the data that is passed together between programs or
computers.

Debit Processor
An institution that provides banking services to your acquiring bank. The
debit processor authorizes and settles debit transactions and coordinates
transfers of funds between issuing banks and acquiring banks.

Decrypt
To decode encrypted data so that it can be processed or read.

Encrypt
To encode data to prevent unauthorized access.

ERP
Enterprise Resource Planning. In TouchNet documents, the ERP is the
school's student system (Banner, PeopleSoft, etc.).

Host system
Refers to a school's ERP system. A host system may also be called a “host.”

In Payment Gateway, host systems are categories of host system accounts.
Host systems are created by the user in Payment Gateway to act as a kind
of folder system for host system accounts.

Host system account
In Payment Gateway, host system accounts are created to contain
information used to process payments and update bank accounts correctly.
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IP
Internet Protocol. Defines rules for data transmission over an internet
network.

IP address
The dotted decimal number that uniquely identifies a computer connected
to the Internet or the local area network (LAN). It acts as the “return
address” of an individual computer.

IP connectivity
For Payment Gateway, connectivity provided to your credit card processor
through the Internet.

Issuing bank
A bank that sets up credit accounts for cardholders, issues credit cards, and
bills cardholders for purchases against their accounts.

JHost
Connects Payment Gateway’s Transaction Manager to Java-based modules
that provide specific functions (such as the SQL logging module).

Merchant
In Payment Gateway, a merchant is a payment method-specific container
for information and instructions that will be used by the credit card or debit
processor (if applicable), the school’s bank, and the Payment Gateway.
There are credit card, ACH, and debit merchants in Payment Gateway.

The term "merchant" may also refer to the merchant accounts that the
school maintains at its bank. These bank merchant accounts are directly
associated with Payment Gateway merchants.

The term "merchant" may also refer to the school itself as a credit card
merchant or debit merchant.

Merchant bank
See Acquiring Bank.

NACHA
NACHA is an electronic payments association that has developed rules and
standards for processing ACH transactions. NACHA stands for National
Automated Clearing House Association.

NOC
Notification of Change. A NOC is a notification from the bank that some
aspect of a transaction required correction (for example, a savings account
that was incorrectly identified as a checking account in the transaction
information). It does not represent a failed financial transaction.
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Operations Center
Online interface provided with Payment Gateway for all payment
processing operations and reporting.

Payment method
Any method you use for accepting money through a TouchNet
U.Commerce Central solution.

Payment processor module
The Payment Gateway component that provides the specific functionality
required by your credit card processor.

PIN debit
A debit payment method, taken at point-of-sale only, which requires the
customer to enter a personal identification number (PIN). This is only
available with TouchNet Cashiering.

PINless debit
A debit payment method, taken for online debit transactions, which does
not require the customer to enter a personal identification number (PIN).
The only application that accepts PINless debit payments and sends them
through the TouchNet Payment Gateway is TouchNet Bill+Payment.

RC
See Response Code.

Reference number
The unique transaction number assigned by Payment Gateway to every
attempted authorization. The reference number displays in the
Authorization and Batch Details reports. (For some processors, this number
is unique only within a merchant's transactions; two merchants may have a
transaction with the same reference number.)

Response
Data returned from a host as the result of a transaction request.

Response code
Indicates a transaction’s success or failure. For example, a response code
that begins with -16 indicates a failure signaled by the credit card processor.

Request
Data passed from a client to prompt the retrieval of response data from a
host.

Reversal
A type of credit in which the original purchase has not yet been settled.
The amount to be settled is changed to a new, lower amount.
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Role
In the Operations Center, the designation that determines which tasks a
user can perform for the merchants assigned to that user.

Settlement
Submission of previously authorized transactions to the credit card processor
for final payment processing. A successful settlement results in a funds
transfer between the issuing and acquiring banks.

Server ID
Designates a server to which the Transaction Manager can pass data.
Payment Gateway’s Transaction Manager can pass data only to servers listed
in the server ID table.

Signature Debit Only
Allows a credit card merchants to accept signature debit only transactions.

SSL
The Secure Sockets Layer protocol, which provides encrypted
communications on the Internet. HTTPS uses SSL as the basis for securing
browser sessions. You may choose to implement SSL for your own payment
applications that send data to a web server.

Subtranscode
A numeric code that identifies the target merchant for a payment.

System log
File containing a record of the ongoing, basic functions of your Payment
Gateway system. Requires periodic archival to maintain the file at a smaller
size.

Transaction
A transfer of data that consists of a request from a client and a response from
a host.

Transaction Manager
The program within Payment Gateway that decrypts, encrypts, and routes
client requests.

Void
As shown in the Payment Gateway Operations Center, a type of credit in
which the full purchase amount is refunded to the cardholder’s account.
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Funds transfer 9

G

Global Payment Systems East 10, 165
merchant configuration 46

Glossary 261

H

Host system accounts
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Cancelling

83

Merchant Configuration Changes, viewing 86
Merchant Configuration Changes;Approving80
Merchant Roles 240
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